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Which Java version does Insight use? 
When you install DUG Insight, its own version of Java is included. Insight uses this version 
instead any Java installations on the system. This ensures that you are using a version that is 
compatible with Insight. 

As a result, Insight does not require a separate installation of Java, and does not require 
updates to the version of Java on the system. 

The Java version included with Insight depends on the release: 

• Up to 4.5-902060 (released before March, 2019): 
• Java 64bit v1.7.0 - “Java SE Version 7” 

• After 4.5-903060 (released after March, 2019): 
• Java 64bit v1.8.0_201 - “Java SE Version 8” 

• After 4.8-006300 (released after June, 2020): 
• Java 64bit - "Java SE Version 12.0.2” 

If you have questions or problems regarding Java and Insight, please contact our support team 
at support@dugeo.com. 

 Note: You may be asked to send data of your session from the Logs window for a 
clearer picture of the problem (see Viewing and Sending Diagnostic Logs). 
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How does Oracle's Java licensing apply to 
Insight? 
Oracle’s Java licensing scheme does not apply to the version of Java included with Insight. 

Each Insight installation includes a Java Runtime Environment (JRE). This ensures Insight runs 
smoothly and the environment is consistent across users and versions. 

The included JRE depends on the release: 

• Up to 4.5-902060 (released before March, 2019): 
• Java 64bit v1.7.0 - “Java SE Version 7” 

• After 4.5-903060 (released after March, 2019): 
• Java 64bit v1.8.0_201 - “Java SE Version 8” 

These releases of Java can be used freely without an Oracle Java licence or subscription. Oracle 
has stated that after January 2019, Oracle Java SE Version 8 will not receive bug fixes or updates 
without a subscription. 

From Oracle's page, Java SE General FAQs: 

Java SE 8 remains free of charge for general purpose desktop and server 
use and is available under the Oracle 11 Binary Code License (BCL) at 
https://www.oracle.com/javadownload. 

Internally, we are successfully running areas of our code on non-Oracle versions of Java. We 
anticipate moving Insight to one of these versions once we have confidence that it is stable and 
reliable. Java runtime environments not provided by Oracle are not covered by their licensing, 
but do receive patches, updates and bug fixes. 

Page 10FAQ

https://www.oracle.com/technetwork/java/javase/overview/faqs-jsp-136696.html


How do I edit the Java's overriding 
Environment Variable? 

Other Java applications installed on your system may have configured Windows to not allow 
Insight to allocate the memory you set with the DUG Insight Launcher. If you are getting 
out of memory errors and believe the memory allocation to be incorrect, you can confirm 
the memory allocation here. 

If this is what you are experiencing, you will need to remove an environment variable called 
"_JAVA_OPTIONS". 

To do this on Windows, follow the steps below. 

Configure advanced system settings 

1. Right Click on My Computer 
2. Click Properties. 
3. On the left panel, click Advanced system settings. This will open the Advanced tab in the 

System Properties window. 
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Edit environment variable 

1. In the Advanced tab in the System Properties window, click Environment Variables. This 
will open the Environment Variables window. 

2. In either the System variables or the User variables section, look for the "_JAVA_OPTIONS" 
variable. Based on the variable value in the example, Insight will use 1GB RAM and not the 
memory you have allocated in the DUG Insight Launcher. 

3. Double-click the variable or select this variable row and click Edit. 
4. Edit the variable name to something else (effectively removing it by name, but backing it up 

in case your other Java applications truly require this setting). 
5. Test the other application. 
6. [Optional] If the other application works, you can now go in and delete the renamed 

variable. 

 Caution: If you have other Java applications on your system that are using this 
variable, and given that this setting is there, this is likely to be the case, removing this 
setting may affect the applications. Hence, we advise to rename the variable and 
ensure other applications are not affected before deleting. 

If you need to merge the variables, contact DUG support at support@dugeo.com. 

Insight should now open with the correct memory allocation. 
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How do I install Insight silently or via SCCM? 

The default installation for DUG Insight is an Attended Installation (see Installing Insight on 
Windows). 

To perform a silent installation, the installation package needs to run from the command 
window using the "msiexec /i" command. 

If you are using a System Center Configuration Manager (SCCM) to perform the installation, 
simply run the command lines described below in your SCCM to deploy Insight. 

Silent installation per user 

1. From the Start menu, type "cmd" and open the Windows Command Processor. 
2. In the command window, navigate to the folder where the installation file (.msi) resides. 
3. To perform a silent installation, type the following: 

msiexec /i DUG_Insight-3.1-408150_x64.msi /qn 

Note: Change the version number as necessary. 

4. Press Enter. Insight will then be installed silently for the current user only. 

 Tip: The installer will install Insight in a default system location for user based 
installations (i.e. C:\Users\[Username]\AppData\Local\DownUnder Geosolutions). The 
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location may vary depending on the operating system the machine is running (see 
Home directory). 

Silent installation for ALL users 

To perform a silent installation for ALL users, administrative privileges are required. Make sure 
you are logged in to an Admin account or from an admin console. 

1. From the Start menu, type "cmd". 
2. Right click cmd and select Run as administrator to open the Windows Command Processor 

as Administrator. 
3. In the command window, navigate to the folder where the installation file (.msi) resides. 
4. To perform a silent installation for all users, type the following (change the version number 

and installation folder as required): 

msiexec /i "DUG_Insight-3.1-408150_x64.msi" APPLICATIONFOLDER="C:\Program Files\
DownUnder GeoSolutions\DUG Insight 3.1-408150" ALLUSERS="1" /qn 

5. Press Enter. Insight will then be installed silently for ALL users at the folder specified above. 

Silent install Insight with Petrel Link 

To include the Petrel Link in the installation, add FEAT_PETRELLINK="1" to the command: 

msiexec /i "DUG_Insight-3.1-408150_x64.msi" APPLICATIONFOLDER="C:\Program Files\
DownUnder GeoSolutions\DUG Insight 3.1-408150" ALLUSERS="1" FEAT_PETRELLINK="1" /qn 

Page 14FAQ

http://en.wikipedia.org/wiki/Home_directory#Default_home_directory_per_operating_system


 Note: This will not fix the problem for an already installed version. Uninstall the 
current Insight version before executing the command. 

Genuine offer of assistance 
If the installation is unsuccessful, or if you have any questions, please do not hesitate to contact 
our support team at support@dugeo.com. 

It would be helpful if you could provide logs for the failed installation. To install Insight with 
logging enabled, see Installation of Insight failed! What should I do? 
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How do I change Insight's default directory? 

By default, Insight saves its data into the local project folder. If you wish to set a separate 
default location to save or load your data for convenience, you can change the default by 
following the steps below. 

Note: Please exit Insight prior to making any changes to the project file. Relaunch Insight 
after saving and closing the project file. 

Changing default location 

1. Locate and open the project directory in the local disk. 
2. Right-click the dug.project file and open with any text-based editing software. 
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3. Under directories, replace the folder names at the second column with the desired path
surrounded by double quotes. 

4. When you are done, click on File and select Save. 
5. This will change the import/export/save defaults to the location specified. 

The example above changes the default path for seismic volumes. After editing the dug.project 
file, every time the user wants to import or export a volume, Insight will open the desired 
directory as the default. This just changes the default path; the user can still browse and save 
the volume at another location. 
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Why is exporting data from Insight light on 
CPU but heavy on RAM? 

Depending on the export, the issue could be I/O bound, waiting for the hard disk to spin. 

Unless there is anything highly computational in the export, you should expect to see low CPU 
usage. If you are exporting computationally-intensive data, use the performance slider in the 
Export Volume window to spread the load over multiple CPU threads. 

The export performance slider controls how many export tasks are created and shared 
between the CPU cores. Each task requires memory and in this case, it adds up to using 
everything that is available. 

Pauses occur during export if Insight fills its assigned memory and needs to clean up. 

If this is happening regularly, reduce the performance setting to a lower level. Lower values 
reduce the number of concurrent tasks and the memory requirements. 

For processor intensive tasks this will increase the export time. 

If possible: 

• Increase the memory allocated to Insight in the DUG Launcher (see Allocating Memory). 
• When running big export tasks, assign 80-90% of the total memory. 
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This allows more tasks to run concurrently before a memory clean up is required, and may 
completely bypass the need for a clean-up. 

 

If the issue persists or you would like specific advice, do not hesitate to contact our support 
team at support@dugeo.com for assistance. 

For more information, see Exporting a Volume to DUG I/O. 
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Performance 
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Why is Insight running unusually slow? 
Performance issues can be notoriously difficult to diagnose due to the shear number of factors 
involved. If you are unhappy with the performance or suspect something is wrong, our advice is 
to send us diagnostic logs while Insight is slow or unresponsive (see Viewing and Sending 
Diagnostic Logs). We will often get a response to you within minutes. 

However, it may be useful to understand how Insight runs on your machine and what might be 
causing it to perform poorly. This could help you troubleshoot the problem yourself. 

How Insight uses memory 
When you open a project, Insight only loads the basic details of the sessions and files (e.g. name 
and type of volume) into memory, not the whole product. The size of the project directory does 
NOT impact the performance of Insight. Generally, Insight should be as responsive for a 50TB 
project as it is for a 50MB project. 

However, the size of a session – how many products must be loaded, what displays open up, 
etc – can impact the responsiveness of Insight and the time it takes to open the session. Insight 
only loads into memory what is required to fulfill the display. Hence, memory usage would 
always be low until you wanted to display something in Insight's Views (there are several 
exceptions to this rule, which are highlighted below). 

When you are displaying data, Insight renders from an in-memory cache, which it loaded from 
your product (and then, just the parts it needed). So if the cache is much bigger than what it 
needs to display, it may have other information in memory and flicking between volumes can 
be very fast (since no more disk IO is required). If, however, your memory allocation is too small 
(see Allocating Memory), it will have to throw away the previous data in order to display the new. 
This will cause Insight to be slow when rendering new data. 

Simply limiting the display of products to a reasonable amount by disabling them in the control 
panel will allow Insight to run a little faster (see Activating/Deactivating Items). Limiting a session 
to the products required – so that you are not updating a flattener you no longer use, for 
example – should also improve performance (see Irrelevant data below). 

Factors affecting performance 
The following pointers are the most common reasons why Insight is not performing as well as it 
should be. 

Memory allocation 

The amount of memory to allocate to Insight depends on the size and complexity of the project 
and how much RAM is available on your machine (see Allocating Memory). 
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As a precaution, you should leave approximately 2GB RAM for your operating system. If you run 
other applications simultaneously, you should also allow for these. If the entire computer 
begins to feel sluggish, you have probably chosen too large a number. It is generally better to 
allocate less if you are unsure. For example, on a machine with 16GB of total RAM, you should 
allocate no more than 14GB for Insight. 

Hardware 

For recommended hardware requirements, please refer to System Requirements. 

Network/external hard-drive I/O limitations 

Storing volumes, horizons or projects on an external USB or network drive could cause 
slowness issues if the I/O capabilities are not up to scratch. Generally we recommend 30 MB/s 
sustained transfer capable connections. 

Process volumes 

Process volumes are generated on the fly by processes in Insight. Processes can be fed into 
one-another so that the end volume is the product of several individual processes. 

For example, an Incoherence volume might be constructed using: Dip process -> SOF process -> 
Incoherence process 

Viewing the final Incoherence Process is computationally intensive and may be slow to display. 
In situations such as this, you can to export the final process volume to disk to retain 
performance (see Exporting a Volume to DUG I/O). 

Volumes with phase rotation applied 

Phase rotation is also a computationally intensive operation. Propagating horizon picks on a 
phase rotated volume will be far slower than usual because Insight must perform a phase 
rotation for each trace prior to propagating new picks. 

Phase rotated volumes are process volumes and should be exported and saved on disk (see
Exporting a Volume to DUG I/O). 

2D survey tie-points 

We have experienced some cases where having a 2D survey comprising very closely spaced tie-
points has resulted in performance issues. The reason for overly dense tie-points could de due 
to poor, erratic navigation data in the original 2D SEG-Y files. You can check the number of tie-
points defining each 2D line by exporting the survey file and opening in a text editor such as 
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wordpad. If you suspect this may be the cause, we may need to downsample your survey for 
you. Or you can regenerate the survey file by re-loading in the SEG-Y files, and at the Survey 
creation screen, increase the maximum error from its default 10m to 20m. 

Horizon used in a process such as flattener 

Picking a horizon that is being used in another process such as a flattener can cause slowness 
because the flattening process updates with changes to the horizon. 

Time-depth conversion 

Viewing TWT volumes in the TVD domain will place more demand on your machine due to the 
depth conversion process involved. Furthermore, it is important to ensure that the velocity 
volume used is not too densely sampled. 

The standard practice in DUG's service division is to use a velocity model sampled at around 
100m x 100m x 24ms/20m. If your velocity volume is more dense than this, you may wish to 
consider downsampling using the velocity conversion process. 

View extents 

Insight only loads data into memory that is required to satisfy the field of view. Zooming in on 
the map and section views will reduce the field of view and consequently the amount memory 
and processing time required. 

Irrelevant data 

As a last resort, any datasets that are not actively being used (such as contours, culture files, 
and non-essential horizons) can be hidden using the traffic light controls in the control panel. 
Less information displayed means less demand on your machine, and the faster Insight can 
perform. 
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Why is my session taking so long to save? 

If Insight is taking longer than several minutes to save a session, there may be something 
wrong. If you can, use the DUG Launcher to send logs and we will investigate and try to 
understand why. 

• Slow network or busy file server 
• It is waiting for another copy of Insight in the same project to complete some work 
• The connection to the server was lost 

There are common reasons Insight can take a long time to save a session: 

Slow network or busy file server 
Insight relies on the speed of the network and file server. If the file server or network is very 
busy, it can result in poor Insight performance. 

How to identify: 

• Many users are affected. 
• All projects are affected. 
• Other software is affected. 
• Talk to other network users. Are they also running slowly? 
• Many actions (saving session, creating new items) take longer than expected). 

Solutions: 

• Send logs. 
• Be patient. Wait longer. 
• Talk to the system administrator to identify performance problems. 

It is waiting for another copy of Insight in the same project 
to complete some work 
It is rare but sometimes another Insight in the same project will take a long time to complete its 
work. If this happens when it is writing to the database, your copy of Insight must wait for its 
turn to write the session. This should not take more than a few minutes. 

More common when using busy projects with many active users. 

How to identify: 

• Only one project is affected 
• Other users in the same project are affected. 
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• Talk to other users in the project. Are they having similar problems? Are they also running 
slowly? 

• Many actions (saving session, creating new items) will take longer than expected. 

Solutions: 

• Send logs. 
• Be patient. Wait longer. 
• Investigate whether the network or the file server is busy. 

The connection to the server was lost 
Temporary network errors can cause Windows to lose the connection to the project area. 
Usually it recovers quickly and is not noticeable. If the error happens when Insight is working, 
Insight may be unable to use the database without restarting. 

Consider this if there are few users of a network project. 

How to identify: 

• Only one project is affected 
• Only one user (or very few) are affected. 
• Talk to other users in the project. Are they also running slowly? 
• Any actions such as saving sessions, and creating new items will be stuck. 

Solutions: 

• Send logs. 
• Talk to other users in the project. Are they having similar problems? 
• Manually close or kill Insight. 

If the save takes more than 10 minutes and is not progressing, consider manually closing the 
Insight process. Insight performs an autosave of a session every 5 minutes (details here), so it is 
very rare to lose work. 
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In Linux, why does Insight run out of 
memory for no good reason? 

Insight is a multi-threaded application. Using multiple threads lets a program run more 
efficiently and also takes advantage of multiple CPUs and CPU cores. When Insight starts, it 
prepares a pool of "worker threads", ready to perform calculations and collect results. 

In the Linux OS, threads and processes are handled very similarly. There is a default setting 
that limits the total number a user can have at any one time. The default setting is often 
very low and not appropriate for a single-user workstation. 

• Check your limits 
• Update the limit 

Check your limits 
These commands should all be run from a terminal window. 

• To find the maximum number of threads and processes a single user can have at any one 
time: ulimit -a 
• Several pieces of information are returned, look for: max user processes 
• For a single-user workstation or virtual machine, this value can be set to a much larger 

number (e.g. 100000) without causing issues. 

• To find the current number of running threads -- this number will vary depending on the 
number of programs and activity on the machine: 
1. ps -elfT | wc -l OR 
2. cat/proc/loadavg 

1. Look at the fourth column (it includes a '/' character). 

• This field shows: "currently executing processes" / "total processes" 
• e.g. 0.72 0.58 0.48 2/867 19334  -> 2 executing processes / 867 total 

• To find the the total limit across all users for the machine: 
• sysctl -a | grep kernel.pid_max 

Update the limit 
These commands require administrator/root permissions. Be careful when making changes to 
system files or have your IT administrator do it for you. 
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• Set the process limit to a new value. The limit will return to the default when the machine is 
restarted. 
• ulimit -u 10000 

Updating the limit permanently depends on the version of Linux you are using. 

 

 Note: You must completely log out of the account and log back in for these changes to 
take effect. 

 

If you are using PAM, these settings can be configured in: 

• Configuration file: /etc/security/limits.conf 
• These lines set the limit for all users: 

*          soft    nproc     16384 
*          hard    nproc     16384 

If you are using a RedHat variant, you can try: 

• Configuration file: /etc/security/limits.d/90-nproc.conf 
• These lines set the limit for all users: 

*          soft    nproc     16384 
*          hard    nproc     16384 
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Licensing 
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How do I activate floating licence for 
multiple users? 

Once you have received your floating licence token from DUG, you can activate the licence 
for multiple users without having to input the licence token for each user. 

After you have activated the licence for one user, the licence details will be stored in a file 
(client.db) in that user's home directory. Follow the steps below to locate and copy the file 
over to multiple users. 

Note: Every instance of Insight consumes a floating licence. Hence, opening multiple 
projects on a single machine will occupy multiple floating licences. 

1. Before we begin, make sure you do not have any existing licence token in your workstation. 
Do a quick search for any client.db files and delete them. 

2. Activate the licence by following the steps in Online Activation or Email Activation. This will 
create a new client.db file in your home directory. 

3. Search for the file (it is normally located at C:\Users\[username]\.dugeo\client.db) and 
copy (or replace if necessary) the file to each relevant user account on each of their 
computers. 
Note: The location of this file may vary depending on the operating system the machine is 
running (see Home directory). 

4. Restart Insight. 

The licence should be activated for all users now. 
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Why did my online activation fail? 

Online activation requires an active internet connection. 

If the online activation fails, your computer has either lost its connection to the network, or 
it requires a proxy to contact our licence servers. 

First of all, check that your device is connected to the internet. If it is offline, connect to a 
network that has an active internet connection. 

If you are certain that the device is connected, check your proxy settings by following these 
steps: 

1. At the prompt, or from the Help menu, select Licence Manager. 
2. From the Licence Manager, click on Network Settings. Alternatively, if you have received an 

error message telling you that the application is locked, select Configure Network. 
3. In the Proxy tab of the Network Settings window, select Manual proxy configuration. 

Depending on your system, you may not need to fill all the fields. 
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 Note: If you are unsure about how to configure your proxy settings, please consult 
your IT department, or look in the connection settings of a web browser like Internet 
Explorer or Firefox. 

Alternatively, see Email Activation to activate your licence offline. 
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How can I see who is using the floating 
licences? 

To see which users are using which modules on which computers, visit 
http://license1.dugeo.com/license/active?XXXX-XXXX-XXXX-XXXX-XXXX-XX (replacing the Xs 
with your DUG licence token). 

See the following example: 

 Note: Every instance of Insight consumes a floating licence. Hence, opening multiple 
projects on a single machine will occupy multiple floating licences. 
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Why doesn't my floating licence work, even 
after a successful activation? 

A valid, successfully-activated, floating licence will not work if the software is unable to 
connect to the licence server, or is configured to use the wrong server. 

You may encounter error messages such as this, despite having successfully activated a non-
expired floating licence. 

This can be caused by either incorrect proxy settings being entered after activation, or incorrect 
floating license server details. 
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Check network settings 

Click on Configure Network and ensure that the Proxy settings are correct. If you do not use 
a proxy, then ensure that No Proxy is selected. 

Check floating server 

Click on the Floating Server tab to check which server you are using. 
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The default setting is DUG's main server. Unless you or your IT department has made a special 
arrangement to operate a local licence server, be sure that Use DUG's main server is selected. 

Otherwise, your licence will activate successfully but you will not be able to actually check out 
the licence and use Insight. 
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Sessions and Projects 

Page 36FAQ



What is the best way to copy and send DUG 
my project database? 

Depending on the situation, Insight support may request your project database for analysis 
in-house. This is a quick guide on how to copy and send your project database files to us. 

Note: We understand that the contents of any data sent to us are confidential and intended 
for testing and bug fixing purposes only. Under no circumstances will the data be shared or 
distributed to anyone other than those necessary to solve your problem. You have our 
promise that we will safeguard your data to the best of our ability. Once we have solved the 
problem and closed the support ticket, your data will be removed from our system. 

• Copy database via Data Manager 
• Copy .dugprj file 

Copy database via Data Manager 

The safest way to copy a project database is to use the Backup feature in Insight's Data 
Manager tool (see Backup a Project Database). 

1. From the DUG Insight Launcher, select the project that you want to copy and the Data 
Manager application, and click Launch. The Data Manager window will be displayed. 
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2. In the Data Manager window, select Backup. 
3. Choose a Backup Parent Directory where you want to keep a copy of the project, or create 

a new parent directory. 
4. Type a name for the Backup folder inside the parent directory (by default, Data Manager 

sets the name as the current date and time) 
5. Deselect Copy dugio volumes, Copy horizons and Copy images. We are only interested in 

the project database (.dugprj) file. 
6. Click Create Backup to copy your project. A notice will appear to confirm that the copy has 

been created at the path you specified. 

Right click on the backup project directory, select Send to and create a compressed (zipped) 
folder. 

Send this zipped copy to support@dugeo.com or upload it to our FTP site (see How to upload to 
our FTP server? for instructions). 

Copy .dugprj file 
Alternatively, if you do not have access to the Data Manager tool, you can directly copy the 
database file from the project directory. 

1. Navigate to the project directory of the database. 
2. Right click on the project.dugprj file, select Send to and create a Compressed (zipped) 

folder. 
3. Send this zipped copy to support@dugeo.com or upload it to our FTP site (see How to upload 

to our FTP server? for instructions). 
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How do I load sample data? 

The sample datasets are mini self-contained DUG Insight project directories, each with a 
pre-configured session. Follow these steps to get started. 

Loading sample data 
1. Download the sample data from http://www.dugeo.com/software/resources/sample_data. 
2. Unpacking the ZIP file will create a new directory called "Insight-sample-2D-project" or "Insight-

sample-3D-project". 
3. Run the DUG Insight Launcher by selecting the Insight icon from the Start menu, Desktop, 

or (on Mac OS X) Applications directory. 

4. Click Open Project to browse for the project directory. 
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5. Navigate to where you unpacked the ZIP file, and click Open Project. 

6. Select DUG Insight at the Choose an Application section and click Launch. 
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7. Select Open Session from the File menu. 

8. Choose the sample session and click Open. 
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How should I backup my project? 

Currently, there are two ways Insight can backup your project: 

• Insight's default automatic backup, and 
• manual backup using Data Manager. 

We recommend using both methods to backup your project as they are both unique in the 
way they perform the backup. The automatic backup creates a copy of the .dugprj project 
database file in a .backup folder in your project directory. However, horizons, volumes, 
TIFFs, etc, are NOT contained within the database. The database file only contains 
references to the individual objects and not the actual physical copy. To physically backup 
the project directory, you have to use the Backup feature in Data Manager. Hence, it is 
recommended that you regularly create full, physical backups of your Insight project as 
well. 

Do NOT copy the project using normal tools (i.e. copy/paste), as Insight might modify the 
files during copy, or other users might be logged in and modifying the project while the 
backup is done, resulting in a corrupt copy of the project database. The only safe ways to 
make backups are the two mentioned in this lesson. 

Note: The automatic backups configured in the project settings should not be confused 
with session autosaves. Autosaves record the session (not the project), and occur once every 
5 minutes. Only one autosave is available per session as each new autosave overwrites the 
previous one. As soon as the session is manually saved on closing, the last autosave is 
discarded (see Autosaves in Project vs Session). In contrast, the Automatic Backup creates and 
keeps a number of copies of the project database (as defined by the user) at a user-defined 
frequency. 
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Automatic backup 

When creating or configuring a project, you can enable automatic backups by selecting Perform 
automatic backups under the Backup Settings section. Specify the number of hours that 
must pass for Insight to create a new backup and the number of copies you want the system to 
keep before deleting older copies. 

The automatic backup creates a copy of the .dugprj project database file in a .backup folder in 
your project directory. Before backing up, Insight will check if there are other users logged in 
(an "integrity check"), and locks the project from being modified while it backs up the project 
database to the backup folder. At every start-up of the project, Insight will automatically check if 
the required hours have passed to create a backup. It it has, then it will create one. 

Note: If your database is corrupted, Insight will disable access to the database until the project 
is fixed. This is to prevent any further file corruption, and prevent Insight from generating 
backups of the corrupted project. If your database is corrupted, please consult our support 
team at support@dugeo.com. You might be required to send diagnostic logs of your project 
session to help us understand why it is happening (see Viewing and Sending Diagnostic Logs). 

The following image shows an example of the backup folder and backup project database files. 
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Note: The backup folder might be a "hidden" folder. If you do not see the backup folder in your 
project directory, you might have to enable viewing of hidden files from the Folder Options of 
your machine's Control Panel (see Show Hidden Files). 
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Data Manager manual backup 

The Backup feature in Data Manager creates a physical copy of the project directory into a 
Backup Parent Directory of your choice. By default, Data Manager sets the Backup Name as 
the current date and time for convenience when restoring using the Restore feature (see
Restore a Project Database). 

Select the Copy dugio volumes/horizons/images check boxes to backup the physical copies of 
the objects. As volumes are often large files, you can choose to ignore volumes over a certain 
size by specifying the maximum size in the Don't copy volumes larger than X MB field. If you 
do not select the check boxes, the backup will only copy references to the objects. 

Any volumes external to the project will not be included when you create a backup. To create a 
copy of the database with external volumes, see Clone a Project Database. 

Note: Backups of the project database file generated by the automatic backups are NOT 
included in the Data Manager backup directory. 
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Where is my user home directory? 

In a machine with multiple users, user-specific files are stored in a default home directory 
for each user. For Insight, user-specific files that are saved in user's home directory include 
the: 

• global.properties file — containing configuration files and preferred settings for HTTP 
proxy and problem reporter settings (i.e. email, notification enabled, etc) 

• client.db file — containing Insight's licence details for the user (i.e. floating/node-lock, 
licence number, etc) 

• DUG_Launcher.properties file — containing Insight's launcher settings/history (i.e. 
recently opened projects and memory allocation). 

The location of these files may vary depending on the operating system the machine is 
running. The table below shows the path of the home directory for different operating 
systems. 

Operating System Path Environment Variable 

Microsoft Windows NT (root)\WINNT\
Profiles\(username) 

%UserProfile% Microsoft Windows 
2000, XP and 2003 

(root)\Documents and 
Settings\(username) 

Microsoft Windows 
Vista, 7 and 8 

(root)\Users\(username) 

Unix-Based (root)/home/(username) 

$HOME and ~/ 

Unix-Derived /var/users/(username) 
/u01/(username) 
/usr/(username) 
/user/(username) 
/users/(username) 

SunOS/Solaris /export/home/(username) 

Linux/BSD (FHS) /home/(username) 
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AT&T Unix (original 
version) 

(root)/usr/(username) $HOME 

Mac OS X /Users/(Username) $HOME and ~/, and path to home 
folder (in Apple Script) 

OpenVMS (device):[username] SYS$LOGIN 

Android /data/media/(userid) 
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How do I sync my session across offices? 

In our experience, many of our users work within teams across multiple offices, and it is 
vital to be able to sync project data and sessions between offices. 

For this purpose, we have created a feature in Data Manager specifically to copy project 
data and sessions to a new project or an existing project. 

For more information, see Copy Objects to Project. 

Copy Objects 

1. Open the Data Manager application from the DUG Insight Launcher. 
2. In the Copy Objects interface, create a new project. The new project will be the container 

for the items to be transferred. In these instructions, we will call it the "container project". 
3. To transfer items to the container, choose Push To and click Select items to copy. The 

following window will be displayed. 
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4. Include your session in the Items to Copy section by double clicking, or selecting it and 
clicking Add. Be careful if you choose to include seismic data! The size of the transfer can get 
large very quickly. 

5. Click OK. 
6. When you click Copy Items and complete the process, all the items in the session will be 

copied into the container project. 

Once the process is complete, the container project can be zipped, archived, or transferred 
directly using rsync (refer to your IT department for assistance). 

After transferring the session to the destination, have the destination project open, and use the 
same Copy Objects function. This time, choose Pull From to copy the session out of the 
container project. 

Genuine offer of assistance 
If the transfer is unsuccessful, or if you have any questions, please contact our support team at 
support@dugeo.com. 
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Workflows 
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How do I create "fake" source and receiver 
headers from offset values? 
Use the following approach to calculate artificial source and receiver headers that are 
consistent with the trace offset value. 

1. Create a Header Maths process. 
2. Select the gathers volume. 
3. Click the "+" button in the Formulae section to add a formula. 

For offset values in the same units as the X/Y coordinates (i.e. metres to metres, feet to feet), 
use: 

 

A unit conversion can also be applied. For offset values in feet and X/Y coordinates in metres, 
use: 
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Calculate a Pseudo-Relief Attribute (TECVA) 

Generating a pseudo-relief attribute (also known as TECVA) can assist with structural 
interpretation. It is often easier to correlate events on the enhanced reflectors, simplifying 
both fault and horizon interpretation. 

Reference: Bulhoes, E. M., 2005, Principio da SismoCamada Elemantar e sua aplicacao a 
Tecnica Volume de Amplitudes (tecVA). Ninth International Congress of the Brazilian 
Geophysical Society. 

1. Go to the Process tab, add a Volume Maths (Simple) process (see Volume Maths Process 
(Simple)). 

2. Volume Maths (Simple) settings: 
• Volume 1 and Volume 2: Select the input stack. 
• Use the multiply operation: x volume. 

3. The result will be a selectable volume. 
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Next, average the squared input stack from the previous process. 

1. In the Process tab, add a new Volume Smoothing process (see Volume Smoothing). 
2. Volume: select the created volume from the previous process. 
3. A new volume will be created. 
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Next, find the square root of the average (from the previous process). 

1. Add a Volume Maths process from the process tab (see Volume Maths). 
2. Click the blue "+" in the Volume Maths panel. 
3. Volume Maths settings: 

• Symbol: v1 - select the volume created from the averaging steps. 
• Formula: sqrt (v1) 

4. A new volume is created. 

Phase rotate the pseudo-RMS using a process. 

1. Add a Phase Rotation process (see Phase Rotation) 
2. Phase Rotation settings: 

• Volume: select the square root volume. 
• Degrees: -90 

3. The new volume is created. 
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Finally, apply a Low-cut filter to remove low-frequency vertical striping. 

1. In the Process tab, add a Band-pass Filter process (see Band-pass Filter process). 
2. Band-pass Filter settings: 

• Volume: choose the phase-rotation volume 
• File type: choose High-pass 
• Windowing Model: select <<Whole Trace>> 
• Stop: 2Hz 
• Pass: 3Hz 

3. If the result looks "smeared", try increasing both the Stop and Pass values by 1 or 2 Hz. 
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How do I create a "chair" display in the 3D 
view using two different volumes? 

1. Go to the Process tab and create a Volume Sculpt process (see Volume Sculpt process) e.g. 
"Incoherence sculpt". 

2. Use the incoherence (or other time-slice attribute) as input for the Volume field. 
3. Set the Top horizon as Constant value of the slice to display, e.g. TWT 2680. 
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4. Go to the Group tab and create a group e.g. "Chair inco+seismic". 
5. Click the blue "+" button and add the volumes for: 

• "Incoherence sculpt", 
• Seismic stack (or volume to display vertically). 

6. In the 3D View,  select the group in the Vol search box. 
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7. Turn on IL, CL and TWT (e.g. at TWT=2680). 
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How to calibrate interface PDFs to seismic 
amplitudes using crossplots 

The workflow is based around a specific event. Also, instead of determining the reflectivity 
from the seismic, we will scale the reflectivity PDF model to match the seismic. Some kind of 
inversion is the best way to calculate reflectivity from seismic. 

1. Start by picking as much of the event as possible. 
2. View the horizon property, "Peak Secant Amplitude" [PSA] to extract amplitudes from the 

stacks. 
• This property correlates better with reflectivity than "vanilla" peak amplitude. 
• View the result in the map view, right click and "Save horizon as a custom property" and 

add to the picked event. 
• Do this for near and far stacks. 

3. Create a probe that encompasses the area of interest. 
4. Create a new crossplot. 
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5. Choose the probe area of interest and configure: 
• Data Type: Horizon, 
• Data Source: your picked event, 
• Property: PSA (near or far) 

6. In the LithoFluid Model tab: 
• Choose the reflectivity (dupdf) model (must be loaded in the QI tab first), and select the 

near vs far attribute. 
• Select the appropriate depth for the event from the model depths. 

The next step is finding the correct scaling. This is a visual calibration approach, rather than an 
analytical approach. The robustness of this method depends strongly on the well control. 
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7. On the map, draw a polygon around one of the wells that intersects the event. 
• Name it appropriately. In this case, it is a top reservoir gas event. 

8. In the crossplot, highlight these points 
• In the Polygons tab, click the polygon and view the points on the crossplot. 

9. You now have a single calibration area for a known lithology interface at the well. 
• Repeat this a few times at other wells, ideally highlighting different lithologies. 

10. In the Lithofluid model tab, enable the corresponding PDF for the lithology at the well. 
11. Adjust the Scale values until the PDF ellipse lands on the appropriate crossplot points. 
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12. Enable additional lithologies and confirm the scaling makes sense. 
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13. Enable highlighting to review how the scaled ellipses correspond to locations in the map. 
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How can I created a layered result from 
many different input volumes merged at 
horizons? 
Use volume maths with a series of nested “if” statements. 

Any number of volumes can be merged this way, but it can be difficult to spot problems when 
using more than five. It is easier to work in separate sets (i.e. shallow set, middle set, and 
deeper set), then combine the shallow/middle/deep in a final process. 

e.g. To merge 14 volumes (v1... v14) at horizons (h1... h14) 

• Merge volumes 1-5 in one process > “MergeShallow” 
• Merge volumes 6-10 in one process > “MergeMiddle” 
• Merge volumes 11-14 in one process > “MergeDeep” 
• Review each set of layers before combining. 
• Combine “MergeShallow”, “MergeMiddle”, “MergeDeep” 

Merge 5 volumes at horizons e.g. "MergeShallow” 

• Given horizons: 
• h1, h2, h3, h4, h5 

• and volumes: 
• v1, v2, v3, v4, v5 

if(twt_ms <h1, v1, 
        if(twt_ms<h2, v2, 
                if(twt_ms<h3, v3, 
                        if(twt_ms<h4, v4, v5) 
                ) 
        ) 
) 

Repeat for the other sets. Merge these combined models using a similar approach. 

Given horizons (from above): 

• h5, h10 

and 3 combined volumes "MergeShallow", "MergeMiddle", "MergeDeep": 

• v1, v2, v3 

if(twt_ms<h5, v1, 
        if(twt_ms<h10, v2, v3) 
) 
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How to interpolate RMS values on a 2D 
horizon? 

Ghost the 2D horizon 

1. In the Map View, select to display the 2D horizon which you want to create the ghost 
horizon. 

2. Expand the left panel and open the Operations tab. 
3. Select Ghost at Operation. 
4. Ghost the 2D horizon to the top and bottom of the interval that you want RMS over. At 

Amount (ms), a negative value will place the ghost horizon above the original horizon and a 
positive value below. 

5. Click Ghost. 

 Note: The Ghost button will be disabled if the horizon you are using in the operation is 
pending on another operation such as propagation. You will see a notification of the 
pending operation that you should complete before continuing with the current 
operation. 

6. When the ghost horizon has been generated, click Save as New Horizon to keep the 
horizon. 
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Amplitude Extraction to get RMS 

1. From the Operations tab in the map view, select Amplitude Extraction at Operation. 
2. At Top and Bottom, select the top and bottom horizons (ghosts) between which Insight will 

extract the amplitude. 
3. Select the input volume for the operation at Volume. 
4. At Property, select RMS as the extraction method to be used in the operation. 
5. Click Run to run the operation. 

 Note: The Run button will be disabled if any of the input horizon you are using in the 
operation is pending on another operation such as propagation. You will see a 
notification of the pending operation that you should complete before continuing with 
the current operation. 

6. When the operation is completed, select Create new to save as a new horizon. 

 Tip: Click on the Help icon to read more information about this operation. 
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Regrid the extracted RMS 

1. In the Map View, select the extracted RMS as the Horizon. 
2. From the Operations tab, select Regrid at Operation. 
3. At Output Survey, select <<X/Y>>. 
4. Regrid the extracted RMS with a small enough increment to honour the CMP bins. 
5. Clear the Interpolate check box, or use a small search distance. 
6. Click Regrid. 

 Note: The Regrid button will be disabled if the horizon you are using in the operation 
is pending on another operation such as propagation. You will see a notification of the 
pending operation that you should complete before continuing with the current 
operation. 

7. Once the horizon has been processed, select Save as New Horizon. 

 Note: After regridding, the interpretation may appear very small. Zoom in to confirm 
regridding occurred. 
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Interpolate/extrapolate 

1. From the Operations tab in the map view, select Interpolate/Extrapolate at Operation. 
2. Select the Extrapolate checkbox. 
3. At Fill area, select a polygon to constrain the area to fill with the selected polygon. 
4. Click Extrapolate. 

 Note: The Extrapolate button will be disabled if the horizon you are using in the 
operation is pending on another operation such as propagation. You will see a 
notification of the pending operation that you should complete before continuing with 
the current operation. 

5. Select Replace this horizon or Save as New Horizon to keep this horizon. 
6. This should generate an interpolated RMS map. 
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How do I make an isochore or isochron map 
in Insight? 

A simple horizon maths operation can be used to create an isochore or isochron map in 
Insight. An isochore map is the true vertical thickness between two horizons; an isochron 
map is the vertical time between two horizons. Both maps are created in a similar way. See 
Isopachs, Isochores, and Isochrons for more details and to create isopach (stratigraphic 
thickness) maps. 

1. Open Map View and begin a Horizon Maths operation (see Horizon Maths).  
2. At the Inputs section, input horizon 'h1' and 'h2'. 

a. For an isochore map, set the property as TVDSS (m). 
b. For an isochron map, set the property as TWT (ms). 

3. At Formula, insert the formula: h1 - h2. Make sure you are subtracting the shallower 
horizon from the deeper one. 

4. Select the output vertical dimension. 
a. For an isochore map, set the output property as TVDSS (m). 
b. For an isochron map, set the output property as TWT (ms). 
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 Note: If you do not want the newly created horizon to show in section view, set the 
vertical dimension to <none>. Without the vertical dimension, you will only be able to 
view it in Map View. 

5. You can optionally constrain your isochore/isochron map by selecting a polygon for the 
‘Area’. 

6. The output is a horizon property of vertical thickness (isochore) or time (isochron) between 
the input horizons. You can save this as a custom property to an existing horizon or create 
a new horizon. 
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How can I update a horizon to tie markers at 
wells? 

There are two approaches to this: 

1. Shift the entire horizon by some constant 
• Find an average shift to apply to the entire horizon 

2. Shift the horizon by a spatially varying value 
• Find a local shift to apply in regions around the wells 

Constant Shift 

1. Calculate the difference between this value and the average horizon depth, then use the 
Horizon Operation / Ghost to create a shifted version. Read about the Ghost (horizon) 
operation. 
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Spatially Varying Shift 

The other approach, which works nicely if the horizon is picked consistently, is to vary the shift 
spatially depending on the difference at each well. Use the following workflow: 

1. Create a horizon from the well markers. Give it a name e.g. "markerHorizon". 
2. Use a sparse increment e.g. 500m. 
3. Set the smoothing power to 1 or 2. 
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4. Comparing original horizon to marker horizon. 

5. Calculate the difference between the horizon and the marker horizon "difference". Read 
more about Horizon Maths operation. 

6. Use the Horizon Maths operation and use the formula: a - b (where a is your horizon and b 
is the  markerHorizon). 
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7. Use the Smooth operation on the "difference" horizon. 
• Use a large radius e.g. 500m or larger. 
• Larger smoothing values take longer, but preserve the character of the original horizon 

better. 

8. Click the Smooth button and save the result e.g "smoothedDifference". 

Page 79FAQ



9. Add the smoothed result to the original horizon. 
10. Select the Horizon Maths operation again. 
11. Use the formula: a - b (with a being your horizon and b being the just created 

smoothedDifference horizon.) 
12. Click Run and save the new horizon. 

13. The resulting horizon should closely tie the markers at each of the wells. Note the is greater 
distortion of the original horizon when the correction values are large. 

Page 80FAQ



Transforming images into 3D horizons in 
Insight 

Integrating all available data is crucial for proper subsurface evaluation. Sometimes 
available data may include structure contour maps taken from literature or other sources. 
This workflow demonstrates how to trace contours using faults sticks to create a file of XYZ 
points that can be imported into Insight as a horizon. 

In this example, an image of Top Tensleep TWT structure from Chiaramonte et al. (2011) is 
transformed into a horizon in Insight. 

• Step 1: Map lines on contour map using fault sticks 
• Step 2: Create polygons to constrain the horizon 
• Step 3: Export fault sticks into a single file and modify 
• Step 4: Import .dat as a horizon 
• Step 5: Regrid and interpolate 
• Step 6: QC and smooth 

Workflow 
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Step 1: Map lines on contour map using fault sticks 

1. Import the image via Import > Culture (see Importing Culture Files). 

2. Create a new fault for each contour line (see Picking Faults). 
• To set the vertical position that the fault stick is mapped on, adjust the time or depth 

value in the top left corner of the map view 

 Important: Pick faults at a high resolution! The goal is to create a horizon based on an 
input file containing XYZ points. Each individual point will be used to create a horizon 
once the file is imported back into Insight as a horizon. In this example, a point is 
added about every 50 m along a contour line. 

 Note: The flat appearing areas above contour 1010 and 1050 in the example likely 
have some curvature that is below the resolution of the contours. To make the horizon 
more geologically realistic, add a fault stick at the crest with a TWT value that is less 
than the contour value just below. This will add points higher in the structure so the 
horizon does not appear totally flat in these areas. 
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Step 2: Create polygons to constrain the horizon 

3. With the culture file displayed, add polygons around the horizon boundaries and faults. 
• This will constrain the area that is interpolated when using the regrid operation after 

importing the file as a horizon. 
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Step 3: Export fault sticks into a single file and modify 

1. Highlight each fault sticks of the mapped contour in the Fault panel. 
2. Right-click > Export (see Exporting Faults). 
3. Open the .dat file in a text editor (e.g. Notepad) 

• The exported file will contain information that isn’t needed when reimporting the file as a 
horizon. 

• Delete all headers for each fault stick 
• Once the headers are deleted, save the file. 
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Step 4: Import .dat as a horizon 

1. Import modified file as a horizon via Import > Horizons. (see Importing Horizons). 
2. Assign the X, Y and Z values to the correct column. 
3. Click OK to continue importing. 
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Step 5: Regrid and interpolate 

1. Go to Map View and select the horizon. 
2. The horizon will display as points on an irregular grid. 
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To create an interpolated horizon, you’ll need to regrid the horizon and interpolate. 

3. In the Map View, click the Operations tab and select the Regrid operation to put horizon 
onto a regular grid. 

4. Tick the Interpolate box and adjust interpolate parameters accordingly. Also consider to: 
• adjust the steps, 
• use polygon to constrain area, 
• and fault polygons to stop interpolation at faults 

5. View the output and click Save As a New horizon to save the result. 
6. Click Discard if you would like to make adjustments to the regrid parameter. 

Step 6: QC and smooth 

1. Once you have regridded and interpolated the horizon, QC the result in Map View. 
2. Turn on contours for easy comparison to the original contour map that the horizon is based 

on (see Contouring in Map View). 
3. Use Operations > Smooth as necessary to create a smoother image (see Horizon 

Smoothing). 

 

 Some useful tips: 
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• In areas that appear flat, may want to add control points slightly lower (if a trough) or 
higher (if a dome) so that horizon isn’t totally flat. This should make for a smoother, 
more realistic horizon and may help avoid odd contours lines. 

• Only draw polygons in areas with faults that have visible offset. Areas in my example 
that had faults with no apparent offset caused gridding problems 

• Add control points (using fault sticks) in areas with large gaps to avoid the gaps from 
appearing when interpolating. 

• Use small tile size when smoothing, then smooth over multiple iterations. 
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Calculating Angle of Incidence 

Angle of incidence can be useful in analysis and in calculations. While angle-mutes, 
raytraced using a velocity model, are the most accurate means of displaying the intercept 
angle, they can be awkward to use analytically. The two methods shown here calculate an 
angle of incidence for use in other calculations. 

• Approximate method (Straight-ray) 
• Accurate method (NMO deviation) 

Approximate Method 
This method finds the angle of incidence assuming a straight-ray cast from the offset to the 
calculated point. This flow creates gathers of incidence angle, from which you can extract 
amplitudes from as you would any other volume. 

It requires: 

• Velocity Model 
• Gathers (to define the offset extents) 
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1. To Calculate depth values sampled in time from the velocities, click Process tab >> add New 
Process >> Velocity Conversion. 

2. Add a name for this Velocity Conversion process and set the values below: 
• Input: Velocity Model 
• Output type: Depth values sampled in time (ZT) 

1. Calculate the angle of incidence at each offset. Go to Process tab >> add New Process >> 
Volume Maths 

2. Add a name for this Volume Maths process and set the values below: 
• Input: Gathers [v1] 
• Input: Velocity-DepthInTime ("Vels_ZT") [v2] 
• Formula: ( atan ( offset / ( 2 * v2 ) ) ) ( 360 / ( 2 * pi ) ) + ( v1 * 0 ) 

3. Set the class of the "AngleOfIncidence" volume to a new class "Angle" and choose a useful 
colourbar (e.g. Banded-Decile-Light) with the range 0 to 100. Read Classes and Colourbars 
Overview. 
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Accurate Method 
This method, derived from the NMO equation, finds a more accurate angle of incidence. 

Given: 

• G0 : A volume of gathers, to define the offset extents (metres) 
• Vint : The velocity model, converted to interval velocity (m/s) 

• Use a Velocity Conversion process if necessary. 

• Vrms : The velocity model, converted to RMS velocity (m/s) 
• Use a Velocity Conversion process if necessary. 

Create a volume maths process, using the above volumes as inputs: 

• Formula: 

asin(sqrt( 
    ( 
        (offset*offset) * (Vint*Vint) 
    ) / ( 
        (Vrms * Vrms) * 
        (twt_ms/1000 * twt_ms/1000 * Vrms * Vrms + offset * offset) 
    ) 
)) * (180/pi) 

The process looks like: 
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And the result: 

In this example, two mutes at 10 and 20 degrees are displayed over a group containing the 
angle of incidence (accurate method, in colour) over offset gathers (in grey). the mutes 
correspond to changes in angle using a banded colour bar and appropriate ranges. 
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How can I calculate pseudo-impedance from 
seismic data? 

You can calculate pseudo-Impedance which can be used as a quick-look approximation of 
actual impedance. 

1. Load a seismic stack from the Volume tab e.g. "Stack". 
2. Calculate pseudo-impendance by using the Volume Integration process. Go to the Process 

tab and add a new Volume Integration process e.g. "PseudoImp-Raw". 
3. Select the earlier loaded stack as Volume and set the method as Integration. 
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4. Apply a bandpass filter to remove low-frequency bias. in the Process tab, add a Band-Pass 
Filter process. 

5. Select the volume created from the Volume Integration process e.g. "PseudoImp-Raw". 
6. Select "High-pass" as the type and the frequency range of 4 to 8 (adjust according to seismic 

bandwidth). 
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An example comparing the log relative-impedance to pseudo-impedance and a band-limited 
impedance (from 3 stacks). 
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Generating synthetic stacks from Intercept 
and Gradient volumes 

An overview of the workflow: 

1. Calculate reference angle stacks from the gathers (see Angle Stacks). 
2. Calculate intercept and gradient from the gathers (see Intercept/Gradient). 
3. Use Shuey's approximation to calculate the synthetic volume (see Volume Maths). 
4. (optional) Band-limit the synthetic to match the reference stack (see Band-pass Filter). 
5. Calculate the residual using Volume Maths. 

Setup 
In this example, we prepared the following data: 

For Angle Stacks 

• Load gathers 
• Load velocity model 

For Spectral Analysis 

• Draw a map polygon 
• Create a window model to evaluate spectra at the target 

For I/G calculation (from gathers) 

• Define angle mutes 
• Load gathers 
• Load velocity model 

Use this workflow. Repeat steps 3, 4 and 5 for additional angles. 

The spectral analysis window is included as a reference. 

• Yellow = Stack 
• Orange = Synthetic 
• Red = Filtered Synthetic 
• Black = Residual 
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Workflow 
1. Create angle stacks from the gathers. We will be using the average of the min and max 

stacking angle for Shuey's equation. 

2. Calculate Intercept and Gradient from the gathers. Use angle mutes to avoid including near-
offset noise and NMO stretch. 
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3. Use Volume Maths and Shuey's equation to calculate the amplitude using the Intercept and 
Gradient results for a specific angle. Note that the trigonometric functions expect radians as 
input (e.g. for 30 degrees). 
• Formula: I + G * (sin(30*pi/180)^2) 

4. Depending on your data, the synthetic result may contain more high-frequencies than your 
angle stack, increasing the energy in the residual. By applying a bandpass filter, we can 
match the synthetic spectrum to the stack spectrum. 

5. Finally, calculate the residual between the stack and the synthetic using volume maths. 
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How to apply complex hand-drawn mutes to 
gathers and combine 2D results? 
When working with complex hand-drawn mutes, the number of control points can quickly grow 
to unmanageable numbers. If you have access to the Image Gather Processing module, then 
consider using a polygon mute instead. This workflow is useful for anyone without access to the 
polygon mute process. 

Instead of creating a single polygon mute for the entire line, create multiple hand drawn mutes, 
applying each mute separately, and combine these muted volumes (using volume maths) so 
that each mute is only applied over a certain CMP range. 

Because it works with CMP values, this workflow is limited to a single line at a time. 

1. Go to the Mute tab and add a New Hand Drawn Mute (see Manual Picking (Mute)). 
2. Pick mutes for first N traces until an unworkable amount of control points appear. 
3. Next, go to the Process tab and add a Mute Gathers process (see Mute Gathers). 
4. Apply Mute Gathers process and select the previously picked mute to create Muted Volume 

A. 
5. Return to the Mute tab and add another New Hand Drawn Mute. 
6. Pick mutes for second N traces until the mute is unworkable. 
7. Apply a new Mute Gather process to create Muted Volume B. 
8. Repeat these steps until mute has been picked over the line. 
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1. Go to the Process tab and add a Volume Maths process (see Volume Maths) 
2. Use Volume Maths process to combine the Muted volumes. 
3. Click the blue "+" button and add the mute gathers created earlier. 
4. In the formula box, apply this equation: 

if (cdp <= 300, v1,  
        if (cdp <= 600, v2, v3, 1) 
) 

This approach can be adapted for more sections by extending the formula, e.g. for 5 sections. 

• v1 to CMP300 
• v2 to CMP600 
• v3 to CMP900 
• v4 to CMP1200 
• v5 rest of line 

if (cdp <= 300, v1,  
        if (cdp <= 600, v2,  
                if (cdp <= 900, v3,  
                        if (cdp <= 1200, v4,  v5) 
                ) 
        ) 
) 
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How do I create a 3D Chair? 

Chair cut seismic displays allow for concurrent viewing of multiple inlines, crosslines, and 
time/depth slices. This display can be created by combining sculpted volumes and can be 
updated on the fly by modifying process inputs. 

Note: The Explorationist module is required for the Volume Sculpting process and the
Volume visualisation feature (see Explorationist module). 

Step 1: Create Two Probes 

The first probe will be used to cover the full extent of the volume which will allow the entire 3D 
'cube' to be displayed in 3D view. To display the data using the probe, select the probe in the 3D 
view > 3D tab and check the Use Probe box. 

1. Probe 1 - used to set the display extents of the 3D view area. 
• Probe 1 can be as large or a small as you would like. This probe will define the maximum 

display extents. 
• In 3D view, open the 3D tab, check the Use Probe box, and select Probe 1. 

2. Probe 2 - This probe will be used to adjust the horizontal extents of the 'back' of the chair. 
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Step 2: Use Three Processes 

1. Volume sculpting 1 
• Use Probe 2 as input 
• Adjusting Probe 2 will change the horizontal extents of this sculpted volume 
• Set ‘Top Horizon’ to Constant value and enter in a value to set the vertical extent of the 

sculpted volume 

2. Volume sculpting 2 
• Used to adjust 'seat' of the chair, no probe is needed as input 
• Instead of using a probe, define top and bottom vertical extents by entering constant 

values in process parameters 

3. Volume combine 
• Add in Volume sculpting 1 and 2, and the output survey 
• This combines the two sculpted volumes into one volume 
• Adjusting the parameters in the input sculpted volumes will allow you to customize the 

display extents 
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Step 3: Configure 3D view 

1. In the 3D tab, make sure the Use Probe box is checked and select Probe 1 (see Volume 
Visualisation). 

2. Select the Volume Combine volume from the volume drop down menu. 
• To define the horizontal extents of the back of the chair, click the pencil icon for Probe 2 

and click-drag the probe to adjust the extents. Click the pencil icon again to leave editing 
mode and the volume extents will update in 3D view. 

• To define the vertical extents, modify the Top Horizon value in the Volume sculpting 1 
process. 

• To define the vertical extent of the seat of the chair, open the Volume sculpting 2 
process, and enter a value for the top horizon. 

• If you'd like to limit the horizontal extents of the seat, this can be done by modifying the 
extents of Probe 1. 

• If you'd like to hide the probes, this can be done by disabling the display in the Control 
Panel > Probe tab. 
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How to estimate seismic bandwidth using 
spectral decomposition? 

Workflow 

Calculate the Spectral Decomposition result: 

1. Click the Process tab, click the blue "+" button and add a Spectral Decomposition process. 
2. Select an Input Volume. 
3. Pay attention to the Spectral Decomposition frequency interval, it's needed for the last 

step. 
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Apply a gate / threshold function to specify the minimum amplitude to qualify for inclusion. 

4. Click the blue "+" button and add a Volume Maths process. 
5. In the details panel, add a symbol and select the result from the previous process. 
6. Use formula: if (v1 > 20000, 2, 1) 
7. Tune this threshold to adjust your results. This example uses 20,000, but it will vary 

depending on your spectral decomposition amplitudes. 

Note: The gate uses values of 1 & 2 to avoid creating "missing values" in the stacking. 
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Stack the gated result (in effect counting the number of frequencies above the threshold). 

8. Click the blue "+" button and add a Stacking process. 
9. In the details panel, select the result from the previous Volume Maths process in the 

volume search box. 
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Rescale the stack by the number of stacked traces (NHS trace header) and the frequency 
interval from step 1. This gives the bandwidth estimate. 

10. Click the blue "+" button and add a Volume Maths process. 
11. In the details panel, add a symbol and select the result from the Stacking process. 
12. Use formula: (v1 - 1) * 3 * NHS 

Note: A constant 1 value is subtracted from the stack to account for the 1-2 range of the gate. 
For this example, the value 3 is the frequency interval from step 1. 

Results 
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How do I reverse the CDP to X/Y relationship 
for a seismic line? 

This procedure will permanently reverse the traces along a 2D line. Be sure you know what 
you are doing! 

Each trace on the line is moved to a corresponding CMP, measured from the end of the 
line. e.g. 

• The first trace of the line is swapped with the last trace. 
• The fifth trace of the line becomes the fifth from the end of the line. 

A copy of the line is exported to SEG-Y, making changes to the CMP header as it is exported. 
The seismic line is then reimported, using the replaced CMP values for each trace. The 2D 
survey geometry is not changed, so the new CMP values result in the trace order being 
reversed. 

Normally, Insight does not allow changing headers that determine the position of a trace. 
For 3D data, these are the IL/CL headers. For 2D data, this is the CMP value. 

When exporting to SEG-Y, Insight quietly looks the other way and does not apply the same 
restriction. 
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1. Right click on the 2D volume, select Export '2D volume name'... 

2. In the Export Volume window, select SEG-Y as the Format (see Export a 2D volume to SEG-
Y). 

3. Disable all lines, then enable the lines that need to be reversed. 
4. Give the file a name at Location. 
5. Click Edit SEG-Y header. 
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6. In the SEG-Y Header Editor window, click the Trace tab. 
7. Find CDP / CMP under Header Name (byte 21) 
8. Click the Source drop-down, and select “Formula”. 
9. Enter the following formula for “Value”: 

• (first CDP + last CDP) - cdp 
• E.g. for a line with CDP ranging from 100 to 1500, use: (100 + 1500) - cdp 

10. To also update the shotpoint, at “Energy Source Point” (byte 17), use the formula: 
• (first SP + last SP) - ep 

11. Click OK to save. 
12. Click OK again to start exporting. 
13. Once the export is complete, save the session and exit Insight. 

 Tip: To QC the result, export the original survey and volume as backup. 

14. Use SEG-Y Loader to import the SEGY file created in step 1 (see Launching SEG-Y Loader). 
15. Select the exported lines (no need to rename). 
16. In the Survey page, select Use existing survey. 
17. Click Next. 
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18. In the Output Options page, choose the existing .dugio file containing your 2D data. 
19. Click Next. 

20. A warning will appear letting you know that you will be overwriting existing data. Click 
Delete the Line(s) to continue. 
• Only line being loaded will be overwritten. 
• Data on other lines will not be affected. 

21. Launch Insight again and load the session to check the new lines. 
22. Import the original survey and volume from the earlier backup to QC the result. 
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SEG-Y 
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Why am I having issues loading SEG-Y? 

We've updated this information. You can get the latest details here! 

SEG-Y data cannot be loaded directly into DUG Insight. It must first be converted into DUG's 
optimised dugio format (see SEG-Y Loader). 

Getting SEG-Y files into interpretation software can be a complex and confusing task. The 
amount of time wasted with persistent errors is frustrating, not to mention the potential 
repercussions of having incorrectly loaded data. Most of these errors and misunderstanding 
revolve around the issue of Header Mapping – an essential part of the SEG-Y loading process. 

A good investment is to learn how the SEG-Y header information is stored, and understand the 
necessary steps involved in any SEG-Y loading process. 

This document is aimed at the non-data specialists, and designed to help users understand the 
complexities of SEG-Y files, and facilitate the task of loading these into Insight. It describes a 
SEG-Y file in layman’s terms, with particular attention paid to the use of SEG-Y header 
information, during the SEG-Y loading process. 

SEG-Y Overview 
SEG-Y is an internationally recognised file format developed by the Society of Exploration 
Geophysicists (SEG) for storing geophysical data, particularly in the Seismic Industry. 

Originally released in 1975, SEG-Y rev 0, experienced widespread usage, which brought about 
many proprietary variations. These variations have resulted in many inconsistencies throughout 
the industry, particularly in the way header information (such as positioning data) is stored. 

The most recent revision of the SEG-Y format was published in 2002, named the rev 1 
specification (http://www.seg.org/documents/10161/77915/seg_y_rev1.pdf). 

One of the major changes introduced by SEG-Y rev 1, was standardising the way header 
information is stored for improved consistency, and also to cater for modern acquisition and 
processing techniques. 

Despite improved standardisation and consistencies, SEG-Y data is still notoriously “non-
standard”, particularly with older vintages, which consequently gives rise to difficulties loading 
data. 

So what is in SEG-Y? 
A SEG-Y file comprises data traces (which contain the actual seismic records) as well as three 
types of header information: a Text Header, a Binary Header, and individual Trace Headers. 
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Text Header 

The Text Header (aka EBCIDIC Header), provides a human-readable description of the data in 
the SEG-Y file (a bit like a readme file), and usually (though not always), contains useful 
information on how the SEG-Y file should be loaded. 

Binary Header 

The Binary Header contains information (values) that apply to the whole SEG-Y file, such as the 
sampling interval and the total number of samples in the traces. The Binary Header appears 
like a table, comprising rows of information, divided into three columns. Each row pertains to a 
specific piece of information, and the three columns are: 1:  Byte code, 2: a human-readable 
descriptor, 3. the value. See example table below: 

Trace Headers 

The data Trace Headers contain information (values), pertinent to each and every data trace 
(seismic record). These values may change on a trace-by-trace basis, such as the CMP number, 
and the geographic X and Y coordinates of each data trace. 

The information (values) contained within each of the trace headers are stored in different 
“byte locations”. 

A byte can be thought of as a repository in the file, where non-seismic information (values) can 
be stored. These bytes are numbered from 1 to 240. Often, the information to be stored is too 
large to be stored on a single byte alone and consequently 2 or even 4 bytes are commonly 
used to store a particular piece of information. 

Note: In computer coding lingo, 2 byte and 4 byte locations are also known as “int16” and 
“int32” respectively. These distinctions are relevant in the latter sections of this guide. 

The SEG-Y rev 1 standard defines specific bytes for the storing of specific information (values), 
needed for the processing and interpretation of SEG-Y files. The table below describes some of 
the more commonly used bytes and the specific information they contain, as per the SEG-Y rev 
1 standard: 
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Data Traces 

The actual seismic data in a SEG Y file is made up of a series of individual seismic records, 
known as the data traces. Depending on the type of data (2D, 3D, gathers etc), these data traces 
will be organised in a particular fashion in order to be loaded and displayed correctly in the 
interpretation software. 

How does Insight know? 
As part of the SEG-Y Loading process, Insight needs to know which bytes contain the required 
information such as CMP Number, CMP X Coordinate and CMP Y Coordinate etc. This process is 
known as “mapping the headers”, and is done in Stage 3 of the loading process: “Specify the 
byte locations of headers” screen, Figure 1 below. 

Notes: 

• When specifying byte locations in Insight SEG-Y Loader, only the first of the 2 or 4 bytes 
(required to store a particular piece of information) is required to be stated e.g. for X 
Coordinate, we would simply specify byte 181, not 181 to 184. 

• The byte length (181-184) is specified by selecting int32 from the adjacent drop down menu 
(see Note in So what is in SEG-Y? above). 

By default, Insight automatically looks in the relevant standard byte locations (Table 2 above). If 
the SEG-Y file being loaded does adhere to the SEG-Y standard, then the user simply has to 
check the values obtained are as expected, and then move on to the next stage. 
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But here is the catch 

Unfortunately, due to the variety of acquisition systems and processing standards employed by 
various companies around the world, these SEG-Y standard byte locations are often not 
adhered to, and the user consequently has to map these byte location manually. 

Some examples of commonly “misplaced” information are: 

• CMP X and Y coordinates stored in place of the Source X and Y coordinates in byte’s 73 and 
77 respectively. 

• Ensemble (CMP) Number stored on byte 25, not byte 21 
• Inline Number and Crossline Number on byte 9 and 13, not 189 and 193. 

The possibilities are endless. 

How does the user know? 
In the likely event that the SEG-Y file does not adhere to the SEG-Y rev 1 standard, the user is 
required to manually tell Insight which bytes contain the required information. 

Assuming the user has received no specific loading instructions, the first place to look is in the 
Text (EBCIDIC) Header. 

The purpose of the Text (EBCIDIC) Header is to provide a description of the SEG-Y file (Figure 1, 
button 1), and should (but often does not) include a list of which Trace Header byte locations 
contain all the important information. 
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In the example Text Header shown in Figure 2 below, we see that the Text Header states the X 
and Y coordinates are contained within bytes 73 and 77 respectively; and the inline and 
crossline numbers are in bytes 9 and 13 respectively. The user can then specify these byte 
locations, and move on with the process. 

Sometimes however, the Text Header provides no information at all, or even worse: misleading 
incorrect information. In this case, the user will then have to manually inspect the Trace 
Headers themselves (Figure 1, button 3). The process of manually inspecting the trace headers 
basically involves looking for values that fit the description of the value you are looking for. For 
example, X and Y coordinates usually have a recognisable six and seven digit number, 
respectively (for UTM coordinates). In the case of coordinates, the user must also be wary of 
any coordinate scalar value. 

When you view the trace headers in the Trace Headers window, the byte locations are labeled 
according to the SEG-Y REV-1 specification (blue box in Figure 3 below). Only the values are read 
from the SEG-Y file (green box in Figure 3 below). 

In the example shown in Figure 3 below, we see seven and eight digit numbers in bytes 73 and 
77 respectively, which would otherwise fit our expected, X and Y coordinates. There is also a 
coordinate scalar of 1/10 (divide by 10), to be applied to these values. This is indicated by the 
“-10” on byte 71 (Coordinate scalar) on the int16 (2 byte) column. 

Note: From Table 2 above, Coordinate scalar is a 2 byte header, and 2 byte is also known as 
int16, hence the coordinate scalar appears on the int16 column. 
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The trace headers window will, by default, show only the “likely” byte locations. The term “likely” 
here refers to only those byte locations (SEG-Y rev1 standard) relevant to loading of that 
particular SEG-Y, e.g. Inline and Crossline (bytes 189 and 193) are not shown when loading 2D 
data. Therefore, may need to select to show “all” locations in order to show the bytes you need 
to inspect. 

Depending on the type of data being loaded the following Table 3 below, presents a summary 
of the essential information required for data loading into Insight, and its usual (SEG-Y 
standard) byte location. 

Some useful tools available to you in the Trace Headers window: 
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• View information for multiple traces at the same time, by increasing the value in the
Number of Traces box. The numbers displayed, will now be the range of values, across that 
range of traces, and any periodic increment will be indicated in square brackets 

• View the Data Traces – This brings up a separate window displaying the seismic records for 
those traces being viewed (Figure 4). This can be particularly useful, for example, to work out 
the number of traces per Inline/Crossline/Gather, if it is unknown. 

For further details of the controls and use of the Trace Headers window, click on the Help icon 
to refer to the specific documentation on this. 

Once you are confident you have specified the correct byte locations for all the required 
information, the user can now progress to the next stage of the SEG-Y loading process. 
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Which SEG-Y formats are supported by the 
SEG-Y Loader? 

SEG-Y is the only supported format for transferring 2D and 3D trace data into Insight. 

The DUG SEG-Y Loader supports both SEG-Y Revision 0 (1975) and Revision 1 (2002). 

The trace data format must be specified in the Data Sample Format Code. The codes are: 

1 = 4-byte IBM floating-point 

2 = 4-byte, twos complement integer 

3 = 2-byte, twos complement integer 

4 = 4-byte fixed-point with gain (NOT SUPPORTED) 

5 = 4-byte IEEE floating-point 

6 = Not currently used 

7 = Not currently used 

8 = 1-byte, twos complement integer 

Insight does not support SEG-Y in 4-byte fixed-point with gain format. 
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Renaming lines in SEG-Y Loader 

1. Click on Add Files to select the SEG-Y files to include in this import session. 
2. By default, Insight will name the lines according to the file name minus “.segy”. 
3. Edit a survey line name by clicking on the line name. Do not include the data type in the line 

name. 
4. Make sure that line names and files are correct. 
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How do I load multiple stacks or volumes 
from SEG-Y at the same time? 

If you are trying to get to your data in a hurry (and you know your disks and network can 
handle it), you CAN load multiple volumes at the same time! 

There are a few things you need to be aware of to make things easier. 

2D Data 
2D SEG-Y data is usually stored in one-line-per-file. An Insight 2D volume includes all the lines 
from the same seismic acquisition for a single type of data. For example, one Insight volume 
contains full stack data stored on several 2D lines, while a second volume contains velocity 
model data for the same 2D lines. 

When you load 2D lines, you should include all the SEG-Y files for the same acquisition and type 
of data, at the same time. 

 Note: 2D volumes are flexible and allow you to revisit a volume to load data after the 
volume is first written. 

3D Data 
3D SEG-Y data can be extremely large, sometimes spanning several tapes or disks. In this case, 
large 3D surveys will be divided into several files. 

When you load 3D data, you should include all the SEG-Y files for the same acquisition and type 
of data at the same time. 

 Note: 3D volumes will NOT let you append or overwrite data after the volume has 
been completed! 
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Surveys 
A survey refers to the navigational positioning of a dataset. Insight uses the survey to position 
data in the correct location. 

In DUG Insight, a 3D survey defines the relationship between Inline/Crossline and X/Y. A 2D 
survey defines the relationship between CMP (or shot-point) and X/Y. 

Tie points define the relationship between the survey coordinates and X/Y. Different 
combinations of tie points can give the same mathematical survey relationship. In these cases, 
Insight treats them as being the same survey. It will not let you load multiple separate surveys 
that are equivalent. 

Example: Load full-stack and near-stack volumes for the 
same survey 
1. Start SEG-Y Loader and configure it to load the full-stack data (see SEG-Y Loader Overview). 
2. Create the survey if it does not already exist (see Defining a 3D Survey, Defining a 2D survey 

and Loading External Navigation Files). 
3. Select the output configuration details and start writing (see 2D and 3D Output and Writing 

Options). 
4. Once the full-stack volume has started writing to the .dugio volume file, return to the DUG 

Launcher and start a new instance of the SEG-Y Loader. 
5. Configure the second instance to load the near-stack data. 
6. Select the existing survey created when configuring the SEG-Y loader for the full-stack. Use 

the option Use Existing Survey. 

7. Select the output configuration details and start writing. 
8. The two .dugio volumes will be generated simultaneously. 
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9. You can start more instances of the SEG-Y loader for additional volumes, but be aware that 
the number of instances is limited by the capacity of your machine and the network. 

To view the volumes that you have loaded, see How do I view multiple volumes at the same time? 

For more information on configuring the SEG-Y Loader, see Importing 3D SEG-Y Data and
Importing 2D SEG-Y Data. 

Page 126FAQ

http://help.dugeo.com/m/Insight4-0/l/614069-co-rendering-multiple-volumes
http://help.dugeo.com/m/Insight4-0/c/144625
http://help.dugeo.com/m/Insight4-0/c/144626


How do I update restricted, locked, 
protected trace headers like offset, inline 
and cmp? 

Insight is careful to protect the headers that determine the location of a trace. This can be 
frustrating when trying to correct or reposition data that was loaded incorrectly. 

One solution is to export the data to SEG-Y and update the trace headers as they are 
exported. Once exported, reimport the SEG-Y to a new volume with the updated headers. 

1. In the Volume tab, right click the required volume and click Export... 
2. Select SEG-Y as the Format and click the Edit SEG-Y header button. 
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3. In this example, the offset header value in the SEG-Y file will be calculated using the formula: 
• offset / 100 

4. Arbitrary custom headers (deviating from the SEG-Y standard) can also be specified as 
shown. In this case, the inline values will be shifted by 25 and the crossline header values 
will be doubled. 
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SEG-Y Loading Gathers with Offsets in 
Centimetres 

1. Run SEGY-Y Loader and load the SEG-Y as channel gathers. 

2. Specify one of the headers as channel. 
• This example used the header at byte 5 (tracr) 
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3. Check the bin size, make sure it is correct (e.g. "Max fold 80"). 
4. Write the result to a .dugio volume. 

5. Start Insight. 
6. Add the volume to the session. 
7. Select the volume in the Control Panel. 
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8. Set the Gather Header as Bin. 

9. Create a Header Math process: "Gathers_offsetScaled" 
10. Input Volume: select the added Gathers. 
11. In Formulae, click the blue "+" icon to add a row: 

• Header: 37 offset 
• Formula: offset/100 

12. In the Volume tab, select the Header Maths result volume: "Gathers_offsetScaled" 
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13. Export the volume "Gathers_offsetScaled" as DUGIO. 
• Tick [X] the Add to session when complete option at the bottom. 

After the export completes, the new volume will be added to the session. If it isn’t, the “Add to 
session” option was not checked. Use the Import / Volume menu item in the Control Panel to 
add the exported dugio volume to the session. 

1. Select the new DUGIO volume. 
2. For Gather Header, choose Offset. 

• The offset range should now be correct. 
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3. View the gathers 
• Offset Vol: Select the new volume. 

4. If the original unscaled gathers are in the session, the Offset axis will be huge (i.e. 100 times 
larger than necessary). To correct the display, remove the original gathers from the session 
or zoom in to the left edge of the offset gathers. 
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Load SEG-Y containing traces with varying 
start times (DELRT) 
To load SEG-Y data containing traces with varying start times: 

1. During loading 
• Load the data with a constant start time 
• Store the variable start time in a trace header 

2. After loading, apply a trace shift process to reposition the traces 

Workflow 

In SEG-Y Loader 

1. Start SEGY Loader. 
2. Configure and select files as you would normally. 

3. In the “Specify byte locations of Headers” window: 
• At “First Sample Time/Depth” choose Constant, with a value of 0. 

4. Expand the Advanced Mappings panel. 
5. Uncheck the “Hide fields with no value” box. 
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6. Choose an unused header, e.g. “laga” 
7. Enter the byte location for the shift data, usually the DELRT header: 109 
8. Confirm that the value range is sensible. 
9. Complete the SEG-Y load and output the dugio volume. 

In Insight 

10. Open the project 
11. Add the new volume to the session. 
12. Create a Trace Shift process 

a.    Volume: Select the loaded, unshifted volume 
b.   Shift: Choose “Trace Header” and select the advanced mappings header containing the 
start time, e.g. laga. 
c.    Update the output start and end values to include the full length of the shifted traces. 
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Views and Display 
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My data loaded successfully. Why can't I see 
anything? 

After loading your data, first make sure to open an appropriate view. 

IL/CL view 

From the Control Panel, open the View menu and select IL/CL View for inline and crossline 
cross-section views of data volumes. 

In the upper right-hand corner of the window there is a volume selector drop-box. Make sure to 
choose the volume that you wish to view, and that you are viewing an inline or crossline that 
contains data. If your volume is not appearing in the drop-down list, check that the circle beside 
the volume in the Volume tab is green. If the circle is amber, click on it to turn it to green to 
enable the volume. 

Tip: You can click on the volume in the Volume tab to display the Details Panel. In the Details 
Panel, check that the IL and CL in the IL/CL View are within the IL and CL extents of the volume. 
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Map view 

If you wish to see time or depth slices, select Map View from the View menu. 

In the upper right-hand corner of the window there is a volume selector drop-box. Make sure to 
choose the volume that you wish to view. If the volume is not appearing in the drop-down list, 
check that the circle beside the volume in the Volume tab is green. If the circle is amber, click 
on it to turn it to green to enable the volume. 
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Class settings 

If you have a view window open and you are still unable to see your data, you may need to 
adjust your class settings. In the Volume tab, open the Details Panel for your volume and look 
at which class it is using (the default class is called "Default Seismic"). In the Class tab, open the 
Details Panel for the class. Examine the maximum and minimum clipping values for your 
colourbar and make sure they are correct for your data. If the values are far too large, your data 
will appear as a single colour, often white. 

For more information about Class Settings, see Classes and Colourbars. 
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Why is the 3D view not opening / giving 
errors / crashing? 

Help, something is wrong with the 3D View! 
If you are having a problem with the Insight 3D view, such as: 

• a message warning of insufficient resources appears when opening the 3D view 
• the software freezing or crashing when opening or using the 3D View, or 
• OpenGL errors at any time, 

then you have come to the right place. 

Executive Summary 

99.9% of the time, problems with the 3D view are caused by buggy, out-of-date video drivers, 
and not Insight itself. 

Almost all modern hardware is capable of running Insight's 3D view when paired with modern 
drivers. 

If you have an NVIDIA or ATI/AMD graphics card made after 2007, then upgrading to the latest 
drivers (available from http://nvidia.com or http://ati.com) is almost guaranteed to resolve your 
problem. 

Read on for more details. 

Basic Requirements 
The Insight 3D view requires a video system that supports at least OpenGL 2.0. As OpenGL 2.0 
was released in 2004 (the latest version is 4.2), every vendor on Earth claims to support it. 

Intel 

Unfortunately, not all such claims are equal. If you have an Intel display device, its OpenGL 2.0 
support is probably not good enough to run Insight's 3D view. 

Many modern laptops include two display devices: a low-power, low-capability Intel chip, and a 
high-capability NVIDIA or ATI/AMD. If yours is like this, it should automatically switch to the 
high-performance chip when Insight launches, but may not. Check the Control Panel (Windows) 
or the Energy Saver panel (Mac OS) for this setting. 

NVIDIA / ATI / AMD 

If you have any display device made since 2007 by NVIDIA or ATI/AMD, then it will almost 
certainly work when paired with modern device drivers. 
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3D Display Drivers 
Because video drivers run at the very lowest level of the system, bugs in video drivers can cause 
virtually infinite problems, even those that seem unrelated to 3D. 

As Insight is modern, demanding software, it is very good at exposing problems in video drivers. 
99.9% of all problems that users experience with the Insight 3D view are not the fault of Insight, 
but rather the video drivers. Upgrading to the latest drivers resolves the issue in all cases. 

Because new drivers are released so often, IT departments rarely keep them up-to-date unless 
there is a specific problem. It is common to find new computers with drivers that are 2 to 3 
years old! 

Please install the latest version of the drivers for your device from either http://nvidia.com or 
http://ati.com. 

 Note: In general, the latest versions of the drivers from Microsoft or your system 
vendor are not good enough. Those versions often lag months or years behind those 
released by NVIDIA or ATI/AMD. You need to visit the NVIDIA or ATI/AMD site to get the 
actual latest versions. 

Remote Desktop 
Some remote-desktop/terminal-server products (such as Citrix, VNC, etc) provide proper 
support for 3D graphics, and some do not.  Sometimes it is a matter of configuration. 

We will certainly do our best to help, but issues with those products will likely have to be 
referred to the vendor. 

Still Having Trouble? 
We want to help!  Please contact support for immediate assistance, and let us know what you 
have already tried. 
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Why are there extra sections/lines showing 
up in 3D View, and how do I remove them? 

If you are dealing with multiple surveys and notice some unwanted seismic sections or lines 
in your 3D View, it is likely that they belong to other surveys in your session. 

Each survey has its own independently-controllable inline (IL) and crossline (CL) slice in the 3D 
View. To turn them off: 

1. Select the survey in the drop-down box at the top left. 
2. Click on the green circle beside the IL and CL to switch off the IL and CL slice for that 

particular survey (green is on, amber is off). 
3. Repeat this step for every survey you wish to disable in the 3D View. 

 Note: Disabling the surveys in the Control Panel does NOT remove the section/line 
from the 3D View, it simply stops displaying the survey grid lines. 
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"Zoom to fit" makes everything tiny and the 
zoom detail and scaling level is limited 

When you open 3D or any section views, if you notice that the data is zoomed very far out, 
or the horizontal and vertical scales are unusually large, there might be something in your 
session that was imported with the wrong units or on the wrong survey. 

To figure out what is causing the display to be skewed, the Product Extents Table will 
allow you to check all the extents for all the products in your session. 

Product Extents Table 
To open the Products Extents Table, click on the View menu from the Control Panel and select 
Product Extents Table. 

From the example above, you can see that the X and Y extents for the 2D survey is the reason 
for the skewed display. Remove, or re-import the anomaly with the correct units, to fix the 
display. 

 Tip: Click on any table header to sort the list according to that column in alphabetical 
order (for text columns) or ascending/descending order (for numerical columns). 
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Contours Based on Amplitude Extraction 

In addition to displaying contours on the map, you can use this feature to combine the 
display of contours with amplitude extraction. The following shows an example of a 
workflow to display contours based on a velocity volume at the time slice of 3,000 ms. 

Display contours based on amplitude extraction 

Part 1: Create a flat horizon at 3,000 ms time slice (see How do I create a flat horizon?) 
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Part 2: Select velocity volume for horizon 

1. In the Map View, select "Horizon=3000" in the navigation bar. 
2. Click on the spanner icon beside Property. The Horizon Settings window will appear. 
3. In the Details Panel of the 'Horizon=3000' horizon, select the velocity volume at Volume. The 

contours will be generated from the selected velocity volume. 
Note: To show amplitudes from a different volume, select another volume at Volume. 

4. Select Amplitude at Property. 
5. Clear the Use min and max from class settings check box and then click Adjust to adjust 

the minimum and maximum clip of the class settings. This will make the best use of the 
colour bar in displaying the horizon. 

Part 3: Display contours for "Horizon=3000" based on amplitude property 

1. At the navigation bar in the Map View, select 'Horizon=3000' at Horizon. 
2. Expand the left panel and open the Display tab. 
3. In the Contours section, select the Show Contours check box to display the contours on the 

map. 
4. Select the Contour Numbers check box to display the contour values on the map. Type the 

font size for the contour values. 
5. At Horizon, select "Horizon=3000". 
6. At Property, select Amplitude. 

See the following examples: 

a) Display time contours for a TWT horizon by selecting the TWT 
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property for the "Top Res" horizon. 

Note: If a velocity model has been specified for the Time-Depth parameters (see Converting 
Time-Depth), depth contours could be displayed instead. 
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b) Display contours for extracted amplitudes on a TWT horizon by 
selecting the Amplitude property for the "Top Res" horizon. 
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c) Display contours for extracted amplitudes at a constant time 
from one volume, while showing the corresponding slice from a 
stack by using this workflow. 
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How do I display a horizon with its contours 
in 3D View? 

Contours are generated in the Map View (see Contouring in Map View). We can simulate 
contours in 3D View by creating pseudo-contours. 

1. Make a copy of the horizon you wish to contour (see Copying a Horizon). 
2. Create a new Class (see Creating a Class) and import the 

"banded_PseudoContours_10.ducolbar" coloubar from DUG-Insight’s default list of 
colourbars (see Importing a Colourbar). 
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3.  Change the class of the Horizon Copy to the new class (PseudoContours). 

4. Turn on both horizons as surfaces in the 3D View. 
5. The copied horizon’s banded colourbar is largely transparent, you can still see the original 

horizon, but with the discrete black lines overlaid. 
6. Manually adjust the min/max cut-off values of the copy so that the black lines fall on exact 

values. The colourbar will be divided into 10 bands between the min and max values. 
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7. For example, in the following image, the difference between the min and max values is 500, 
so every 50 will be black lines (interval = 50). 
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How do I pick contours in Insight? 

You can't pick contours directly, but there is a workaround that you can use. If you pick the 
horizon as a fault, you can use the map view to create the contour lines as fault picks which 
you can manually pick. 

Depending on the picks, the fault surface may not display sensibly, but the sticks will 
contain all the necessary points to create a good horizon. 

To do it, export the fault to a file -- make a small change, and import the result as a horizon. 
Regrid to X/Y and extrapolate to complete the surface. 

1. From the Fault tab, click the "+" button and create a New Fault. Read more about Faults. 
2. Type a name for the fault (e.g. "horizonY-as-fault"). 
3. In section (i.e. 2D Line View or Arbline view), create fault sticks for the horizon on the 

available lines. 

4. In Map view, select the contour TWT and create a new fault stick. 
5. Repeat at different TWT values for additional contours. 
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6. Repeat at different TWT values for additional contours. 

7. Repeat until the level of detail is satisfatory. 
8. When finished picking, go to the Fault tab, right-click the fault and export it to a file (e.g. 

"horizonY-as-fault.dat"). 
9. Open the .dat file with any text editor and remove these lines: 

Page 153FAQ



PROFILE horizonY-as-fault               TYPE 2  1 DUG Insight fault 
SNAPPING PARAMETERS 
... 
EOD horizonY-as-fault 

10. Save the file as "horizonY-as-fault.txt" (note the .txt extension) 
11. From the Control Panel drop-down menu, select Import >> Horizon and choose the edited 

.txt file. 

12. In the Import screen, set the column types as X, Y, (blank), (blank), TWT and click OK. 
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13. Go to Map View and check the result. 

14. Next step is to regrid to X/Y. Select the Operations tab in the Map View and choose Regrid 
from the Operation drop-down box (if not yet selected, choose the imported horizon from 
the Horizon drop-down box). 
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15. Select X/Y as the Output Survey. For regional horizons, try an increment of 100m x 100m 
or larger. Set these for both X and Y extents in the Step textbox. 

16. Draw a polygon around the imported horizon to Regrid. Right click on the Map View and 
select Create a New Polygon. Read more on Polygons. 

17. Select this polygon in the Contrain to area box and click Regrid. 

18. Insight will interpolate/extrapolate the horizon within the polygon. Review the result once 
completed. 
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19. Apply some smoothing if the contours are irregular via the Operations drop-down option. 
Read more about Smoothing (Horizon). 
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Dashed Line Selection Outlines in 2D Views 
In the 2D Line View line selection box, lines are organized by survey name, which is left-justified. 
Line names are indented below the survey name, and they are sorted in alphanumerical order. 
It is possible to load duplicate 2D line names to a project associated with different surveys, if 
this happens you can use the left-justified survey name at the top of the line list to differentiate 
the line names. 

As well as the trace data displaying in the view, the Line selection box will be drawn with a solid 
grey colour when you select a survey line name with traces present in the active displayed 
volume in the display. 

Here the line B89-18M has associated trace data in volume B89_NE_Survey_4s8b. Trace data 
appears in the view and the Line selection box draws with a solid grey outline indicating this is 
so. 

The line selection box can also be displayed with a dashed red or dashed grey outline to 
indicate a mismatch between the selected line and the displayed volume. 

If you select a line name which does not have traces in the active displayed volume, no trace 
data will be displayed in the view and you will see a dashed grey outline around the line 
selection box indicating that the volume data does not exist for that line selection. 

Here Survey_B89_NE is not associated with volume GPCT93_NE_Survey_4s8b and so Line name 
B89-18M does not exist in volume GPCT93_NE_Survey_4s8b and there is no associated trace 
data. No data is displayed, and the Line selection box is drawn with a dashed grey outline. The 
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volume must be changed to match the survey selection for traces to be displayed and the line 
selection box outline to become a solid grey line again. 

Here, volume B89_NE_Survey_4s8b is associated to Survey_B89_NE, but the Line name 
B89-22MA does not have any traces loaded to volume B89_NE_Survey_4s8b and so no data is 
displayed. If the SEGY data can be located and loaded for line B89-22MA, the volume can be 
displayed and the line selection box outline to become a solid grey line again. 

The dashed red box outlining a line selection means that you've selected a line name which 
exists in the displayed volume, but you've selected it from a different survey to the one 
associated to the volume. This happens when the same 2D line has been loaded to multiple 
surveys creating duplicate line names. 

In this example two surveys are available, Survey_B89_NE and 2d_regional_ALL. The line name 
B89-18M is duplicated and exists in both surveys. Using the search filter in the line name box it 
is possible to see the line listed in both surveys. 

The active displayed volume in the 2D line view is B89_NE_Survey_4s8b and is associated to 
Survey_B89_NE, not 2d_regional_ALL. 

Selecting line B89-18M from Survey_B89_NE displays the trace data as expected and draws the 
line selection box with a solid grey colour indicating a survey - volume match. 
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Selecting line B89-18M from 2d_regional_ALL  displays the trace data but draws the line 
selection box with a dashed red colour indicating that the line selected is part of a different 
survey from the display volume. Trace data is still displayed because the line name and 
navigation information is duplicated and available in the active displayed volume. 

Interpreting on a volume when the line selection outline is dashed red will store horizon picks 
with another survey to the one intended and can cause confusion and problems in the future. 
Avoid interpreting horizons when the line selection box is red unless you have good reason to 
do so. 

To make sure you’re displaying the correct data, always check you’ve selected your line from the 
survey associated with the displayed volume. 

 Find Out More! 

• Surveys vs. Volumes 
• Survey Overview 
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Surveys 
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Why does SEG-Y Loader tell me I have a 
duplicate survey even though the 
coordinates are not the same? 

In general, a survey simply defines the relationship between Inline/Crossline and Eastings/
Northings. 

Any given survey can be defined by an infinite number of orthogonal tie point sets, so long 
as they define the same relationship in the conversion from IL/CL to X/Y. 

The following example shows two tie point sets that has different coordinates but describe 
exactly the same relationship between IL/CL and X/Y - and therefore are duplicate surveys: 

This is why you receive the "duplicate survey" warning (image below). Even though the tie 
points sets are different, they define the same relationship as the existing survey, and hence it 
is labeled as a duplicate. 
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How do I change survey CRS to project CRS? 

 WARNING: Changing the coordinates for a survey will reposition all data associated 
with that survey. For example, altering a 3D survey will change the X/Y coordinates of 
seismic and any horizons picked on the survey. 

This workflow assumes that a survey has been loaded without applying a CRS conversion to 
the survey. The solution exports the uncorrected survey, then redefines the current survey 
using the file with corrections applied.. 

Export the survey (without corrections applied) 

1. Go to Control Panel > Survey tab. 
2. Right click on the survey and select Export. 
3. Enter a filename and location for the exported survey. 

Configure the current survey 
4. In the Survey tab, double click on the survey. 
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5. In the Survey Configuration window, click the Select File icon. 
6. Select the exported 3D survey file and click Open. 

Specify the original CRS for the survey 
7. Choose the CRS used in the survey by clicking Convert from. 
8. Insight will convert the survey coordinates to the project CRS. 
9. Volumes and horizons will be repositioned accordingly. 

10. Click OK. 
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10. The Survey Updated window will appear to ask you to reload the session. 
11. Click Save and Reload Session. 

The current session must be reloaded for the changes to take effect. All items using the old 
survey will be repositioned to the new coordinates once the session is saved and reloaded. 
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Export 2D survey as simple XY TWT file 

ARCGIS (and other softwares) import a simple XY TWT file. We can use the workflow below 
in Insight to create a horizon for XY values from the 2D surveys, export this to an XYT file for 
import into ARCGIS. 

1. Create a constant horizon covering all the 2D surveys you wish to transfer. (A 2D line set can 
be used to group the 2D lines). 
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2. Regrid this horizon to the 2D survey using the Regrid tool. Create a new horizon. 

3. Export this new horizon, select custom export and XY TWT. If needed, CMP and Line name 
can also be exported. 

4. A simple XYT file will be exported. Import into ARCGIS. 
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How do I set boundaries for my 3D survey? 

Insight automatically extends 3D surveys to include associated data, horizons and volumes. 
Remember to check the Product Extents Table for any objects that might cause the 3D survey 
to expand. 

In some cases, the survey extends further than is required, making the Map View harder to 
use. 

Use this workflow to reduce the displayed survey extents in the Map View. 

 Note: The survey boundaries are for display only. They update to contain the 
coordinates of anything assigned to the survey. Updating them will not affect the 
positioning of anything in the project. 

Export the 3D survey 
1. Control Panel > Survey tab, right-click the desired survey and choose Export (see Exporting 

a Survey). 
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2. Save to file, e.g. '3d_survey.survey' 

Example format of .survey file below, more examples available here. 

Survey files are easy to update. Use any text editor to open the .survey file and update the min 
and max values for IL and CL. 

1. Search for line: survey= 
2. Update il: ####-#### 

• Enter the desired min and max inline 

3. Update cl: ####-#### 
• Enter the desired min and max crossline 

4. Save the file. 

We’re ready to update the survey with the new extents.  
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Redefine the 3D survey in Insight 

1. Open the Survey tab in the Control Panel. 
2. Double-click the survey to adjust. 

• Alternatively, right-click the survey and choose Configure 'Survey'. 

3. Type a new name in Name field. 
4. Click the Select File icon to the right of Name field. 
5. Select the 3D survey file (e.g. '3d_survey.survey') that you updated and click Open. 
6. Click OK to replace the survey. 
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Volumes and Data 
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Can I store a volume outside the project 
directory? 
Sure you can! 

We understand that volumes are huge files that can take up a lot of space in your machine. 
Hence, we have made sure that Insight projects can be stored independently from the dugio 
volumes without any problems. 

By default, Insight uses the 100sei directory as the default location for storing and retrieving 
volumes. This is to help you keep things organised, especially in a multi-user environment. 
However, if you find yourself juggling data to manage disk space, you can move the .dugio 
volume to a different location (secondary disk, network, external USB storage, etc.) after the 
SEG-Y loading process is completed. Provided the volume is not in use (i.e. Insight is not open), 
.dugio volumes can be moved around and copied safely. The operating system will treat them 
as folders. 

 Tip: To change the default directory to another location, see How do I change Insight's 
default directory? in the FAQ section. 

If Insight cannot locate a volume when opening a session (or adding a volume from the project), 
it will prompt you with a dialog to locate and reconnect it. This might happen because a 
network share is unavailable, an external drive is disconnected, or the volume was moved (see
Missing files when loading volume. Where did my volume go?). 

When importing from SEG-Y, make sure you output the volume to a fast and reliable location 
with enough space. The new volume will automatically be added to the project. SEG-Y loading is 
an I/O intensive task, so performance is governed by the read and write speed. 
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Gather Types 
There are three types of gathers: 

1. Type 1 (Regular offset) — Gathers that have regular offsets for every CMP (Type 1 = same, 
same). 

2. Type 2 (Irregular offset) — Gathers that have irregular offsets, but the same irregularity for 
every CMP (Type 2 = different, same). 

3. Type 3 (Irregular offset, and location-dependent) — Gathers that have irregular offsets, and 
the offset irregularity is different for every CMP (Type 3 = different, different). 

Examples 

Type 1 example: 

CMP1: Trace 1 offset 75m, Trace 2 offset 150, Trace 3 offset 225m, etc (regular 75m 
increment) 

Type 2 example: 

CMP1: Trace 1 offset 75m, Trace 2 offset 155m, Trace 3 offset 240m, etc (no regular 
increment) 

CMP2: Trace 1 offset 75m, Trace 2 offset 155m, Trace 3 offset 240m, etc (but the irregularity 
is the same for every CMP) 

Type 3 example 

CMP1: Trace 1 offset 75m, Trace 2 offset 155m, Trace 3 offset 240m, etc (no regular 
increment) 

CMP2: Trace 1 offset 80m, Trace 2 offset 165m, Trace 3 offset 245m, etc (and irregularity 
between CMPs). 

General Discussion 
Most gathers are typically Type 1. 

Depending on the acquisition geometry and processing, some gather datasets may be Type 2 
and, even less commonly, Type 3. The most common use for Type 2 and Type 3 is when the 
gather dimension is not offset (i.e. frequency). 

Type 2 gathers have the following properties: 
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• low fold data 
• acquired in feet, offsets converted to metres (rounding errors give increments of 24, 25, 24, 

25, 25, 24) 
• spectral decomposition frequency (i.e. many lower frequencies, but more sparse in higher 

frequencies). 

Type 3 gathers are mostly used for shot gathers, channel gathers and other similar raw data. It 
treats each gather like a bucket of traces and has to sort through them when it gets there. 
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Insight's Automatic Volume Class 
Assignment 
When importing a volume, Insight will try to guess a volume's class using keywords found in the 
volume's name. 

These keywords are not case sensitive, and are checked in the order shown below. The first 
matched keyword will be used to determine the volume's class. 

Velocity volume check 
If the volume filename ends with any of the following AND either .su or .dugio, the specified 
class will be used. 

Ends with Uses Class 

vintt Interval Velocity in Time 

vintz Interval Velocity in Depth 

vrmst RMS Velocity 

vavgt Average Velocity in Time 

vavgtz Average Velocity converted to Depth 

zt Depth values sampled in Time (ZT) 

tz Time values sampled in Depth (TZ) 

Keywords class check 
Otherwise, the presence of the first of any of the following keywords will cause the specified 
class to be selected. 

Keyword Class 

ufar Stack (Ultra-Far) 

far Stack (Far) 
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mid Stack (Mid) 

near Stack (Near) 

stack Stack 

gather Seismic Gather 

impedance AND s- 
S Impedance 

simp 

impedance AND p- 
P Impedance 

pimp 

rho 
Density 

density 

rho AND lambda Lambda-Rho 

rho AND mu Mu-Rho 

prob AND oil Probability (Oil) 

prob AND brine Probability (Brine) 

prob AND gas Probability (Gas) 

poisson Poisson's Ratio 

vp AND vs Vp/Vs 

vs S Velocity 

vp P Velocity 
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How do I load a velocity ASCII cube into 
Insight? 

Unfortunately, velocity ASCII files cannot be loaded into Insight. However, if you send it to 
us, we are happy to convert it to .dugio for you to import into your Insight project. 

Note: We understand that the contents of any data sent to us are confidential and intended 
for testing and bug fixing purposes only. Under no circumstances will the data be shared or 
distributed to anyone other than those necessary to solve your problem. You have our 
promise that we will safeguard your data to the best of our ability. Once we have solved the 
problem and closed the support ticket, your data will be removed from our system. 

Send us your velocity 
Kindly send the file and the survey onto which the velocity is to be imported (see Exporting a 
Survey) to support@dugeo.com or upload it to our FTP site (see How to upload to our FTP server?
for instructions). 

After receiving the data, it will take us a day or two to prepare the results. 
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How do I crop a seismic volume using a 
polygon? 

Volume Sculpting and Volume Maths can be used to remove the area inside or outside a 
polygon. 

A probe can also be used, but is limited to the shape of a cube. 

Remove seismic outside polygon 
1. In the Process tab, create a Volume Sculpting process (see Volume Sculpting). 
2. Choose the volume and select a polygon to constrain the data inside the polygon. You can 

also constrain the vertical extents of the cropped seismic by selecting a constant time/depth 
or horizon. 

3. In the views, select the process volume to display. 

This will create a process volume within the constrains of the polygon. Process volumes are 
updated on-the-fly and may be computationally intensive. Export this process volume to disk to 
improve performance (see Exporting a Volume). 

Remove seismic inside polygon 
1. In the Process tab, create a Volume Sculpting process (see Volume Sculpting). Choose the 

volume and select a polygon. 
2. Create a Volume Maths process. 

• Select the original volume as v1 and sculpted volume as v2. 
• At Formula, type the following formula: if(!IsNaN(v2),NaN,v1) 
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This will create a process volume that omits the area inside the polygon. Process volumes may 
be computationally intensive. Export this process volume to disk to improve performance (see 
Exporting a Volume). 

Alternatively... 

Another way to remove the volume inside a polygon is to create a horizon with missing values 
inside the polygon (see Horizon Erase), and then select to Exclude traces where a horizon is 
missing during Volume Sculpting. 

If either (you only technically need one) of the horizons used in Volume Sculpting have null 
values, the nulls will carry through into the process volume. 
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How do I colour a volume differently 
between horizons? 

This workflow allows for flexibility in colouring the different stratigraphy in your volume. 

Use Volume Maths process to fill values between horizons 

1. Create a Volume Maths process. In this example, we name it "Layer Fill". 
2. Add each of the horizons to define the layers. It will be easier if the horizons are correctly 

sequenced. 
3. Construct an if statement using the following structure: 

• if TWT above A, use value 1, otherwise 
• if TWT above B, use value 2, otherwise 
• if TWT above C, use value 3, otherwise use value 4 

The actual formula looks like this: 

if (twt_ms < a, 1, 
  if (twt_ms < b, 2, 
    if (twt_ms < c, 3, 4) 
  ) 

Page 180FAQ



) 

4. Finally, choose a nice colourbar and set the range from 0 or 1 to your maximum value. 
5. If you would like to overlay the results, create a group containing the "Layer Fill" virtual 

volume, put that layer at the top of the group, and adjust its transparency in the class 
settings. 

Here are the results achieved using a quick test: 
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Why does the result of my Volume Combine 
process look different to my group of the 
same volumes? 

The group will use the settings of the individual volumes to adjust the displayed amplitudes. 
In a group, the volumes might have different amplitude ranges, but still display similarly. 

Volume combine doesn't "see" the display settings, only the actual trace values. After 
combining, the resulting volume will contain the unchanged amplitudes from the original 
volumes. 

The solution is to apply a scale to the volumes before combining. There are two easy ways 
to do this: 

1. Use a Volume Maths (Simple) process to apply a scale, and combine the resulting volume; 
or 

2. Use manual mistie correction to adjust the scale of the volume as it is read. 

Adjusting amplitude scale of two volume groups 
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A timeslice view of both volume 1 and volume 2 grouped together.  However, volume 2 has 
twice the amplitude range of volume 1, making the amplitudes display more intensity. 

To adjust the colorbar range so that they have the same scale relative to amplitude values for 
each volume: 

1. Uncheck the ‘Use min and max from class settings’ box 
2. Adjust the the Min/Max values for volume 2 to correlate with those in volume 1. 
3. The colourbar range for each volume is scaled to amplitude values (of one volume) so that 

amplitudes is shown with the same intensity across both volumes. 

Create a combined volume with the same amplitude value 
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range 

1. Go to Process tab and add a Volume Maths (Simple) process. 
2. We will use Volume Maths (Simple) to rescale volume 2 to volume 1.  Since volume 2 has 

twice the amplitude range of volume 1, dividing the values by two will properly scale volume 
2. 

3. Still in the Process tab, add a Volume Combine process. 
4. Using the Volume Combine process, select volume 1 and the rescaled version of volume 2 

(created from Volume Maths (Simple) process earlier) as the Input Volumes. This will 
create a new volume combining volume 1 and volume 2, with both having the same 
amplitude scaling. 
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Manually adjust the amplitude scale. 

The amplitude scale can also be adjusted manually from the Configure Volume window. 

• To scale the amplitude of Volume 2 to Volume 1, enter ‘0.5’ as the input for ‘Amplitude Scale’. 
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What should I know about Insight's 16-bit 
data compression? 
Being relatively new to Insight processing I would like to better understand how intermediate 
data is stored in 16-bit. I haven't found any documentation so have the following questions: 

 

Q: What processing should be applied to the original 32-bit floating point input data before it 
can be safely stored in 16-bit (integer?) format (e.g. any amplitude balancing or scaling 
required)? 

A: Your data should be despiked. 16 bit data results in a fixed-size compression ratio of about 
1.5:1 (i.e. an output file that's about 60% the size of the uncompressed input) with a loss of 
precision of approximately 1 part in 32,000, provided that the data has no spikes. Hard zeroes 
(0.0) are preserved exactly. 

 

Q: Does the sample format of the internal processing depend on the storage format of the 
input data or is it always done at 32 or 16-bit? 

A: Internal processing is always done at full precision 

 

Q: Are there any issues associated with the subsequent return of data from 16 to 32-bit when 
the final data are written out to SEGY format? 

A: Exporting back to 32 bit will retain the precision you had at 16 bits. 

 

Q: If a large spike is detected on a 16-bit stored dataset I assume that this could impact the 
accuracy of the nearby amplitudes and subsequently the correct approach to fixing this would 
be to recreate the dataset without a spike rather than just fix the spike on the input data? 

A: The volume is packed in blocks of 32 samples. For each block of 32 samples, the 16-bit range 
is scaled to match the range of those samples. 

A spike of extreme amplitude blows out the range of the block, ruining the storage of the other 
samples. This is why we recommend using 16 bit data after the input has been processed to 
remove spikes. 

Approaches to despiking are data dependent. We recommend consulting an experienced 
seismic processor for guidance. 
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How to add/replace 2D lines to an existing 
dugio 

After loading a volume from SEG-Y, a 2D line may need to be added or replaced in the 
volume (e.g. because of an error in the SEG-Y file). 

This can be done in the SEG-Y Loader by specifying an existing 2D dugio volume as the 
output file. 

Note: We recommend making a backup of your existing dugio volume and survey before 
proceeding with this workflow. 

Add/replace 2D line 

1. Follow the steps in Importing 2D SEG-Y Data. 
2. In the SEG-Y Loader, select your lines and make sure the byte locations and configurations 

are correct. 
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3. In the case of adding a new line to an existing 2D dugio, select Add to/edit existing survey. 
4. If the line had previously been loaded, it will already be defined in the survey - the loader 

should recognise it and force you to use the existing survey. 

5. In the last panel (Output Options), select your existing .dugio file in the Output Filename 
text field. 
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6. Make sure that the volume you are adding the lines to is not loaded in your Insight session 
at the same time. Insight will need to delete the existing line(s), and will not be able to if the 
volume is currently loaded. 

7. Click on Delete the line(s) when prompted. 
8. Insight will load the data and overwrite the existing one. 
9. You may reload the volume to your session to check the changes. 

Genuine offer of assistance 
DUG understands that importing SEG-Y data can be a confusing task. 

Whether you are using a trial version or a fully-paid licence, we will help you to import your data 
to Insight so that you will get the maximum out of your data. 

For more information, contact support at support@dugeo.com. 
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How do I merge lines from multiple 2D 
volumes and surveys into a single volume 
and survey? 

This workflow can be used to efficiently consolidate 2D data contained in multiple 2D 
volumes spread over several surveys into a single 2D volume and survey. 

1. Create a line-set containing lines from both 2d surveys e.g. "Merged Lines" (see Managing 2D 
line set) 
• In the Volume tab, highlight each line name found in the Extents section, then right-click 

and select Add to Line Set > New... 
• Alternatively, select the lines in Map view by pressing Ctrl and clicking the lines. To add 

lines, right-click and select Add lines to line set > New.... 
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2. Export the line set e.g. Merged Lines (see Exporting 2D line sets) 
• Go to the Survey tab, right-click on the line set, and select Export > Export "line set. 

3. Import the line set as a 2D survey via Control Panel > Import > Surveys... 

4. Export both 2D volumes to the same .dugio file (see Exporting to DUG I/O). 

Page 191FAQ

http://help.dugeo.com/m/Insight4-0/l/438593-exporting-2d-line-sets
http://help.dugeo.com/m/Insight4-0/l/438670-exporting-to-dug-i-o


5. Give the first volume a name, select the location to export to, and click OK. 
• This new volume will contain the merged data. 

6. To add lines to the merged volume from the second volume, use the same file name and 
location when exporting. 

Note: Exporting lines from the second volume to the merged volume will not overwrite 
data already contained in the merged volume, unless the lines being export are already in 
the merged volume. 

7. Import the merged volumes via Control Panel > Import > Volume. 
8. When prompted to select a volume by the Survey not defined window, select the merged 

line survey imported in Step 2. 
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How do I gain a volume between two 
horizons, using a spatially varying 
multiplier? 

In this workflow, we apply a gain to the values of a volume between two horizons. The 
amount of gain applied is defined by a third horizon. 

It requires the following items loaded in the session: 

• The volume to scale 
• An upper bounding horizon 
• A lower bounding horizon 
• A horizon containing scalar (gain) values 

1. Create a Volume Maths process. 
2. Click the Volume (+) and select the volume to scale. Use the default variable name, “v1”. 

• This example uses a volume called “Velocity_tie_to_wells”. 

3. Click the Horizons (+) three times to and add three horizons: 
• h1: choose the upper-bound horizon. 
• h2: choose the lower-bound horizon. 
• h3: choose the  is the horizon (grid) based scale factor. 
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4. Use the formula: 

if (twt_ms > h1 && twt_ms< h2, (v1*h3), v1) 

5. The result of this process is a new volume, located in the Volume tab. Note: Use the CTRL-
P hotkey to quickly switch between a process and its result volume. 

6. Go to View > New IL/CL View or 3D View to QC the result. 
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Seismic Reference Datums 

Marine seismic is usually referenced to Mean Sea Level (MSL) which is a global datum for 
measuring height. In a marine project, zero elevation (the mean sea level) will have a time 
of 0 ms. 

Because elevation on land is variable, land seismic is often referenced to a Seismic 
Reference Datum (SRD). The SRD is a plane that sits above the highest elevation in the data. 
In a land project with a seismic reference datum set, the SRD will have a time of 0 ms. All 
time data, e.g. seismic and velocities, will start at this datum. 

The seismic reference datum will be above the elevation of most of the land surface. For 
seismic, values in the is gap will be empty. In velocity models, a replacement velocity fills the 
data gap between the surface and the datum. It’s an important value to note when 
manipulating volumes with different datums. 

In a project, all wells and traces are referenced to MSL enabling objects to be compared to each 
other. 

• Seismic is Measured from MSL or SRD 
• Well data is most commonly referenced to KB, DF or RT. 
• Checkshots are most commonly referenced to SRD, MSL and sometimes KB 
• GL or ML(WB) can also be used but are not as common. 
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In Insight, the default seismic reference datum is 0m. With marine data you do not need to 
change this value. There are two ways to configure a project with land data referencing a non 
zero SRD. 

Method 1 - Set a seismic reference datum for the project 
In Configure project, set the SRD to match the seismic survey SRD. 

In this example 800 m = 0 ms. The replacement velocity is 2000 m/s. 

The well has its own datum set at 613 m above MSL. 
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With the seismic reference datum configured as 800m: 

In TWT 

• The line at time zero is the SRD, 800 m above MSL 
• Unconverted TWT traces begin at time zero, all the samples are after time zero. 
• The entire well converted to TWT is visible. 
• The wells and seismic tie. 
• Unconverted TWT-Interval Velocity data (inset image) starts from time zero. 
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In TVDSS 

• The line at depth zero is the MSL. 
• TWT traces converted to TVDSS start at the SRD, 800 m above MSL. 
• The unconverted depth well is fully visible. 
• The wells and seismic tie. 
• The TWT-Interval Velocity data (inset image) converted to TVDSS starts from time zero, 800 

m above MSL 
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This is ideal. All the data is displayed in both TWT and TVDSS, and the velocity model extends to 
the seismic reference datum. Time-depth conversion using the model covers the entire vertical 
domain. 

Method 2 - Use Mean Sea Level (0m) as the seismic 
reference datum 
The trace data was originally processed using a SRD of 800m. The time traces have been shifted 
using replacement velocity of 2000 m/s from the original SRD of 800 m to a new 0 m MSL 
datum. 

In Configure project, set the SRD to 0m (MSL). 

In this example: 0 m = 0 ms. 
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The well has its own datum set at 613 m above MSL. 
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With the seismic reference datum set to MSL (0 m): 

In TWT 

• The line at time zero is the MSL 
• Unconverted TWT Traces begin at time -800 ms, the time shift calculated from the original 

SRD using a replacement velocity of 2000 m/s. 
• The entire TWT trace is visible above and below time zero (MSL). 
• The well converted to TWT is only visible below 0 ms. “Negative time” values are not 

displayed. 
• Wells and seismic tie for the visible portion. 
• Unconverted TWT-Interval Velocity data starts at time zero. “Negative time” values are not 

displayed. 
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In TVDSS 

• The line at depth zero is the MSL. 
• The TWT traces converted to TVDSS are only visible below 0 m. “Negative Depth” values are 

not displayed. 
• The entire unconverted Depth well is visible 
• The wells and seismic tie for the visible portion 
• The TWT Interval Velocity data (inset image) converted to TVDSS is only visible below 0 m. 

“Negative Depth” values are not displayed. 

Page 206FAQ



This method truncates well data at MSL when displayed in TWT, and seismic time data at MSL 
when displayed in TVDSS. The velocity model is modelled from below MSL, with only the 
constant replacement velocity available to use above MSL. 

For a single seismic reference datum this isn't the best method, but this method becomes 
useful when using multiple surveys with multiple seismic reference datums. After defining a 
common seismic reference datum, each survey is shifted to align with each other. 
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A quick way to determine the angle to stack 
your gather data 

Looking for the optimal angle to stack your offset gathers?  This simple approach visually 
inspects gathers using our angle gathers process.  Quickly distinguish between possible 
noise and real data. 

 

1. In the Control Panel, select the Process tab. 
2. Click the blue (+) icon and create a new Angle gathers process. 

• Input gather: Select the gather volume. 
• Offset: Use the OFFSET header or Calculate offset from SX/SY/GX/GY. 
• Output Sequence: Specify the first angle, last angle and increment of the angle gathers 

to create. 
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3. View the output in the IL/CL view, using the angle selector to scroll through the angles. 
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Velocity 
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What are some good ways to create 
synthetic velocity models? 

The following describes the workflow to create a Vo+kz velocity model with varying 
gradients between horizons for the purpose of time/depth conversion. 

• A simple V0 model 
• A simple V0 + k(z) model 
• A layered V0 model. 

Create a simple V0 model 

1. In the Process tab, click on the Add icon and select New Process. 
2. Create a Volume Maths process and type a Name for the process. Click OK. 
3. In the Details Panel, at Formula, type the formula 1500 to create a velocity model at a 

constant value of 1500. 
4. Under the Output Extents section, select a 3D survey. 
5. Enter the appropriate Inline and Crossline extents for the model. 
6. Models can be created in TWT or TVDSS, depending on the domain selected in the output 

extents. 
7. The velocity model will appear in the Volume tab. 
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Assign a velocity class to the model 

1. In the Control Panel, open the Volume tab. 
2. Double click the velocity volume or right-click and select Configure 'Volume'. 
3. At Class, select Velocity (Interval) from the drop-down list. 
4. Click OK. 
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Create a simple V0 + k(z) model 

1. In the Process tab, click on the Add icon and select New Process. 
2. Create a Volume Maths process and type a Name for the process. Click OK. 
3. In the Details Panel, at Formula, type the formula 1500+1.05*tvdss_m. 
4. Under the Output Extents section, select a 3D survey. 
5. Enter the appropriate Inline and Crossline extents for the model, and select TVDSS as the 

output domain. 
6. The velocity model will appear in the Volume tab. 
7. In the Volume tab, double click the velocity volume or right-click and select Configure 

'Volume'. 
8. Change the Class of the volume to Velocity (Interval) from the drop-down list. 
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Create a layered V0 model 
1. Create a Window Model using constants or horizons (see Creating a Window Model). 

Note: If you are creating a velocity model in depth, you must create a window model in 
depth. 

2. In the Process tab, click on the Add icon and select New Process. 
3. Create a Velocity Model (From Well Checkshots) process and type a Name for the process. 

Click OK. 
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4. Select the Windowing Model that you have created. 
5. Under the Output Extents section, select a 3D survey. 
6. Enter the appropriate Inline and Crossline extents for the model. 
7. Under the Per-Layer Settings section, change the Calculation types to User-specified 

constant and enter an appropriate value in the adjacent box. 
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How do I create a velocity model from time-
depth (T-Z) pairs? 

There are a few approaches to creating a velocity model from T-Z pairs to be used as a 
velocity volume in time-depth conversion. 

Depending on your data, see the following example workflows: 

• Workflow for 3D data 
• Workflow for 2D data. 

For 3D data 
For 3D data, we recommend creating a constant volume to define the model size, then scale it 
using a gain function defined by the T-Z pairs. 

Create a constant volume to define the model size 

1. In the Process tab, click the Add icon and select New Process. 
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2. Select Volume Maths from the list and type a name for the process (see Volume Maths). In 
this example, let's call it CONSTANT ONE. 

3. Input a constant (in this case: 1) as your Formula and configure the Output Extents. 

Create a gain function of the T-Z pairs 

1. In the Process tab, create a New Process and select Gain from the list (see Gain). 
2. Give the process a name and click OK. In this example, let's call it T-Z. 
3. In the Details Panel, select the constant volume that you have created. 
4. Choose Data independent and Time/Depth-Gain pairs as your gain function. 
5. Click the Add icon at Vertical values to apply gains to the volume. The new process volume 

will be created in the Volume tab. 
6. Set this volume's class by right-clicking (or double-click) it in the Volume tab and select 

Configure. 
7. In the Class dropdown box, select Velocity (TVDSS values sampled in TWT) and click OK. 

Read more about Changing a Volume's Class. 

 Note: At least 2 time/depth pairs must be provided. 
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Convert the T-Z result to interval velocity (VINTT) 

1. In the Process tab, create a New Process and select Velocity Conversion from the list (see 
Velocity Conversion). 

2. Give the process a name and click OK. In this example, let's call it VINTT. 
3. Select the gain function (T-Z) as your Velocity Volume. 
4. In the Output Settings, choose to convert the T-Z result to Interval Velocity. 

For 2D data 
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If you are working with 2D data instead, select your 2D volume as an input when creating the 
constant volume. Insight will detect a 2D volume and change the Output Extents section 
accordingly. 

The rest of the workflow remains the same as if you were using 3D data (refer to the workflow 
above). 

For more information on velocity models for 2D data, see How can I create a simple velocity 
model for 2D data? 

Page 219FAQ

http://help.dugeo.com/m/faq/l/308709
http://help.dugeo.com/m/faq/l/308709


How can I create a simple velocity model for 
2D data? 

A velocity model can be constructed using Volume Maths (see Volume Maths). While the 
equation may be a little daunting, the result is very flexible. For 2D data, we will use stack 
data to define the output lines. 

Create a Volume Maths process 
1. In the Process tab, click on the Add icon and select New Process. 
2. Create a Volume Maths process and type a Name for the process. 
3. Click OK. 

4. In the Details Panel, click the Add icon to add your 2D volume and horizon. 
5. Input the following formula: 

max((twt_ms - WB)/(9000-WB) * 4500 + 1500, 1500) 

(See below for a brief explanation of the equation.) 

6. Set the output extents as follows: 
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• TWT (ms), 0 - 9000 [24] 

7. The process should now yield a resulting volume in the Volume tab. 

Set the class of the result volume to Velocity (Interval) 

1. Right-click on the Volume Maths process and select Open Child Volume, or find the 
resulting volume directly from the Volume tab (the process volume should be in Italics). 

2. Double click on the volume, or right click and select Configure Volume. 
3. In the Configure Volume window, set the class of the resulting volume to Velocity 

(Interval). 

A brief explanation of the equation 

max((twt_ms - WB)/(9000-WB) * 4500 + 1500, 1500) 

1. max(result, 1500) 
• The minimum velocity is 1500; only output the result if it is larger than 1500. 

2. (twt_ms - WB) / (9000-WB) 
• The current time sample (twt_ms), as a fraction (0.0 to 1.0) between the water bottom 

and 9000ms. 
• To scale between two horizons, add another horizon (symbol 'h2') and replace '9000' with 

'h2'. 
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3. (fraction * 4500) + 1500 
• Calculate a velocity between 1500 and 6000, scaled by the fraction. 
• The fraction is scaled by 4500. 

• 4500 = 6000 - 1500 
• (Scaling) = (the model maximum velocity) - (the model minimum velocity) 

Genuine offer of assistance 
If you have any questions regarding the workflow, or if you need a variation of this process for a 
3D model, don't hesitate to contact our support team at support@dugeo.com. 
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How do I create a velocity gradient volume? 

Follow the steps below to display the vertical gradient of a velocity volume at any point. 
Using the velocity gradient, large changes in the velocity can be easily seen. 

1. Copy volume 

To be able to display the velocity gradient, a duplicate of the velocity volume is required. 

Follow the steps in Creating a Copy of a Volume to create a copy, export and configure the 
velocity volume. 
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2. Set bulk shift 

After creating a copy of the velocity volume, shift the duplicate volume by the desired value, e.g. 
-100 ms (see Manual Mistie Corrections). 
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3. Volume math 

Create another Volume Maths process, and select the original and the duplicate volume. At 
Formula, type 

v2-v1 

where: 

• v2 = copied and shifted velocity 
• v1 = original velocity volume. 

As a result of this process, a new volume is available in the Volume tab based on the Formula. 
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4. Viewing the gradient 

At the navigation bar, select the Gradient volume. 

The gradient can be displayed in 3D View, Map View, and any section views. Press F5 or F6 to 
make the colourbar hotter or colder respectively. 
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Simple velocity tie (to wells) 

Creating velocity volumes is easy in Insight - just take a look at some of our suggested 
workflows. 

Matching a velocity to tie the well location can be more troublesome. A simple velocity tie 
can be achieved by calculating the vertical interval velocity in time (V0) from any "isotropic 
interval velocity model" in time, possibly from depth migration or velocity picking, and an 
interval delta model in time. Insight packages this workflow up into easy-to-use processes 
available in the Explorationist and Image Gather Processing modules. 

The workflow can be split into 3 stages: 

1. Use the Synthetics tool to create delta curves for each well that you want to influence the 
model. 

2. Create an interval delta model in time. 
3. Calculate V0 from delta and isotropic depth mig velocities. 

1. Synthetics tool delta curves 
Generate the delta curve for the wells in DUG-Insight’s Synthetics tool. The delta curves will 
then be used to build 3D delta models (see Delta Model). 
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1. As a prerequisite, you need to load the (NMO) interval velocity volume and select it for time/
depth conversion as described in Converting Time-Depth. 

 Note: The delta curve is calculated at the wells using the well’s checkshot Vint and an 
initial (NMO) isotropic Vint field selected for Time-Depth Conversion (See Generate Delta 
Curve). 

1. In the Synthetics window, open the View tab. 
2. Under the Tracks section, click the amber circle at Delta to display the Delta track in 

Synthetics. 
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3. Open the Delta tab in the Synthetics window. 
4. Select the Calculate Delta check box. This is to create the delta curve. 

• Note: Delta values are required to be in the range of -0.25 to 0.35. 

5. At NMO Velocity, the velocity volume selected for time/depth conversion is shown. 
6. At Extrapolation Top, select Well Water Bottom or Horizon (and select the water bottom 

horizon). This parameter defines the depth above which the delta value will be extrapolated. 
7. Type the display sample interval for the delta curve at Display Sample Interval (m). By 

default, this is set to "20". 
8. At Smoothing Window (m), type the smoothing value for the delta curve. By default, this is 

set to "12". 
9. Select the blocking option to be used for the delta curve after smoothing at Blocking. 

• No Blocking: Display the smoothed delta based on the display sample interval. 
• Regular Blocking: Use the regular blocking option and type the block size in meters for 

the delta curve (this is equivalent to making a coarse sample interval). 
• Horizon Blocking: Use the horizon blocking option and select the horizon(s) used in the 

blocking. To add the horizons, click the Add Row icon. 

10. QC the delta curve generated. Valid delta curve results must be in the range from -0.25 to 
0.35. 

2. Create an interval delta model in time. 
The Delta Model process builds a delta model from well curves. It requires a windowing model 
(see Creating a Windowing Model) and at least one well with a delta curve. 

Window model layers are automatically divided by ghost horizons using the conformability 
specified in the windowing model. Delta values are selected for the model at the intersection 
between each well and the ghost layer. These values are combined according to the specified 
per-layer settings. 
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 Note: Create the Window model in Time as Delta model process creates an interval 
delta model in time. 

1. In the Control Panel, open the Process tab. 
2. At the tab header, click the blue "+" icon and select New Process. 
3. Double-click Delta Model. 
4. Type a name for the process and click OK. 

5. Select the windowing model to be used in the process at Layer horizons - select a windowing 
model (see Creating a Windowing Model). 
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6. In the Output Extents section, select a survey to be used in the delta modeling process at 
Survey. 

7. Type the range of Inline extent, Crossline extent and time (TWT) extent for the delta model 
and the respective sample intervals. 

8. In the Wells section, click the Add Row (blue "+") icon to add the wells used in the delta 
modeling. 
Note: Specific vertical extents can be specified at each well by selecting  Specify well curve 
vertical extents (ms) option. 

9. Select the delta curve for each well to be used in the delta modeling. 
10. In the Per-Layer Settings section, select the calculation type used to distribute delta in each 

layer in the windowing model. Available options include: 
• Inverse Distance 
• Average of Well Values 
• User-specified constant 

11. As a result of this process, a new delta volume is added in the Volume tab. You can further 
smooth the delta model using the Volume Smoothing process. 

3. Calculate V0 from delta and isotropic depth mig 
velocities. 
Calculates the vertical interval velocity in time (V0) from an isotropic interval velocity model in 
time, and an interval delta model in time. 

Page 231FAQ

http://help.dugeo.com/m/Insight4-0/l/438826-volume-smoothing


1. In the Control Panel, open the Process tab. 
2. At the tab header, click the blue "+" icon and select New Process. 
3. Double-click V0 from delta and isotropic depth mig velocities. 
4. Type a name for the process and click OK. 

5. Select the nmo interval velocity volume (in time) used in delta calculation. 
6. Select the delta model (time). 

• Volume is calculated using formula Vo/Vnmo = 1/sqrt(1+2*delta) 
• See paper Tsvankin, I., 2012, Seismic signatures and analysis of reflection data in 

anisotropic media: Society of Exploration Geophysicists, third edition.  

7. As a result of this process, a new volume that ties the well locations is added in the Volume 
tab. You can further smooth the delta model using the Volume Smoothing process. 
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Horizons 
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How do I create a contact horizon for use in 
layered models? 

To construct the model including a contact, you will need to construct a version of the 
contact horizon that is bound by the neighbouring horizons. 

Refer to this diagram: 

1. In Map View, open the Operations tab and select Horizon Math. 
2. Add the two bounding horizons ("top" - Top Res, "base" - Base Res). 
3. Set the property of each to TVD (assumes you have a velocity model configured for Time-

Depth conversion). 
4. Use this formula to create a constrained constant surface (e.g. at 2500): 

if (top > 2500, top, if (base < 2500, base, 2500)) 
5. Set the output Z dimension to TVD. 
6. Click Run. 

Rename the result to something useful, e.g. constrainedOWC. 

Replace the constant value in your model with this constrained horizon. 
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How do I perform an amplitude extraction 
at different angles through the volumes? 

This can be done by performing amplitude extractions on horizons that dip at specific 
angles. 

Creating the initial angle horizon 

1. From the View menu in the Control Panel, open the Map View. 
2. Select an existing horizon that covers the area (the waterbottom might be a good choice). 
3. Expand the Operations tab and select Horizon Maths. 
4. Use the base formula: 

IL - <minimum inline>*<inline spacing>*tan(<oblique angle>*pi/180) 

• This formula calculates a new horizon with depth values at a specific angle dipping in the 
crossline direction. 

• You can replace the IL with CL to set the dip direction to the inline direction. 

5. Define the output as TVDSS (m) since the survey spacing is measured in meters. 
6. Click Run to begin the operation. 
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Once you have this base angle horizon, you can use the Ghost operation in Map View to move 
the horizon up or down by a constant amount (see Ghost). This will allow you to cut the volumes 
at different depths/times. 
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Converting time-depth 

If you need to convert the horizon to time so you can extract amplitudes from time volumes, a 
constant velocity volume that will allow a 1:1 conversion between the TWT and TVDSS for the 
horizon can easily be created. 

1. From the Control Panel, open the Process tab. 
2. Click the Add icon and select New Process. 
3. Select Volume Maths and give the process an appropriate name. 
4. Set the Formula to a constant 2000. This will create a new volume under the Volume tab. 
5. Change the class of the volume to Average Velocity. 
6. From the File menu in the Control Panel, select Configure Time/Depth Conversion. 
7. Choose the new volume as the Velocity Volume. 

Now you have dipping horizons on which you can view amplitudes/values from your volumes. 
Remember you can just change the horizon property to Amplitude in the Map View to do the 
on-the-fly amplitude extraction. 
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Why is the amplitude value as shown by the 
cursor different than the horizon extracted 
value? 

The amplitude value displayed by the location of the cursor in section views, and the 
amplitude value extracted by horizon amplitude extraction, are fundamentally different. 

• The cursor value displays the amplitude based on the nearest true sample value. 
• The horizon amplitude extraction extracts the amplitude to the nearest 1000nth of a 

milli-second, based on the interpolation function. 

True amplitude sample value vs Interpolated function 
value 
The difference between the true amplitude sample value and interpolated function value can 
be demonstrated by switching the display interpolation method in Class settings. The three 
following options are available: 

• Nearest — Displays true amplitude sample values only. Quickest to render but provides the 
lowest quality of result. 

• Bilinear — A simple linear interpolation to render the colour information and is slightly 
slower than the nearest neighbour method. 

• Bicubic — Uses bicubic splines to interpolate your data. This provides the best output at the 
expense of performance. 

The following images demonstrate the effect of switching between Nearest and Bicubic 
interpolation methods. The images also include the wiggle traces, with no oversample (in 
Nearest), and oversampled (in Bicubic) for clearer understanding. Over sample controls the 
smoothness of the wiggles. When set to 1, you will essentially see the raw trace. When set to 5, 
you will see something that resembles interpolation function. 
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In both the images, a horizon is displayed, which was picked with Snap enabled. The snap 
function snaps the horizon to the highest amplitude value based on the interpolation function. 
The horizon extraction extracts the same value based on the interpolation function. Hence, the 
extracted value will almost certainly always be different to the nearest true sample value. 
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It is important to note however that, even with the cursor value based on the 
interpolation function, unless you can place the mouse cursor on the EXACT same time 
as the horizon, you will still NEVER see the exact same value. 
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How do I decimate an interpolated surface 
back to its original picked lines? 

If you picked your original surface on a regular grid, you can extract the original picks as a 
lattice horizon using Horizon Maths. 

Workflow 
1. In the Map View, select Horizon Maths and input your IL/CL horizon. Call it 'h1'. 
2. Define the formula: if( il % 10 == 0 || cl % 10 == 0, h1, nan). This formula translates as: Keep 

inlines and crosslines that, when divided by ten, have a remainder of zero. 

 Note: The modulus operation (%) used in this formula is a fast way to find the 
remainder after dividing by some value. In cases where the horizon locations are not 
evenly divisible by the lattice increment (i.e. there is some offset), no picks will be 
returned. 

For example: 
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• If inline values are on the sequence (105, 115, 125...), (il % 10) will never be zero. 
• If crossline values fall on odd values (101, 103, 105...), (cl % 2) will never be zero. 
• In these cases, add or subtract a constant so the result is evenly divisible by your 

lattice increment. 

Also: 

• If inline values are on the sequence (105, 115, 125...), ((il + 5) % 10) will work. 
• If crossline values fall on odd values (101, 103, 105...), ((cl - 1) % 2) will work. 

Page 243FAQ



How to display data from two or more 
horizons simultaneously 

To view multiple horizons, or multiple attributes of one horizon, there are a few options, 
depending on what you would like to achieve: 

• Use multiple map view 
• Merge using horizon maths 
• Using 3D view 

Use multiple map view 

Open a second Map view to display each horizon (see Volumes and horizons in Map View). 

There are two approaches: 

• From the Control Panel, View menu, choose New Map View, OR 
• Right-click on an existing map view and choose “Duplicate this window” 
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Merge using horizon maths 

To combine two (or more) pieces of a horizon to a single surface: 

• Use Operations > Horizon Maths 
• Add each of the horizons to merge 
• Use the Formula: merge (a, b) 

For more on horizon maths see Common horizon tasks in horizon maths. 
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Using 3D view 

• Open the 3D view 
• In the Control Panel > Horizon tab, toggle the display of each horizon using the 'traffic light' 

icon 
• Enable the option in the Control Panel to display the horizon as a 3D surface, not the 

intersection (see Horizon Overview). 
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In the 3D view, different attributes can be displayed for horizon. To display multiple attributes 
for the same horizon, create a duplicate and display a different attribute for each. 

1. Duplicate your horizon (see Copying a Horizon). 
2. In the Control Panel, display the original and hide the copy. 
3. Right-click on the original horizon in the 3D view and choose "Settings for Horizon". 

• Select the property to display. 
• Click the class and set the opacity. 

4. In the Control Panel, hide the original and show the copy. 
5. Right-click on the duplicate horizon in the 3D view and choose "Settings for Horizon". 

• Select the property to display. 

6. In the Control Panel, show the original horizon again. 
7. Both horizon attributes are now displayed together. 

For more on viewing horizon attributes in 3D view, see Horizon options in 3D view. 
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How do I extract the number of events 
between 2 time horizons? 

Use this workflow to calculate a rough estimate for event counts, based on average 
frequency and time thickness of the target zone. This example calculates the seismic event 
counts from TopRes to BaseRes horizons for a 3D seismic volume in time. 

Step1: Create an  instantaneous frequency for stack: 

1. Go to Control panel > Process and add an Instantaneous Attributes process 
2. Select the volume. 
3. Select the Frequency checkbox. 
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Step 2: Calculate average of instantaneous frequency (Ave_IF) from the top to bottom horizon: 

1. Go to Control panel > Map view. 
2. Click the Operations tab and select Amplitude Extraction from the Operation dropdown 

menu. 
3. Under Horizons, use this configuration: 

• Top: pick Horizon from the dropdown and select the top horizon e.g. TopRes. 
• Bottom: pick Horizon from the dropdown and select the bottom horizon e.g. BaseRes. 

4. Use the created volume from the Instantaneous Attributes process e.g. instantaneous 
attributes: frequency. 

5. Use Simple Average as the property. 
6. Click Run. 
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Step 3: Calculate time thickness from the top to bottom horizon: 

1. Calculate time thickness from the top to bottom horizon: 
2. Go to Control panel > Map view. 
3. Click the Operations tab and select Horizon Maths from the Operation dropdown menu. 
4. Add 2 symbols by clicking the blue "+" button and set: 

• h1: top horizon e.g. TopRes 
• h2: bottom horizon e.g. Base Res 

5. Use formula: h2 - h1. 
6. Click Run. 
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Step 4: Calculate Number of events from top to bottom horizon: 

1. Go to Control panel > Map view. 
2. Click the Operations tab and select Horizon Maths from the Operation dropdown menu. 
3. Add 2 symbols by clicking the blue "+" button and set: 

• h1: the calculated average of instantaneous e.g. Ave_IF 
• h2: the calculated time thickness e.g. Thickness_time 

4. Use formula: Ave_IF x (Thickness_time / 2000) or h1 * (h2 / 2000). 
5. Click Run. 
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The results can be QC with the Event counts graphed on top of the seismic section by writing 
the results from step 4 to one of the unused header in the seismic: 

1. Go to Control panel > Process. 
2. Click the blue "+" button and add a Header Maths process. 
3. Select the seismic in the Volume search box. 
4. Add a new symbol by clicking the blue "+" button. 

• Select the "Event counts" horizon as h1. 

5. Add a new header formulae by clicking the blue "+" button: 
• Select header: 105 laga: SEG-D Skew. 
• Use formula: if (isnan(h1), nan, h1). 

Note: To QC this event, use the IL/CL view and enable header graphs. 
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How do I perform an amplitude extraction 
between two horizons? 

An amplitude extraction between two horizons can be done from the Map View (see 
Horizon Operations in Map View - Amplitude Extraction). 

Alternatively, you can also perform an amplitude extraction between two horizons by using 
a sculpted volume. Follow the steps below for a different approach to amplitude extraction 
between two horizons. 

Note: You should first familiarise yourself with how to perform an extraction along a single 
horizon (see the "Mapping and Attributes" tutorial video, or the Single Horizon Amplitude 
Extraction section in the User Manual). 

Create a volume sculpting process 

1. From the Control Panel, open the Process tab. 
2. In the Process tab, click on the Add icon (+). 
3. Scroll down and double click on Volume Sculpting. 
4. Type a name for the process and click OK. 
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Sculpt volume between horizons 

5. In the Details Panel, select the input volume to sculpt at Volume. 
6. At Top and Bottom Horizon, choose the top and bottom horizons that you want to extract 

between (and your data volume). 
7. At Constrain to area, select a polygon/probe to constrain the sculpting to the area covered 

by the polygon/probe (see Creating a Polygon in Map View, Creating a Probe). 
8. Select the Exclude traces where a horizon is missing check box to remove traces where 

one or both horizons are not present. By default, areas of the volume not covered by the 
horizon(s) are unmodified. 

As a result of this process, a sculpted volume is available in the Volume tab. 
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Set amplitude extraction window 

1. From the Control Panel, open the Map View. 
2. At Horizon, select either the top or bottom horizon. 
3. Click on the spanner icon beside the horizon property. 
4. Choose the sculpted volume from the previous step as the Volume to use. 
5. If you chose the top horizon, set your Below amplitude extraction window large enough to 

cover the entire sculpted volume (or the Above window if you chose the Below horizon). 
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How do I dynamically update an Isochron 
Map? 

Use Volume Maths to create a volume based on the Isochron values and then extract them 
onto the horizon. As you make edits to the horizon map, Insight will dynamically update the 
volume. 

1. Go to the Process tab and add a Volume Maths process. 
2. Add two horizons with the "+" in the Volume Maths panel and select horizons  for h1 and 

h2 respectively e.g. Top and Base horizons for Isochron. 
3. Use the formula h1-h2 in the Formula text box. This will create an Isochron volume. 
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4. Go to the View menu and display the volume in IL/CL View, with horizons overlaid. 

5. Display a horizon you wish to drape the isochron onto in Map View. 
6. Click ther Operations tab and perform amplitude extraction (learn about Amplitude 

Extraction). 
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7. Create a Group with Isochron volume and Full Stack and set the Isochron volume opacity (in 
class) to mid (read about Creating a Group and Class Opacity). 

8. Edit anomalous values directly on the input horizons and the Volume and extraction will 
dynamically update. 
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How do I pick events on absolute impedance 
and other non-zero mean data? 

1. From the Volume tab, load impedance or velocity volume (continuous, non-zero mean data). 

2. Go to the Process tab and apply a Bandpass Process to remove the low-frequency signal. 
3. Select the impedance or velocity volume in the Volume search box. 
4. Choose High-pass Filter type. 
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5. Go to the Horizon tab and pick a new horizon. 
6. In the horizon picking settings, choose the appropriate event type. In this example, Zero 

Decreasing was used to identify this top-sand. 

7. Arbline showing Horizon Picked on Band-limited P-Impedance. 
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How do I export a time-slice as an X, Y, 
Amplitude map? 

To export a time-slice as an X, Y, Amplitude map: 

1. Create a constant time or depth horizon 
2. Configure the amplitude extraction 
3. Capture the result as a custom property 
4. Custom horizon export as X/Y/Amplitude 

Workflow 

Create a constant time or depth horizon 

1. Go to the Map View > Operations tab. 
2. Select Create Constant Horizon in the Operations dropdown 
3. Enter a Value for the horizon. 
4. Select the Vertical dimension to use. 
5. At Area, select a polygon or probe. 

• To create a probe or a polygon, see Creating a Polygon in Map View or Creating a Probe. 
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6. Enter the Spacing (m) (grid cell size, or increment) for the horizon. 
7. Select the Survey to use. 

• Choose <<X/Y>> for a regularly spaced grid without a survey. 

8. Click Calculate to start the operation. 
9. Click Create to create a new horizon containing the extracted values. 

10. By default, the new horizon will be named: “constant_value survey/gathers” e.g. 1,500 ms X/
Y. 

Configure the amplitude extraction 

11. Select the volume to extract from. 
12. Select the constant horizon. 
13. (Optional)Turn off the time slice. 
14. Select the horizon property to extract (e.g. Amplitude). 
15. Click the tool button to adjust extraction properties (for windowed properties such as RMS). 
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Capture the result as a custom property 

16. Right click on the displayed amplitude map 
17. Click Save horizon as a custom property. 
18. Enter a name for the property. 
19. Click OK. The property will be added to that selected horizon. 
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Custom horizon export as X/Y/Amplitude 

20. Go to Control Panel > Horizon tab. 
21. Right-click on the constant horizon and choose Export 'horizon_name'. 
22. In the Export window, choose Export customised text file. 
23. Click OK. 
24. In the Export Horizon window, choose columns X, Y and the custom property. 
25. Click OK and save the file in a desired location and name. 

Page 264FAQ



How to create a horizon from trace headers 

To create a horizon from trace headers, use a combination of Volume Maths and the
Amplitude Extraction horizon operation. 

Extract the header values to a volume 
1. In the Control Panel / Process tab, add a new Volume Maths process. Name the process, 

e.g. “Header TRACF”, and Click OK. 

2. In the Symbol & Volume section, click the blue "+" icon. 
3. Choose the volume containing the header values to extract. 
4. In the formula, enter the header name, e.g. TRACF or SWDEP 

• See this list of available trace headers. 

5. The result volume containing the header value will be in the Volume tab. 
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Create a horizon from the volume 

6. In a Map View, open the Operations tab. 
7. Choose Operation / Amplitude Extraction. 
8. For Volume, choose the volume math result, e.g. “Header TRACF” 
9. For Property, choose Simple Average. 

10. Enter any two different values for Top and Bottom. 
11. Click Calculate. 
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Completing the operation 

 After running the operation: 

• At Class: Choose the Display Class for the results 
• Use Unknown for raw values unless a better choice is available. 

• Review the results in the display by: 
• Check: Use min and max from class settings 
• Click Adjust to set the Min and Max from the extracted amplitude. 

• Click Create to save the values as a new horizon 
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How to mark a pinchout/intersection of two 
surfaces using a polygon? 

Investigating stratigraphic traps or a stratigraphic surface which has been interrupted by a 
fault?  How do we map the resultant pinchout/intersection between these two horizons 
using DUG-Insight?  The workflow below discusses how to create a detailed polygon 
outlining the pinchout/intersection. 

Workflow 

1. Pick the top (h1) and base (h2) horizons of your pinchout structure 
2. Create a pinchout horizon using Horizon maths 

• Inputs: h1 = top horizon, h2 = base horizon 
• Formula: if (h1<h2, h1, nan) 
• (If top horizon is greater than base horizon use top horizon.  If not use nan as value.) 
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3. Create a constant horizon using the Constant horizon 
• Value: 0 ms 
• Vertical: TWT 
• Output grid: polygon which covers entire horizon area 
• Spacing: 100 
• Survey: Same 3D survey as original horizons 
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4. Merge the pinchout horizon created in step 2 and constant horizon created in step 3 using 
Horizon Maths 
• Inputs: h1 = pinchout horizon, h2 = constant horizon 
• Formula: merge (h1, h2) 
• (Merge pinchout horizon and constant horizon, give priority to pinchout horizon) 
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5. Display in Map View. 

We now have the intersection represented clearly on the merged horizon.  Create a polygon 
along this boundary using create polygon from contours tool. 

6. Open Display tab and select contours 
7. Display 0 contour in Map View 

8. Create polygon from contour 0 using Create contour Polygons 
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9. Final polygon showing pinchout intersection. 
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Faults 
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How do I import or export faults? 

Insight can import and export faults in three ways: using either the GeoQuest IESX format, 
VoxelGeo XYZ or using DUG's own (.dufault) format. 

Importing fault sticks from a GeoQuest IESX file 

This standard format can be produced by almost every software package. A single file can 
contain an arbitrary number of faults, each of which will be imported as a separate fault in 
Insight. Unassigned fault sticks are imported in the same way. 

Insight imports only fault sticks, from which it will build its own tesselated surface and fault 
polygons. Insight does not yet import fault polygons or surfaces from other software. 

The example above shows a GeoQuest IESX data file. 

Importing fault sticks from a DUG fault file 
The DUG fault file is a simple text format that may be more convenient for scripting. 

It consists of a single X/Y/Z point per line, separated by whitespace, with a blank line to indicate 
a new fault stick. The filename generally has the extension ".dufault" 

This is an example of a three-stick .dufault file: 

626281 6178923 2604 

Page 275FAQ



626269 6178885 2706 
626210 6178697 2833 
626110 6179213 2602 
626051 6179027 2860 
626009 6178894 3027 
625971 6178772 3113 
625918 6179436 2590 
625858 6179245 2987 
625792 6179036 3194 
625732 6178847 3373 

Importing fault sticks from a VoxelGeo XYZ fault file 

The example above shows a VoxelGeo XYZ data file. 
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Exporting fault sticks as a GeoQuest IESX file 

This standard format can be read by almost every software package. By default, Insight exports 
the fault sticks to the GeoQuest IESX format (.dat file extension). If you have defined a velocity 
volume for time/depth conversion (see Converting Time-Depth), you can export the fault based 
on the time/depth domain. 

1. In the Fault tab, right click on the fault(s) you wish to export. 
2. Click Export 'Fault'. 
3. In the Export Fault window, select the time (TWT) or depth (TVDSS) domain to export your 

fault. 
4. Click OK. 
5. Browse to the location you want to export the fault(s) and click Save. 

Exporting fault surfaces as a GoCAD file 
When exporting a single fault, Insight will also export the tesselated fault surface in a separate 
GoCAD TSurf file alongside the GeoQuest file containing the sticks. 
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Wells 
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How do I load well data? 

DUG Insight reads well data from text files. Curve and log data should be stored in LAS 
format, with a single LAS file per well. 

The first time you import a well for use in DUG Insight, you will use the Well Import dialog to 
create a duwell file. The duwell file describes the well, and contains pointers to the LAS, 
checkshot, deviation, and markers files. 

You can also bulk import all well data to create a new well. 

Create well file 

1. From the Control Panel, open the Well tab. 
2. Click on the Add icon and select New Well. 
3. The New Well window will be displayed. 
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4. Fill in all of the relevant information for your well and click Create Well. 
5. Once you have a duwell file, you can load it by clicking on the Add icon and select Load 

Wells already in the project. 

Checkshot (time-depth) Surveys 

Time-to-depth information is required for DUG Insight to display well data in time. Checkshot 
data points require two values: 

• the measured depth at the well, and 
• its corresponding two-way-time 

The depth column label should indicate the depth datum. Expected depth labels are: 

• MDKB: Measured Depth from Kelly Bushing / Round Table 
• MDSS: Measured Depth Sub Sea 
• MD: Measured Depth (assumed to be MDKB) 

The time column label should be "TWT". No other time formats are accepted. 

Sample checkshot survey: 

Time-depth survey for Well-1 
2 
MDKB    TWT 
1210.00 1170.07 
1710.00 1500.07 
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2210.00 1800.04 
2700.00 2150.06 
3200.00 2520.03 
3730.00 2810.07 
4000.00 2960.74 

Deviation Surveys 

Deviation surveys are required for DUG Insight to accurately display deviated wells. Deviation 
surveys require four values for each point: 

• the measured depth 
• the true vertical depth 
• the UTM X coordinate at this depth 
• the UTM Y coordinate at this depth 

The measured depth column label should indicate the datum. Expected measured depth labels 
are: 

• MDKB: Measured Depth from Kelly Bushing / Round Table 
• MDSS: Measured Depth Sub Sea 
• MD: Measured Depth (assumed to be MDKB) 

The true vertical depth column label should indicate the datum. Expected true vertical depth 
labels are: 

• TVDKB: True Vertical Depth from Kelly Bushing / Round Table 
• TVDSS: True Vertical Depth Sub Sea 
• TVDBML: True Vertical Depth Below Mud Line 
• TVD: True Vertical Depth (assumed to be TVDKB) 

The UTM X and Y columns should be labelled "UTMX" and "UTMY" or "X" and "Y", respectively. 

Sample deviation survey: 

Deviation survey for Well-1 
4 
MDKB       TVDSS       X            Y 
0.00       -20.06      39844.56     24589.34 
1000.00    1020.02     39844.47     24588.95 
2000.00    1990.05     39845.82     24590.47 
3000.00    2980.00     39895.21     24524.15 
4000.00    3410.03     40453.486    23864.922 
5000.00    3910.05     41009.257    23219.492 
6000.00    4890.06     41036.517    23192.534 
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Well Markers 

Markers are text labels applied to points along the well path. Well marker files require two 
values: 

• the marker name (the text placed beside the point at the well) 
• the marker depth 

The marker name column should be a short description of the point. Spaces and commas are 
not allowed in the name. We recommend the use of underscore '_' or hyphens '-' to replace 
spaces. The marker name column should be labelled "Name". 

The marker depth column should indicate the datum, as above. 

Sample marker file: 

Markers for Well-1 
2 
NAME          MDKB 
WaterBottom   185.0 
Cretaceous    2700.00 
Jurassic      3200.00 
Triassic      3730.00 
Permian       4000.00 

Bulk import well data 
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Well data that was exported to OWX and ASC format can also be imported as a new well. 

1. To bulk export well data, right click on the well in the Control Panel and select Export > All 
data (OWX format). 

2. To import this file, open the Import menu and select Well Data. 
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Creating checkshots from a velocity model 

This FAQ is no longer relevant. DUG Insight (4.0+) includes a more convenient approach. 
See this page for details: 

• http://help.dugeo.com/m/Insight4-0/l/542676 
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Height datums and abbreviations 

The diagram below depicts the measurement of each height datum together with its 
abbreviation. 

TVDSS is True Vertical Depth SS. This is measured from mean sea level (MSL). It does not 
reference KB. 

Kelly Bushing (KB) is the height of the Derek (drill rig) measured from the MSL. The interpreter 
should manually enter the KB height under the well info tab (see Creating a New Well). 

The KB information is also stored when MDKB or TVDKB is entered in at a well (usually in the 
well Path/Deviation). In these instances, the KB will be checked against the KB in the well info to 
ensure they match. If they do not, the user will be given a warning. 
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Why can't I see my well in section views? 

Do you have a well that is near an inline or crossline but is not showing up on the seismic in 
section views? 

If the well does not go through the line exactly, you may need to increase the well 
projection distance in order to display it. 

Increase well projection distance 
The well Projection Distance controls how far away a well can be displayed from a section view. 
Choosing larger values includes the well on more distant IL/CL or arb lines. Smaller values will 
only include the well on very close IL/CL or arb lines. 

1. Select the well in the Well tab of the Control Panel (see Defining Well Settings). 
2. Increase the Projection Distance (m) until the displayed section is within this distance from 

the well path. 
3. One way to figure out how much distance is required is to right click in Map View and select 

Add Measurement. Draw a straight line from the well to the line to calculate its length (see 
Measuring in Map View). 
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My projection distance is okay, what else can I try? 

Are you viewing the wells in TWT or TVD? 
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1. Try switching the section view to TVD. Wells can almost always be displayed in depth! 
Displaying in depth requires only a well path, or surface location. 

2. To display in TWT, wells require time-depth conversion, provided by the checkshots or time-
depth pairs configured for the well. If there are no time-depth pairs, the well will not display 
in TWT sections. 
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Insight's Automatic Well Curve Class 
Assignment 

When importing a well, Insight will assign the class of the well curve as follows. 

Well Curve Class Keyword 

DENSITY rho, RHO, RHOB, ZDEN, RHOZ, FDC, DENSITY, DEN, 
DENC 

DEPTH depth, DEPTH, DEPT, MD 

TVD TVD 

S SLOWNESS DTS, SDT, DTTS, DTSM, DT_SH, DT2, DTS -RC, BATS, 
ACS 

P SLOWNESS DT, DTCO, DT4P, SLOW, SONIC, DTM, DT4, BTCS, 
BATC, NCTL_DT, NCTL_VEL, VELMODEL_DT, 
OSCTL_DT, AC 

PVELOCITY Vp, VP 

SVELOCITY Vs, VS 

GAMMA GR, GAMMA, GMR, GRM, SGR, CGR 

RESISTIVITY resistivity, LLD, LLS, MSFL, LLG, RES, ILD, ILS, RT, 
RXO, SFL, ML, NCTL_RES, OSCTL_RES, RMIC 

RESISTIVITY DEEP resistivity deep, LLD, LLS, MSFL, LLG, RES, ILD, ILS, 
RT, RXO, SFL, ML, RDEP 

RESISTIVITY MID resistivity mid, LLD, LLS, MSFL, LLG, RES, ILD, ILS, RT, 
RXO, SFL, ML, RMED 

RESISTIVITY SHALLOW resistivity shallow, LLD, LLS, MSFL, LLG, RES, ILD, ILS, 
RT, RXO, SFL, ML 
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RESISTIVITY XSHALLOW resistivity xshallow, LLD, LLS, MSFL, LLG, RES, ILD, 
ILS, RT, RXO, SFL, ML 

VOLUME SHALE Vsh, VSH, VCL 

WATER SATURATION Sw, SW, SXO, XSXO 

WATER SATURATION (EFFECTIVE) Sw, SW, SXO, XSXO 

WATER SATURATION (TOTAL) Sw, SW, SXO, XSXO 

WATER SATURATION (INVADED) Sw, SW, SXO, XSXO 

PIMPEDANCE PI, PIMP, IMP, AI 

SIMPEDANCE SI, SIMP 

POROSITY phi, PHI, POR 

POROSITY (EFFECTIVE) PHIE, PORE 

POROSITY (TOTAL) PHIT, PORT 

BULK MODULUS K 

SHEAR MODULUS mu 

TIME time, TIME 

REFLECTIVITY reflectivity, REFL 

ANGLE angle, ANGLE 

SEISMIC seismic 

RATIO ratio, RUGOSITY 

PHOTOELECTRIC EFFECT PEF, PE 

SPONTANEOUS POTENTIAL SP 

CALIPER CALI, CAL 
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NEUTRON POROSITY NPHI, SNP, CNL, NEUT, NEU 

DENSITY CORRECTION DRHO 

TEMPERATURE TEMP 

VPONVS VPONVS, VP_VS, VPVS 

MU_RHO MRHO, MURHO, MU_RHO 

LAMBDA_RHO LRHO, LAMBDARHO, LAMBDA_RHO 

PRESSURE PRES, PP_DT_Eaton, PP_RES_Eaton, PP_VEL_Eaton, 
PP_P10_DT_Eaton, PP_P10_RES_Eaton, 
PP_P10_VEL_Eaton, PP_P90_DT_Eaton, 
PP_P90_RES_Eaton, PP_P90_VEL_Eaton 

PRESSURE_GRADIENT PP, PPG_DT_Eaton, PPG_RES_Eaton, PPG_VEL_Eaton, 
PPG_P10_DT_Eaton, PPG_P10_RES_Eaton, 
PPG_P10_VEL_Eaton, PPG_P90_DT_Eaton, 
PPG_P90_RES_Eaton, PPG_P90_VEL_Eaton 

PORE_PRESSURE PP_Interp 

FRACTURE_PRESSURE FP_MK 

OVERBURDEN_PRESSURE OBP 

PORE_PRESSURE_GRADIENT PPG_Interp 

FRACTURE_PRESSURE_GRADIENT FG_MK 

OVERBURDEN_PRESSURE_GRADIENT OBG 
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Where does Single Well View extract 2D 
value from? 

In Single Well View, a seismic trace can be extracted along the well path from an input 
volume. When using a 2D volume, which the well does not directly intersect, Insight will still 
extract a curve. What is it extracting here? 

For a 2D volume, it uses the "nearest line" based on the well's surface location. This may be 
different to the nearest line selected for display in a seismic track, which is based on the 
weighted average distance from the full well path. The well path is projected onto the line using 
flux projection using the same approach as displaying the well on a 2D or arbline section. 

Four-point lagrangian interpolation is used for horizontal interpolation, while vertical 
interpolation is determined by the volume's class configuration, see picture below. 
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The curve is produced in MDKB by sampling at one metre intervals along the well path, defined 
by points in X/Y/(TWT or TVD depending on the volume's domain). The well path is interpolated 
linearly between those points. 
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How to export map values at specific IL/CL 
locations? 

1. Open a text editor and create a column of line ID besides the well inline/xline locations. 
2. Save this file as a .dat file. 
3. Open Insight and import them as horizons (see Using the Horizon Text Importer). 
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4. Set the IL, CL and TWT values in their respective columns. 
5. Click OK to continue importing. 
6. Go to Control Panel > Map View. 

7. Go to the Operations tab and select Horizon Maths operation. 
8. Click the blue "+" button to add two symbols: 
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• a:  imported well list 
• b:  horizon (e.g. dip curvature horizon) 

9. In the formula field, use: ( a * 0 ) + b. 
10. Click Run. 
11. Click the Add property button and type a property name. 
12. Click OK. 

13. Right click on the imported horizon and select Export "horizon_name" (see Exporting Horizon). 
14. Select Export customised text file and click OK. 
15. Click the checkbox of the newly added properties from the previous horizon maths result 

and click OK. 
16. Type the name of the file and click Save. 

The saved file will contain the property values of the wells. 
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Calculating Well Marker-Horizon Mistie 

Use this workflow to determine the well marker and horizon intersection depths at a 
specified well marker location and use these to either generate a table of residuals, or 
calculate a residual map. 

• Calculate the Residual Mistie 
• Result 1: Export Residual Mistie 
• Result 2: Map Residual Mistie 

Build a map of marker locations 
The workflow requires a table of XY locations for each marker location. The table will be used 
create a well marker location horizon and to sample the structural horizon data at that location 
for comparison. If the wells are vertical, all the marker locations will be the same and so only 
one generic table is required. 

In additional to a well name, the table should also include a reference number for each row, it 
must be numeric, and should be a well number or code. Exported results will refer to this ID. 

1. Open a text editor and create a column of well ID besides the well marker X/Y locations. 

 Note: For wells without a marker, either exclude them from the table or set the Well 
No. to a missing value such as -999.99. 

2. Save this file as a .dat file. 
3. Open Insight and import them as horizons (see Using the horizon text importer). 
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4. In the Import window, set the X,Y values in their respective columns. 
5. Set the well ID as “Extra Attribute” 
6. Click OK to continue importing. 
7. Go to Control Panel > Map View. 

8. Display the imported horizon in the map view 
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9. Click the Operations tab and select the Regrid Operation to regrid the imported XY  well 
locations to the 3D Survey (ILCL) (see Regrid Horizon) 

10. Click Regrid. 
11. Save as a new horizon (ILCL). 

Extract the horizon depths at the markers 
Use the marker location map to filter the horizon depths, i.e. keep only the depth values at 
these locations. 

Use the marker location map to sample and store the structural horizon at the well marker 
locations. 

1. Go to the Operations tab and select Horizon Maths operation. 
2. Click the blue "+" button and add two symbols: 

• h1:  Imported well list 
• h2:  Depth converted horizon 

3. In the formula field, use: (h1*0)+h2. 
• Note: This formula discards the "Well ID" value by multiplying by zero. Because "h1" only 

has values at marker locations, the "missing points remain missing". Only the structural 
horizon points coincident with the Wellid locations will be included. 

4. Click Run. 
5. Click the Add property button, select the well marker location horizon and type a property 

name to identify the structural horizon as a source. (e.g. Horizonname_TVDSS) 
6. Click OK. 
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Create a Current Marker Value Horizon 

 Note: The initial table (Step 1) can optionally include a column of marker Z values to 
avoid this calculation. To be of use in the workflow, the table values would need to be 
stored as TVD. If the marker depth of interest in the well was then adjusted the table 
would need to be updated accordingly and reloaded. 

By calculating a marker map, using the steps below, these factors are automatically taken care 
of, the latest marker is always used with the correct TVD. 

1. Enable the wells in the Control Panel > Wells tab. 
2. Click the Operations tab and select Create Horizon from Well Markers operation. 
3. Select the Marker name. 
4. Select a polygon that includes the wells of interest. 
5. Click Run. 
6. Click the Create New button, rename the horizon to reflect the markers as the source. (e.g. 

WellMarkers_markername) 
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Extract the Marker depths at the Marker Locations 
This samples the current marker horizon at the defined locations for comparison with the 
structural horizon. 

 Note: This calculation can be skipped if the table in Step 1 includes a valid TVD marker 
depth. 

1. Go to the Operations tab and select Horizon Maths operation. 
2. Click the blue "+" button to add two symbols: 

• h1:  Imported well list 
• h2:  WellMarkers horizon 

3. In the formula field, use: (h1 * 0)+h2 
4. Click Run. 
5. Click the Add property button, select the well marker location horizon  and type a property 

name to identify the markers as a source. (e.g. WellMarkers_markername) 
6. Click OK. 
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Calculate the Residual Mistie 
This is the main (and final) calculation that determines the difference between the well marker 
TVD and the structural horizon at the same location. 

1. Go to the Operations tab and select Horizon Maths operation. 
2. Click the blue "+" button and add two symbols: 

• h1:  Depth horizon sampled at well list 
• h2:  WellMarkers horizon sampled at well list 

3. In the formula field, use: (h1 - h2) 
4. Click Run. 
5. Click the Add property button, select the Well marker location horizon  and type a property 

name  to identify the residual . (e.g. Markername_ResidualMistie) 
6. Click OK. 

Depending on your ultimate objective, you can now either look at the residual differences as a 
table, or turn the differences into a horizon for surface correction 

Results 1: Export Residual Mistie 
This optional section explains how to view the results as a table of values. 
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1. Export the horizon as a customise text file from the control panel (see export customised text 
file). 

2. Select all the attributes of interest. 
3. Click OK to export these attributes. 

 Note: The well name was dropped during the regrid operations, which is why the Well 
ID (number) column was introduced in order to identify the final results. 
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Results 2: Map Residual Mistie 
This optional section explains how to create a residual horizon for surface correction. 

Horizon regrid and interpolate / extrapolate operate on the primary stored value of a horizon, 
not the additional (residual) attributes that have just been calculated. Create a separate horizon 
distinct from the custom attribute horizon to ensure that the correct attribute is being used in 
the interpolation process. 
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Use Horizon Math: 

1. Go to Map View > Operations > Horizon Math. 
2. Click the blue (+) and add your well marker location horizon with calculated residual as an 

attribute. 
3. Choose the Property to use (e.g. Markername_Residual Mistie). 
4. Use formula: h1 (or whatever symbol you've chosen). 
5. Check the Class is set to Depth (TVDSS) 
6. Click Run. 
7. Click Create New to save as a new horizon. Provide a suitable name for easy identification 

(e.g. Markername_Residual Mistie). 
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Interpolate the residual data 

1. Select the new TVDSS horizon of residual mistie values. 
2. Select Operations > Interpolate/Extrapolate. 
3. Click Interpolate. 
4. Save as new horizon. 

 Note: This horizon can then be added to the original structural horizon to create an 
accurate well tie. 
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Polygons 
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How do I find out the area and volume of a 
polygon? 

You can obtain the area and volume of a created polygon from the Map View (see Measuring 
in the Map View). 

Area of a polygon 

1. In the Map View, open the Geometry tab. 
2. Under Region, select the polygon you wish to use. 
3. In the Results section, select the Area check box to calculate the area in the polygon. 
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Volume in a polygon 

1. To find the volume within a polygon, select a Horizon in the navigation bar of the Map View. 
2. Open the Geometry tab and select the polygon you wish to use. 
3. In the Vertical Extents section, define the Top and Base boundaries using a constant or a 

horizon, or both. 
4. Select the Volume check box in the Results section to calculate the volume. 
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How do I convert culture polygons into 
regular polygons? 

These instructions are for importing a single polygon into Insight. In order to import 
multiple polygons, see How do I convert a .duculture file containing many shapes to a .dupoly 
file. 

Note: Simply right-click on a culture product and select Export shapes to new map 
polygon (see Working with Culture). 

1. From the Map View> Culture tab, right-click on the culture file and select Export 'Culture'. 
2. Export the file as an ASCII format .duculture file. 
3. In the Insight Control Panel, expand the Import menu and select Polygon. 
4. At Files of type, select All Files. 
5. Select the exported .duculture file and click Open. 
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6. In the Import Polygon window, define the X and Y columns. 
7. If there are no errors, click OK. 

You should now have your culture as editable polygons. 
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How do I convert a .duculture file containing 
many shapes to a .dupoly file? 

To convert a culture polygon into regular polygon, see How do I convert culture polygons into 
regular polygons. 

1. Insert Header information at the top of the file e.g. copy and paste from another file. 
2. Insert a space or indentation before every row of X/Y coordinates. 
3. Insert the word "points" between every set of X/Y coordinates, dividing each shape. 
4. Remove all other blank rows in the file. 
5. Save this file as .dupoly. 
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Crossplotting and 
Spectra 
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What is the best way to crossplot the points 
in a series of channel structures? 

The primary method of selecting points for crossplotting is by using polygons. This 
approach is favoured because of its speed and efficiency.  

1. To best utilise this approach with channel structures, draw an arbline down the center (or 
most significant section) of your channel (see Creating an Arbline). 

2. In Arbline View, select the new line and draw a polygon highlighting the channel structure 
(see Picking Polygon in Arbline View). 

3. Create additional arblines and polygons for each of your channel structures. 
Note: The crossplots will permit overlapping polygons, allowing you to have polygons such 
as "Channel 1", "Channel 1 High Porosity", etc. 

4. In the crossplot window, select and deselect the polygons to highlight the points inside each 
channel. 

Crossplot points in specific channel 

To crossplot all the points in a specific channel, you will need to use a different approach. By 
using a Volume Sculpting process on the input volumes, you can constrain the points available 
for the crossplot (see Volume Sculpting). 

1. Draw a polygon that closely follows the edge of the channel structure in Map View. 
2. Create a Volume Sculpting process: "P-Impedance - Channel 1" 

• Volume: P-Impedance 
• Top horizon: Channel top event 
• Base horizon: Channel base event (Or channel top + estimated channel thickness) 
• Constrain to Area: Channel edge polygon 

3. Use the result of this process as one of the inputs to the crossplot. 

Multiple channels 

For the more complex, multiple channel case, repeat the procedure for each channel, resulting 
in one impedance volume for each channel, e.g. "P-Imp Channel 1", "P-Imp Channel 2". Then try 
the following: 

1. Configure the crossplot to use the original (unsculpted) P-Impedance and Vp/Vs. 
2. Select a probe that includes all the channels. 
3. Select the crossplot Plot Type as Point by Point. 
4. For the Colour Data Set, select the output from a volume maths process defined as: 

• Process: Volume Maths, "Channel Identifier" 
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• Symbol: "C1" Volume: "P-Imp Channel 1" 
• Symbol: "C2" Volume: "P-Imp Channel 2" 
• Formula: if(!isNaN(C1),1,if(!isNaN(C2),2,0)) 

This example can be extended to any number of channels. The performance will be slower than 
the polygon/section approaches described earlier. 

For more information, see the following pages from the online manual: 

• Creating a Crossplot 
• Highlighting Volume Points in Crossplot. 

If you are having problems or would like to ask us a question, do not hesitate to contact our 
Support team at support@dugeo.com. 
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Processes 
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Stacking process across NaNs 
Regardless of whether you use a mute, stacking should exclude both NaNs and zeros. 

As a general rule, NaNs are always excluded. Zeros are excluded if they are at the far offset 
edge of the data (i.e. there are no non-zero, non-NaN samples between this one and the 
furthest offset). 

 Note: The steps on how to perform the stacking process can be obtained from the 
Stacking section. 
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How do I filter large amplitudes, extreme 
values and spikes from my data? 

Volume Maths is a very usefull process in Insight that allows manipulation of seismic data 
(to a certain degree). In this instance, we will use Volume Maths to identify large amplitudes, 
extreme values and/or spikes and replaced it with NaN values. We can then interpolate 
these NaN values using the NaN Removal process to repair the volume. 

For this situation, we use the logic that if values in volume v1 are greater than 900 (or a 
more suitable extreme number for the volume) replace it with NaN, if not use v1 (input 
values). 

1. Open the Process tab and click the "+" button to add a New Process. Search and select 
Volume Maths. 

2. Type in a name for this Volume Maths process. 
3. In the Volume Maths panel, click the "+" button and select the abnormal volume. 
4. In the Formula text box, enter the formula: if (abs(v1) > 900, NaN, v1). 
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To crop on specific high min and max values, use the logic that if input volume v1 is greater 
than 75 (or a suitable max value) OR if v1 is less than -75 (or a suitable min value), replace 
with it NaN, othewise use v1 (original value). 

1. Add formula if (v1 > 75 || v1 < -75, NaN, v1) in the Formula text box of the Volume Maths 
panel. 
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Interpolate NaN values using the NaN Removal process. 

1. In the Process tab, click the "+" button and add a new process. Search and select NaN 
Removal. 

2. Type in a name for this NaN Removal process. 
3. Under the NaN Removal panel, select the volume created from the above Volume Maths 

process in the Volume text box. 
4. Select Linear Interpolation from the Action drop box. Read more about NaN Removal 

process. 
5. A volume is created and is available in the Volume tab. 
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When should I choose a Dip filter over an F-K 
filter? 
Both processes remove linear noise but there are some circumstances in which one works 
better than the other: 

• F-K can filter on certain frequencies. This helps when noise occurs within a specific 
frequency range. 

• F-K tends to work better when spatial resolution is poor. 
• Dip filter works better if there is aliasing in the F-K domain. 

 

Read more aboout F-K Transform and Dip Filter. 
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Synthetics 
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How do I scale synthetic trace relative to 
seismic? 

In addition to the wavelet scalar, the display of the synthetic trace in section view is 
determined by two main factors: 

1 - The min/max values of the Class colourbar 

Note: The synthetic trace automatically inherits the same Class as the volume you are 
comparing it to. 

2 - The display width of the well track 
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Note: The edges of the well track represent the min/max values of the colourbar (i.e. if your 
synthetic trace has amplitudes -100 to +100 and you also set the min/max colourbar values as 
-100 to +100, then the maximum peaks and troughs should just hit the edges of the well track). 

Workflow 
Please follow these four steps for scaling of your synthetic trace: 

1. Set the wavelet scalar such that it matches the seismic trace in the synthetic view. 
2. Set the Class min/max values such that the peaks/troughs of the synthetic trace are just 

inside the edges of the well track in section view: 

3. Set the volume to Use min and max from class setting: 
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4. You may now wish to adjust the Display Width of the well track depending on the zoom 
level in the section view: 

The display of the seismic traces is zoom dependent. The display of the well logs is zoom 
agnostic. Therefore there will likely always be some necessary tweaking of the well track display 
width. You may also find it useful to deselect Use min/max from class for the volume and 
adjust the min/max display of the volume (using F5/F6) independently to the synthetic trace. 
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How do I find the RMS amplitude for a single 
trace over a given time window? How do I do 
this with a synthetic? 

For a single trace from a volume 

1. Go to the Process tab and create a new Probe. Type a name for this probe e.g. 
"OneTraceProbe". 

2. Set the IL/CL size manually in the details panel. Use the same value for min and max for 
each extent. 
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3. While still in the Process tab, create a Volume Sculpting process and type a name for it e.g. 
"OneTraceVolume". 

4. Select your volume in the Input Volume text box. 
5. Select the earlier created probe (e.g. "OneTraceProbe") for the Constrain to area option and 

choose Based on Survey location. 
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6. Next, create a Volume Interpolation/Extrapolation process. 
7. Select the Input Volume as the one created from the Volume Sculpting process e.g. 

"OneTraceVolume". 
8. Tick the Extrapolate checkbox. 
9. For Extents, select a small arbitrary area around the probe, approximately 20 x 20 traces. 

10. In the Map View, click the Operations tab on the right and select Amplitude Extraction in 
the Operations dropdrop box. 

11. Set the interval to analyse by entering a top and base (constant) time, or by choosing 
horizons. 

12. Choose your created volume from the Volume Sculpting process e.g. "OneTraceVolume" for 
the Volume option. 

13. Select Property as "RMS". 
14. Click the Run button. 
15. Set the class to "RMS" and click the "Create New" button. 

The map view will return a single result for the extrapolated area containing the RMS (or other 
property) for the single trace. 
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For a synthetic trace from a well 

To generate the volume for the synthetic trace: 

1. Go to Tool > Synthetics to configure the well in the Synthetics window. 
2. Click the Well tab and select the input well curves for the synthetic: P Slowness, S Slowness 

and Density. 
3. Select the Angle, Wavelet, and Stack parameters in the Synthetics tab. 
4. Confirm that a synthetic is generated! 
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5. Go to the Model tab and create a new arbitrary window Model. Type a name for the model 
e.g. "simpleModel". 

6. Select TWT domain for the Vertical dimension of model setting. It does not require any 
windows or layers. 
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7. Go to the Process tab and create an LF Model (Ghost Horizon...) process. Name the 
process e.g. "Synthetic Extrapolation". 

8. Select the earlier created Model as the  Layer horizons e.g. "simpleModel". 
9. In Output Extents, pick a small arbitrary area around the well, approximately 20x20 traces. 

10. Set the TWT sampling to 2 or 4ms (match the rate of the seismic). 
11. Select Type of well curves as "Any one curve". 
12. Select the well and the "synth: (near)" synthetic trace - If the trace isn't listed, confirm that the 

synthetics are configured correctly (from step 1). 

13. In the Map View, click the Operations tab on the right and select Amplitude Extraction in 
the Operations dropdrop box. 

14. Set the interval to analyse by entering a top and base (constant) time, or by choosing 
horizons. 

15. Choose your created volume from the LF Model process e.g. "Synthetic Extrapolation" for the 
Volume option. 

16. Select Property as "RMS". 
17. Click the Run button. 
18. Set the class to "RMS" and click the "Create New" button. 
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Spectra Analysis 
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Why does the amplitude spectrum not show 
deeper peaks and troughs as expected? 

When trying to display the seismic amplitude spectra using Spectra Analysis, you may 
notice that the resulting wavelet does not resemble a typical spectrum. 

This is because the frequency spectrum generated is, by default, smoothed to give you a better 
picture. This setting can be changed by clicking the spanner icon and disabling the Smoothing 
enabled check box (see also Configuring View Settings). 

This should reveal the deeper peaks and troughs that is expected (see image below). 
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Kingdom 
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Why does my Kingdom survey appear with a 
different spacing in Insight? 

The survey "bin spacing" displayed by Kingdom is based on the survey's increment, 
whereas the spacing displayed by Insight is based on a "single" IL/CL. 

Note: In Insight, a 3D survey has no increment or extents — it just represents the 
geometry. The increment or extents are defined in the volume (in Kingdom, this is called 
"data type"). This means that many volumes with different extents can easily be loaded into 
Insight without having to define multiple surveys. 

For example, take the following 3D survey as defined in Kingdom: 

                    Min Value    Max Value    Increment 
  Inline:           1001         2001         10 
  Crossline:        3001         4001         5 
  Bin spacing (m):  Inline:  200     Crossline:  100 

When loaded into Insight, it will appear as: 

   IL spacing:   20 (m) 
   CL spacing:   20 (m) 
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How do I import a Kingdom polygon to use 
in Insight? 

Kingdom polygons are not stored in the Kingdom database and thus will not appear in the 
Manage Remote Resources window when using the Kingdom Reader. 

To import a Kingdom polygon, open the Import menu in the Control Panel, select Polygons 
and change the file type to the Kingdom Planimeter Polygon format (.plg). 

Import polygon 

1. From the Control Panel, click on the Import menu and select Polygons. 
2. In the Import Polygon window, change the Files of type to Kingdom Planimeter Polygon 

format (*.dat, *.plg). 
3. Browse to the polygon that was exported from Kingdom and click Open. 
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Exporting a Kingdom SQL Database to 
Access 

If you have a Kingdom project stored as a Microsoft SQL database, you could convert it to 
an Access database to avoid all the requirements of an SQL database, including being able 
to access your data on Linux/Mac. Follow the steps below to export an SQL database to 
Access by using either Kingdom's Database Admin Tool or Microsoft SQL Server's Import 
and Export Wizard. Attached is an empty Access database file that you would need if you 
are using the second method. 

Export using Kingdom's DB Admin Tool 
If you have Kingdom installed on your computer, you can access the Database Admin Tool that 
comes with Kingdom to create a database dump file and a dummy Access project, and do a 
database dump from SQL to Access. 

 Notes: 

• If your SQL database (mdf and ldf files) is larger than 2GB, it will be too large to dump 
into an Access database. 

• To work with an Access database, a 32-bit Kingdom DB Admin Tool is required. If you 
have a 64-bit Kingdom, you will need access to a 32-bit Kingdom. 

 empty.mdb 
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Open Kingdom's DB Admin Tool 

1. At the Start menu, click on All Programs. 
2. Open the Database Admin Tool under the Kingdom Software. 
3. From the Database menu, click Connect to connect to the project database. 
4. Select DB type (Auto/Manual SQL) and select the Kingdom project’s .tks file. 
5. The database should appear in the main window. Highlight the database. 
6. At the Project menu, select Export to file. This will create a database dump file 

(export.dmp). This file will have all the information from your SQL database file. 
7. Then, create a dummy Access project with Kingdom, this will create an empty Access 

database (.mdb). 

Import from file 

To import the database dump file into the dummy Access project: 

1. From the Database menu, click Connect to connect to the Access database. 
2. Select Access and navigate to the Access database file (.mdb). Select the project's .tks file. 
3. The database should appear in the main window. Highlight the database. 
4. At the Project menu, select Import from file. 
5. Import the database dump file (export.dmp) into the new Access database. You will now have 

all the information from the SQL database in an Access database. 

Proceed to Insight and Kingdom Overview to begin linking your Access database with Insight. 
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Export using SQL Server Import/Export Wizard 
If you do not have Kingdom, you can also convert an SQL database to Access by using the SQL 
Server Import and Export Wizard. To begin: 

1. Download the empty Access database file attached at the top of this article (empty.mdb) and 
copy it to your Kingdom project directory. 

2. Rename the Access database <project_name>70sav.mdb to adhere to Kingdom's naming 
convention for inactive Access databases. This will help remove any confusion about which 
database Kingdom will use (the SQL database will remain as the project's active database) as 
Kingdom does not allow users to select when opening a project. 

 Notes: 

• To work with an Access database, a 32-bit SQL Server Import and Export Wizard is 
required. To install the 32-bit version, select either Client Tools or SQL Server Data 
Tools (SSDT) during setup. 

• Also, the SQL Server Import and Export Wizard is only available in SQL Server 2008 
and newer versions. 

Open SQL Server Import and Export Wizard 
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1. Click the Start button to access the Start menu. 
2. At the Start menu, click on All Programs and expand the Microsoft SQL Server 20XX folder. 

Click on Import and Export Data to open the Import/Export wizard. 
Alternatively, you can access the wizard from SQL Server Management Studio by right-
clicking on a database, selecting Tasks and click Import/Export Data. 

3. Click Next to proceed. 
4. In the Choose a Data Source page, choose SQL Server Native Client as your Data Source 

and complete the following: 
• Server name — Type the name of the server or choose from the drop-down list. 
• Use Windows/SQL Server Authentication — Choose whether the wizard should use 

Windows or SQL Server Authentication to log in to the database. If you choose SQL 
Server Authentication, input a User name and Password. 

• Database — Select from the list the database you wish to export. 
• Refresh — Click to restore the list of available databases. 

5. Click Next. 

6. In the Choose a Destination page, select Microsoft Access as your data destination and 
complete the following: 
• File name — Browse and select the empty Access database file (empty.mdb) given in this 

article. 
• User name & Password — Leave these blank. The empty database does not require any 

kind of authentication. 

7. Click Next to proceed. 

Page 342FAQ



8. Select Copy data from one or more tables or views and click Next. 

9. In the Select Source Tables and Views window, select all tables by clicking on the top left 
check box. 

10. Click Next to review data type mapping. 
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11. At the Review Data Type Mapping page, select Ignore from the drop-down list at On 
Truncation (global) to allow the wizard to ignore any truncation and continue the process. 
By default, this is set to Fail. 

12. Click Next to proceed with the rest of the settings. 
13. Once the export is successful, you will have all the information from the SQL database in the 

Access database. 
14. Save the package and set your preferred protection level. 

This process only creates an Access database for use with Insight. It does NOT convert the 
Kingdom project itself to Access. Any changes made in the Kingdom project after this will 
render the Access database out-of-date and the user must then repeat this process. 

 Note: The SQL Server Import and Export Wizard tool is NOT part of Insight. As such, 
please make sure to check that your data is unaffected after completing this process. 

Proceed to Insight and Kingdom to begin linking your Access database with Insight. 
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How to get interpretation into Kingdom 

This is a quick reference guide of the formats best suited to transfer data into Kingdom. 

To transfer data from a Kingdom database, see Insight and Kingdom Overview. 

Note: This guide is given in “good faith”, information here is based on experience from our 
users. You may still need to edit your files between software. 

Horizons into Kingdom 

Option 1 

In general, we recommend exporting horizons from Insight as X/Y/TWT grids and importing 
them into Kingdom as a grid. You can then use Kingdom's Grid to Horizon feature to convert 
these grids to editable horizons. 

To export horizons for import into Kingdom, select Export customised text file when 
importing from Insight and export X, Y, TWT/TVD. 
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Option 2 

There is a second option, which is technically more difficult, but potentially more reliable: 

• The reason for the enhanced difficulty is due to the fact that Insight handles 2D data in 
relation to CMPs, where as Kingdom handles 2D data in relation to SPs. 

• Export your Insight horizons as a customised text file with the following format: 2D Line 
Name, CMP, TWT. 

• If you are sure of the SP–CMP relationship, you could then edit this file (in MS Excel or 
likewise), changing the CMPs to equivalent SPs, and then import into Kingdom directly as a 
horizon using the format 2D Line name, Trace (SP), TWT. 

• The horizon interpretation data should then be located directly on to the corresponding 2D 
Survey in Kingdom (assuming all line names are the same). 

Faults into Kingdom 
Fault surfaces are exported from Insight in Geoquest/IESX format. 
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At the Import fault surface dialog in Kingdom, specify these as Assigned Fault Lines in a 
Named Fault and choose the input format GeoQuest IESX v.11, and then assign them to a 
survey. 

Unassigned fault sticks are also exported from Insight in Geoquest/IESX format and can 
subsequently be imported to Kingdom in a similar way. At the Import fault surface dialog in 
Kingdom, specify that these are Unassigned Fault Lines and choose the input format 
GeoQuest IESX v.10.x, and assign them to a particular survey. 

 Note: Insight operates in XY space. This can cause problems importing 2D faults as 
Kingdom requires 2D survey data that is not available in Insight. The best way to get 
around this is to create a dummy 3D survey in Kingdom and import the faults as 
Geoquest IESX  V10. 
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SQL Server versions and backwards 
compatibility 

Microsoft SQL Server can attach databases from older versions, but not newer versions. For 
example, SQL Server 2008 can attach a database that was detached from the 2005 version, 
but not one detached from the 2012 version. 

However, when attaching a database from an older version, the database is upgraded to 
the current server version. That is, after a 2005 database is attached to SQL Server 2008, it 
can no longer be attached to SQL Server 2005! 

Since some Kingdom releases include older SQL Server versions, it is possible that Kingdom 
may not be able to use the database after attaching it to a newer version. Therefore, if there is 
any chance the project is going to be used in Kingdom in the future, it is recommended to 
create a backup of the project database before attaching it for use with Insight. 

To backup the project database: 

1. Find the .MDF and .LDF file (usually in the "Project Database" folder within the project) 
2. Make a copy of the files 
3. Rename the files to .MDF.BAK and .LDF.BAK 
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Installing MS SQL Management Studio 

For troubleshooting purposes, Kingdom projects in Auto SQL Server Express (SSE) mode 
can be manually attached to the SQL Server Management Studio. Follow the steps below to 
download and install Microsoft SQL Server Management Studio. 

Upon successful installation, see Manually Attaching Kingdom Database from an Auto SQL 
Server Express (SSE) Project to attach the Auto SSE Kingdom database manually. 

Download and install 

1. Open your preferred browser. 
2. Download Microsoft SQL Server Management Studio Express from

http://www.microsoft.com/en-us/download/details.aspx?id=29062. 
3. Choose your language and click Download. 
4. Select the ENU\x64\SQLManagementStudio_x64_ENU.exe check box to only download the 

Management Studio for 64-bit operating systems. 
• For 32-bit operating systems, select ENU\x86\SQLManagementStudio_x86_ENU.exe. 
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 Note: If you do not have SQL Server 2012 installed on your machine, select ENU\x64\
SQLEXPRWT_x64_ENU.exe (or ENU\x86\SQLEXPRWT_x86_ENU.exe for 32-bit) to 
download and install both SQL Server 2012 and Management Studio in a bundle. 

5. After the download is completed, run the .exe file as Administrator. 
• If there is no option to run it as Admin, open your Start menu, type "cmd" in the Search 

bar, right-click and run cmd as administrator. 
• At the command prompt, enter the file path of the .msi file (i.e. C:\Users\Guest\

Desktop\SQLManagementStudio_x64_ENU.exe) and press Enter. 
• Click Run. 

 Note: If you are unsure about how to use the command prompt, please consult your IT 
Department for help. 

6. In the Installation Center, click on New SQL Server stand-alone installation to add 
features to an existing SQL Server 2012 instance. 
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7. Read and accept the License Agreement. 
8. Click Next. 
9. At the Product Updates window, click Next to install the setup files. 

8. After the setup files finish installing, select to Add features to an existing instance at the 
Installation Type window. 
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9. Click Next to proceed to Feature Selection. 

10. To install the Management Studio, select the Management Tools - Basic check box. 
11. When you are ready, click Next. 
12. At the Error Reporting window, skip the option to send information to Microsoft (optional), 

and click Next to begin the installation. 
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13. When the installation is completed, click Close. 
14. Right-click and run Microsoft SQL Management Studio Express as Administrator from the 

Start menu. 
15. Choose the Server and Authentication that was specified in Downloading and Installing SQL 

Server. 

Proceed to Manually Attaching Kingdom Database from an Auto SQL Server Express (SSE) Project to 
attach the Auto SSE Kingdom database manually. 

 Note: If you are having trouble connecting to the instance, it could be because of 
restricted permissions of the database files or a folder leading to the database files. 

Feel free to contact us at support@dugeo.com if you have any queries. 
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Petrel 
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How Insight detects the Petrel installation 

When you run the installer, the Setup Wizard will automatically check if Petrel is installed in 
your machine. The way it does that is by running a "set" command and searching for the 
Ocean201XHome environment variable. 

If you have multiple versions of Petrel installed on one machine, Insight will install the 
plugin to all detected Petrel versions. 

If the installer detects that variable, it will give you the option to install the Petrel Link during 
the setup (see Downloading and Installing Insight on Windows). 
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Petrel environment variable 

If Petrel is installed in your machine, but the system is unable to detect the Ocean201XHome 
line, the system variable name or path might be different. To check and/or change the variable: 

1. From the Start menu, open the Control Panel. 
2. Click on System and Security and then click on System. 
3. On the left sidebar, select Advanced system settings. 
4. In the System Properties window, click on Environment Variables. 
5. Look for the variable that is registered when Petrel was installed. 
6. Click Edit to change the path stored in a variable: 

• Update the path to match the Petrel installation directory. 
• Click New to add a new variable (and path), if your current Petrel version is not listed. 

7. Run the installation again. 

 Note: If there are multiple versions of Petrel installed in the machine, Insight will find 
all versions of the Ocean201XHome environment variable to install the Petrel Link. 

Genuine offer of assistance 
If you are still unable to install or connect using the Petrel Link, please do not hesitate to 
contact our support team at support@dugeo.com. 
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How do I send the Petrel message log? 

If you are experiencing problems working in Petrel with Insight, sending us your Petrel 
message log could help give us a better idea as to the nature of the problem. 

Follow the steps below to enable Petrel's message log, and copy the text inside. 

1. In Petrel, go to the Home tab. 
2. Click Panes. 
3. Click on Message Log and make sure that it is toggled on. 
4. Locate the Message Log window. 
5. Click on the Copy all text to the clipboard icon (second icon from the left at the top of 

the Message Log window). 
6. Open your email and compose a new email. Address the email to support@dugeo.com. 
7. In the main body, right-click and select Paste, or press Ctrl + V on your keyboard to paste 

the text. 
8. If you have a support number, please indicate it in the subject. Write a brief description of 

the issue. 

The more we know about the problem, the easier it is for us to help you! 
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How do I export polygons from Petrel to 
import into Insight? 

DUG Insight can load IESX format polygon files that have been exported from Petrel. 

Export Polygon 
Right click on the polygon in the Petrel navigation tree and select Export. 

Polygons should be exported as IESX fault polygons (ASCII) with a .dat or .iesx extension. 

Import Polygon 

1. From the Control Panel, click on the Import menu and select Polygons. 
2. In the Import Polygon window, change the Files of type to GeoQuest IESX format. 
3. Browse to the polygon that was exported from Petrel and click Open. 
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How do I manually remove the Petrel Link? 

Newer versions of Insight are bundled with a compatible version of the Petrel Link during 
installation. If you already have the Petrel Link installed for an older version, that version 
will no longer work and needs to be manually removed before you install the new version. 
You can uninstall older versions of the Petrel Link manually from your computer's Control 
Panel or via Petrel's Ocean Plug-in Manager. 

Uninstall via Control Panel 

1. From your desktop, open the Start Menu and select Control Panel. 
2. In the Control Panel, click Uninstall a program under Programs. 
3. Locate the DUG Insight Petrel Link and double click to begin uninstalling. 
4. Alternatively, select the link and click the Uninstall/Change button above the list of 

programs. 
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Uninstall via Ocean Plug-in Manager 

1. In Petrel, open the Help menu. 
2. Click on Ocean Plug-in Manager. 
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3. In Ocean Plug-in Manager, you should see the DUG Insight Link in the list of installed plug-
ins. 

4. Click on DUG Insight Link to expand the plug-in. 
5. Check the version you would like to remove and click Uninstall. 
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"Error opening file for writing" when 
installing Petrel Link 

When you install Petrel for the first time, your machine will register Ocean2013Home at the 
installed location. Any plugins (including the Petrel Link) that you attempt to install will 
automatically look for that path.  

Error message 

The error message above will appear when the system is unable to find the registered path to 
write the required files to. This can occur if you have copied/moved the installed folder to 
another location or if you have re-installed Petrel at a different path. 
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Changing the environment variable 

To changed the registered path: 

1. From the Start menu, open the Control Panel. 
2. Click on System and Security and then click on System. 
3. On the left sidebar, select Advanced system settings. 
4. In the System Properties window, click on Environment Variables. 
5. Look for the Ocean2013Home system variables and select Edit. 
6. Type the path where Petrel is now located and click OK. 
7. Run the installation again. 
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How do I send horizon attributes / 
amplitude extractions to Petrel? 

Horizon attributes can be sent to Petrel directly using the Petrel Link (see Insight and Petrel 
Overview) by following the steps below. 

When a horizon attribute such as an extracted amplitude is generated, the resulting 
horizon or horizon property is not defined in time or depth (see Horizon Amplitude Extraction 
and Single-Horizon Amplitude Extraction). It can only be viewed in Map View. However, the 
Petrel Link is only able to transfer the elevation aspect of a horizon (i.e. TWT or TVDSS 
property). It is important to recognise the distinction between horizons (in IL/CL) and 
surfaces (in X/Y) in Petrel. 

In order to send horizon attributes (in this example, the extracted amplitude) to Petrel, you 
can assign the amplitude values as a TWT property, and then transfer it to Petrel as a 
regular surface. 

Workflow 
1. First, regrid the horizon to X/Y and choose to Save As New Horizon (see Regrid). A new 

horizon will be created in the Horizon tab with the suffix 'XY' (i.e. Horizon XY). 
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2. Then, use the Horizon Maths operation to assign a Z dimension to the amplitude values of 
the new horizon (see Horizon Maths). 

3. Select the new XY horizon and input property as Amplitude. 
4. Assign the Output Z dimension as TWT. 
5. Click Run and select to Create New horizon. A new horizon will be created in the Horizon 

tab (Result:Horizon Maths). 
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6. Right click on the resulting horizon and select Send to Petrel. 

Once transferred to Petrel, you can change its template to suit amplitude values. It would then 
be possible to drape this regular (amplitude) surface over the equivalent TWT horizon in Petrel. 
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Why is the Petrel Link showing me a 
different project after connecting? 

Question: I have the Petrel Link installed and I managed to connect to Petrel from Insight, 
but the project that appears is not the one that I have opened. Why is this happening and 
how do I connect to the correct project? 

Answer: The Petrel Link will automatically detect and connect to an open Petrel project. 
However, it can be confused if multiple Petrel projects are open at the same time. In this case, it 
is best to only have one Petrel project open at a time. 
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How to get interpretation into Petrel 

This is a quick reference guide of the formats best suited to transfer data into Petrel. 

Insight also supports connections to Petrel using the Petrel Link. This is a separate module 
that enables users to establish a bi-directional link to view, edit and transfer objects 
between Insight and Petrel. For more information, see Insight and Petrel Overview. If you are 
interested in attaining this module, contact our sales team at sales@dugeo.com. 

Tip: You can also send interpretations to Petrel by using Insight's context menu, see Send 
an Item to Petrel. 

Horizons into Petrel 

Horizons in Insight can be exported as a simple customised text file with columns (X/Y/IL/CL/Z 
or X/Y/IL/CL/Attribute) that can then be modified for import into Petrel. 

1. In Control Panel, Horizon tab, right click horizon 
2. Choose Export>>Export customized text file. 
3. Select relevant data columns. 

For more information, see Horizon Export Formats. 
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In Petrel, select General lines/points (ASCII) format when importing a horizon. 

Make sure your columns are mapped properly, and to select the correct Z data type and 
Coordinate Reference System (CRS). 

See also How do I send horizon attributes / amplitude extractions to Petrel? 

Faults into Petrel 

Fault surfaces are exported from Insight in Geoquest/IESX format. 
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1. In Petrel, select the IESX fault sticks (ASCII) format when importing a file. 
2. If you do not have a CRS defined, you will be prompted to choose a CRS or continue spatially 

unaware. 
3. Make sure to select the correct Domain and CRS in the Input Data window. 
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Polygons into Petrel 

1. In DUG-Insight - Export polygons in IESX/Geoquest format 
2. Importing into Petrel - select IESX Fault Polygon and choose Generic boundary polygon 
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How do I transfer an on-the-fly horizon to 
Petrel? 

To transfer an on-the-fly horizon (e.g. TWT in depth, extracted amplitudes) to Petrel, first 
output the values to a new horizon. 

This example shows how to transfer TVD values from on-the-fly depth-conversion to Petrel. 

Note:  Ensure a velocity model is configured for depth conversion (see How it Works: Time-
Depth Conversion). The Petrel link must be connected to transfer horizons and/or faults (see
Insight and Petrel Overview). 

Use horizon maths to output the depth values to a new horizon. 

1. In the Map View > Operations tab, choose Horizon Maths. 
2. Add a horizon row. 
3. Use the default symbol: 'h1'. 
4. Select the TVDSS property. 
5. Use the formula: h1 
6. Click Calculate. 
7. Click Create 
8. Rename the new horizon, e.g. “TVD Result” 
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Push the new horizon to Petrel using the link. 

Send to Petrel 

1. In the Horizon tab, right-click the horizon: “TVD Result”. 
2. Select Send to Petrel. 
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How do I transfer depth-converted faults to 
Petrel? 

Depth-converted faults can be transferred to Petrel, e.g. TWT faults as TVD, or TVD faults 
as TWT. 

The process: 

1. Export the faults in the converted domain 
2. Import the faults back to Insight 
3. Transfer the imported faults to Petrel 

Note: Ensure a velocity model is configured for depth conversion (see How it Works: Time-
Depth Conversion). The Petrel link must be connected so that horizons and/or faults can be 
transferred (see Insight and Petrel Overview). 

Exporting Faults to depth 

1. Go to the Fault tab and right-click the fault. 
2. Select Export 'Fault'. 
3. In the Export as dropdown box, select TVDSS (m). 
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4. Click OK. 

Importing Converted Faults 

1. In the Import menu and select Faults.... 
2. Select the exported fault file from the previous step 
3. Select the correct domain from the previous step, e.g. TVDSS (m) 
4. Click OK. 
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Send to Petrel 

1. Go to the Fault tab and right-click on the imported fault. 
2. Select Send to Petrel. 
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Miscellaneous 

Page 377FAQ



How to upload to our FTP server? 

If you are having problems converting SEG-Y data into dugio format, or if we require more 
information from you regarding your database, it might be better for you to send us your 
data so that we can get a better look at what is causing the error. If your data is too big to 
send via email, you can upload it to our FTP either by using an FTP client (i.e. FileZilla) or by 
using Internet Explorer. Follow the steps below for both methods. 

Note: We understand that the contents of any data sent to us are confidential and intended 
for testing and bug fixing purposes only. Under no circumstances will the data be shared or 
distributed to anyone other than those necessary to solve your problem. You have our 
promise that we will safeguard your data to the best of our ability. Once we have solved the 
problem and closed the support ticket, your data will be removed from our system. 

Uploading via FTP client 

If you have an FTP client like FileZilla, transferring files is a simple three-step process. 

1. Open FileZilla from your desktop or Start menu. 
2. Type in the following at the top and click Quickconnect. 

• Host: ftp.dugeo.com 
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• Username: upload 
• Password: upload 

3. Drag and drop the relevant files into the upload folder. 

Send us an email at support@dugeo.com to let us know that you have successfully uploaded 
the file(s) into the folder, and include the name of the file(s) in the email. 

 Note: The folder will still appear empty after transferring the files into the folder. You 
can verify that the transfer was successful by looking at the Successful transfers tab 
at the bottom of the window. 

After the problem has been identified, we will revert back to you and send you the usable data. 
See How to download, unzip and load volumes and surveys into Insight? to download and load the 
files into your Insight project. 

Uploading via Internet Explorer 

Alternatively, you can also access our FTP using Internet Explorer. This method does not require 
you to have an FTP client installed. 

1. From your desktop or Start menu, open Internet Explorer. 
2. In the address bar, type ftp://ftp.dugeo.com and press Enter (or click on the link). 
3. Enter "upload" as the username and password, and click Log on. 
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4. The FTP root page should appear with instructions to press Alt, click View and select Open 
FTP Site in File Explorer. 

5. The File Explorer window will appear and you are required to log in again. 
6. Type in the same username and password as before and click Log on. 

7. Open the upload folder 
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8. You can now drag and drop your files into the upload folder. 
9. Send us an email at support@dugeo.com to let us know that you have successfully uploaded 

the file(s) into the folder, and include the name of the file(s) in the email. 

After the problem has been identified, we will revert back to you and send you the usable data. 
See How to download, unzip and load volumes and surveys into Insight? to download and load the 
files into your Insight project. 
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How to download, unzip and load volumes 
and surveys into Insight? 

If you have sent us your data for testing and bug fixing (see How to upload to our FTP server?), 
we will revert to you once we have identified and solved the problem. A download link to 
the .zip file containing the usable data will be sent to you. Follow the steps below to 
download, unzip and load the data in Insight. 

Note: We understand that the contents of any data sent to us are confidential and intended 
for testing and bug fixing purposes only. Under no circumstances will the data be shared or 
distributed to anyone other than those necessary to solve your problem. You have our 
promise that we will safeguard your data to the best of our ability. Once we have solved the 
problem and closed the support ticket, your data will be removed from our system. 

Download and extract 
1. Download the .zip file as provided by DUG's support team. 
2. When the download is completed, locate the .zip file from the download folder. 
3. Double click and extract the contents using WinZip or any similar software. 
4. If you have been sent a volume, the .zip file should contain a folder with the .dugio 

extension. Copy or extract the folder into your project directory's 100sei folder. 
5. If you have been sent a survey, the .zip file should contain a file with the .survey extension. 

Copy or extract the file into your project directory folder. 
Note: You can choose a different location for the survey file. However, we generally 
recommend placing it in the project directory for convenience. 

Page 382FAQ



Loading in Insight 

Import survey: 

1. From Insight's Control Panel, click on the Import menu and select Surveys. 
2. Navigate to the location you copied the survey file and click Open to import. 
3. The survey will now be loaded in Insight. 

 Note: You must add a survey before adding any volumes. 

Import volume: 

1. To load the volume, click on the Import menu and select Volumes. 
2. Navigate to the .dugio volume you downloaded and click Open to import. 
3. The volume will now be loaded in Insight. Click on the View menu and select any section 

view to display the volume on the survey. 
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Exporting GeoTiff files from Petrosys into 
Insight 

GeoTiff files can be exported directly from Petrosys to be loaded into Insight (see Load 
Culture Files and Import Culture Files). 

When exporting the GeoTiff file from Petrosys, make sure to select the Affine only option in the 
TIFF Image Output Options window. 

This will allow the embedded positional information (coordinates) of the GeoTiff file to be 
exported from Petrosys and loaded into Insight alongside the GeoTiff file. 
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How do I get my data stored in a third-party 
database into DUG Insight? 

There is limited support in DUG Insight for loading directly from certain databases. Please 
contact us at support@dugeo.com to find out about your specific situation. 

Generally, the Petrel Link and Kingdom Link can be used to transfer data into an Insight 
project. These are available via additional modules. Petrosys projects can use the Petrosys 
Link, please contact Petrosys for more information on this feature. The Petrosys link is NOT 
supported via the DUG support team. 

Volume data can be exported as SEG-Y files (see Exporting a Volume to SEG-Y); horizons or 
faults as GeoQuest CardImage 7 files; well data can be bulk exported as OWX files and then 
loaded into DUG Insight. A full list of formats Insight supports can be found here. 
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Where are the old Insight user manuals? 

Should you require any assistance with an older version of Insight, you can download the 
PDF of the manuals by clicking on the links below. 

• Insight 2.9 — http://downloads.dugeo.com/insight/DUG+Insight+2.9+User+Manual.pdf 
• Insight 3.0 — http://downloads.dugeo.com/insight/DUG_Insight_3.0_User_Manual.pdf 
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Where can I find the manual for older 
versions of the software (e.g. Insight 3.1)? 
Older versions of the manual are available in PDF format for you to download and read (or 
print!). Please click on the link below for the correct version of the manual: 

• DUG Insight 3.1 
• DUG Insight 3.0 
• DUG Insight 2.9 
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I have a great idea for Insight! How do I send 
DUG my suggestions? 

If you have an awesome idea that would revolutionize Insight, or know of a feature that 
would drastically improve Insight's functionality, we would like to hear from you! 

Please, tell us all about it! 

1. In Insight's Control Panel, go to the Help menu. 
2. Click Send Feedback/Ideas. This will open the online feedback form in your default 

browser. 
3. In the online feedback form, type your suggestion or queries in the Comments box. 
4. Type your Name, Company and Email for DUG to contact you. These are optional fields. 
5. Click Submit. 
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Insight Error Messages 
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Display driver has stopped responding. 
What should I do? 

This is a common error message that occurs with any NVIDIA card on any Windows 
operating system. When the computer detects that your graphics card is not responding, 
the screen goes black for a few seconds followed by the pop-up box below, and the 
software utilising the graphics card would stopped working. 

Error message 

The cause of this error is not an obvious one. It could be a corrupted or outdated graphics card, 
power supply, ram or overheating. If this error persists, follow the steps below to troubleshoot. 

 Note: If, at any time, you are not familiar or are uncomfortable performing any of the 
solutions below, please consult your IT department. 
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Turning off power management 

1. Open your Control Panel from the Start menu and click on Hardware and Sound. 
2. Click on Power Options. 
3. At Preferred plans, click on High performance to choose it as your preferred plan. 
4. Click on Change plan settings for High performance and select Change advanced power 

settings to display the advanced settings. 
5. Scroll down and expand PCI Express. Turn off the Link State Power Management setting. 
6. Click Apply to save the settings and click Ok to close the window. 

If you are still experiencing this error, there are several other ways that might fix the problem. 
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Update display driver 

1. Open your Control Panel from the Start menu and click on Hardware and Sound. 
2. Under Devices and Printers, click on Device Manager. 
3. Expand the Display adapters. Right-click on the graphics card and select Update Driver 

Software. 
4. Select Search automatically for updated driver software. 
5. Update to the latest driver software. 
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Update Windows 

1. Open your Control Panel from the Start menu and click on System and Security. 
2. At Windows Update, click Check for updates. 
3. If there are updates to be installed, click Install updates to begin installing. 

RAM and overheating 
If the error does not go away, it could be a faulty RAM or your display drivers are overheating. 

• To check your RAM, simply remove all the RAM sticks except one and see if it fixes the 
problem. Repeat this until you have found the faulty RAM stick. If the error happens no 
matter which RAM stick you put in, that means the RAM is not the problem here. 

• To check the temperature of your display driver, you can download any PC hardware 
monitoring program. If you find that the temperature increases rapidly when using a graphic 
intensive software, you can either try cleaning the driver's cooling fan or installing new fans. 

 Note: If you are not familiar or are uncomfortable performing any of the solutions 
above, please consult your IT department. 

Genuine offer of assistance 
If the problem persists, or if you have any questions, feel free to contact our support team at 
support@dugeo.com. 
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Installation of Insight failed! What should I 
do? 

If the installation of Insight is unsuccessful, the error message below will be displayed. 

Error message 

This error could be due to a number of reasons. 

It would be a great help in diagnosing the problem if you could run the installer with extra 
logging enabled, as described below. This will create a log text file that will tell us exactly what 
was going on during the installation. 
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Installing with logging options 

1. From the Start menu, type "cmd" and open the Windows Command Processor. 
2. In the command window, navigate to the folder where the installation file (.msi) resides. 
3. To run the installer with logging options, type the following: 

msiexec /i DUG_Insight-4.x-xxxxxx_x64.msi /lvx* log.txt 

Note: Change the version number as necessary. 

4. Press Enter and run the installation again. The log file will document all activity by the 
installer, including the moment it failed and the error code. 

5. Send us a support ticket by emailing support@dugeo.com describing how and when the 
problem occurred, your system specifications, and attaching the log file. 
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Out of memory error 

Error message 

What it means 
This error means that the memory you have initially assigned to Insight before opening a 
project is insufficient. 

See Allocating Memory for more details on allocating memory for Insight. 

 

Genuine offer of assistance 
If the problem persists, or if you have any questions, please contact our support team at 
support@dugeo.com. 

You may be asked to send data of your session from the Logs window for a clearer picture of 
what happened when the error occurred (see Viewing and Sending Diagnostic Logs). 
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Error launching Insight on 32-bit Windows 
machine 

Error messages 
If you are running on a 32-bit Windows machine, you might encounter the following errors 
when launching Insight: 

• Error occurred during initialization of VM. 
• Could not reserve enough space for object heap. 
• Could not create the Java virtual machine. 

What it means 
On a 32-bit Windows operating system, you cannot reliably allocate more than approximately 
700MB of memory for a single application in the DUG Insight Launcher. This is a fundamental 
design defect of 32-bit Windows. To solve this problem, reduce the memory allocation or 
upgrade to a 64-bit Windows operating system. 

Genuine offer of assistance 
If the problem persists, or if you have any questions, please contact our support team at 
support@dugeo.com. 

You may be asked to send data of your session from the Logs window for a clearer picture of 
what happened when the error occurred (see Viewing and Sending Diagnostic Logs). 
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SQL database does not exist error 

Microsoft SQL Kingdom projects in Auto SQL Server Express (SSE) mode need to be 
attached before you can link the projects in Insight (see Downloading and Installing SQL 
Server). Kingdom does this automatically, thus a project can be left open in Kingdom and 
then connected to Insight, or manually attached (see Manually Attaching Kingdom SQL 
Database). 

This error is coming from the SQL server used to access data from your Kingdom project. The 
error says the server is unable to access the Kingdom database because the path to the 
database file (.mdf) on the specified drive is no longer valid. There are two possible reasons for 
this: 

• If this network drive is no longer available, or if the location of the kingdom project has 
changed, you would get this error message. You may need to check with your IT support for 
help with this. 

• If you did not manually attach the Kingdom database, the project must be open in Kingdom 
when you connect to the database from Insight. This error will appear if you try to connect 
to the database without Kingdom running. To connect without Kingdom running, the project 
has to be manually attached (see Manually Attaching Kingdom SQL Database). 

 Note: If you no longer need to access data from the kingdom database you can 
disconnect the link and the error will no longer appear. 
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Genuine offer of assistance 
If the problem persists, or if you have any questions, please contact our support team at 
support@dugeo.com. 

You may be asked to send data of your session from the Logs window for a clearer picture of 
what happened when the error occurred (see Viewing and Sending Diagnostic Logs). 

Page 399FAQ

mailto:support@dugeo.com
http://help.dugeo.com/m/Insight4-0/l/438235-viewing-and-sending-diagnostic-logs-u


There is a problem. How do I provide 
information on my issue? 

On occasion, DUG Insight may experience an issue which will require more information for 
us to provide a fix for you. Here is how to get more diagnostic information to us so we can 
resolve the issue quickly. 

Note: For a fatal error, see Help, Insight just crashed! What should I do now? 

Repeat or perform the action that causes the issue to occur 
This is important! The issue must be reproduced, and the logs captured at the time of the issue 
occurring. 

1. In the DUG Insight Launcher, click the Logs button. 
2. The Logs window will be displayed 
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3. There is a tab for every time that Insight or the SEG-Y Loader has been launched. Select the 
relevant tab that you are currently experiencing a problem with. 

4. Click Send to DUG to send the log files for diagnostics. 
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5. Enter your email address and any other relevant information in to the comments box so we 
can provide a response back to you. This information, along with the contents of the log, will 
be sent to the support team for analysis. 

6. If you want a response from the support team, make sure to provide an email address. 
7. Click OK to send the logs. 

 Note: It is important that you send the logs to DUG while you are having that problem. 
Sending it later will not be useful to provide information related to the problem. 

For more information, see Viewing and Sending Diagnostics Logs. 
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Help, Insight just crashed! What should I do 
now? 

When Insight encounters a fatal error, the Problem Reporter window will appear. It allows 
you to easily send details about the error to us. 

Note: For a non-fatal error, see Viewing and Sending Diagnostic Logs. 

1. Enter your email address and any other relevant information in to the comments box so we 
can provide a response back to you. This information, along with the contents of the log, will 
be sent to the support team for analysis. 

2. If you want a response from the support team, make sure to provide an email address. 
3. Click OK to send the logs. 

 Note: It is important that you send the logs to DUG while you are having that problem. 
Sending it later will not be useful to provide information related to the problem. 
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